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he way I look at being a senior is this: We
got there ahead of the rest of the pack.

Let those behind us get all excited over tweets
and iPods and video games that simulate the
challenges and joys of life. We've been there
before — before there were computers, as a
matter of fact.

When the PC arrived it was hard to imagine
what its ultimate role would be. We played
some games, we used it to balance our check-
books, and we learned to put aside our dumb
typewriters and use the computer as something
with a new title: a word processor.

And then everything began to come together.
The computer was connected to the telephone
system and through it to a completely new
concept, the World Wide Web (now more
commonly known as the Internet).

Through that connection, the computer
became a carrier of a new kind of communica-
tion, called e-mail. And over the same wire
(and its faster cousins including DSL and cable
television connections) came Internet video,
Internet radio, and digital images.

And though Sears no longer sends out its huge
catalog, the Internet as the replacement for
mail order has become a major part of com-
merce in our society. There is very little that
you (and your credit card or an electronic link
directly to your bank) cannot purchase online.

| “*roduction



Introduction

About This Book

The purpose of this book is not to point out how stupid you are. I
don't believe that for a second . . . in fact, it is our generation that
invented all of these great devices.

But it is also true that for some of us it is important to update our
metaphors and clear out our mental attics so that we can function
efficiently as seniors. I'll try to explain, in plain English, just enough
about how a computer works to help you understand it. And, as
promised in the book'’s title, I'll show you ways you can make simple
repairs to your computer that will extend its life, save you money, and
amaze the youngsters.

Foolish Assumptions

You have a computer and you want to fix a problem, prevent a prob-
lem, or be able to intelligently discuss your needs and wants with your
14-year-old grandson. Nothing foolish there. I also assume that you
don't have an advanced degree in computer programming or electrical
engineering. That's just fine.

The information in this book should be of use to any personal
computer (PC) user. The differences between a desktop and a laptop,
between a PC and a Mac, or between a machine running Microsoft
Windows, Mac OS, or another operating system are not that great
anymore.

But for the record, I assume the following as your standard machine:

e A PC.

w= An Intel or AMD microprocessor (which together

account for nearly all current processing units
in PCs)

w= A current version of the Microsoft Windows operat-
ing system (Windows XP, Windows Vista, or
Windows 7)
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w= A current Web browser (Microsoft Internet Explorer,
Mozilla Firefox, or other similar products, including
Google Chrome)

Why You Need This Book

My children never knew a world without Nintendo or PCs or e-mail. I
once told my daughter to make a “carbon copy” of something she was
about to mail and she looked at me as if I had two heads. When 1
explained what I meant she rolled her eyes, and I felt very, very old.

But for the rest of us, the fact that we have a history (we remember life
before Google, before YouTube, before cell phones) sometimes makes
it harder to deal with the fast pace of change.

Just as you don’t need to understand fuel injection or the chemistry of
a catalytic convertor in order to drive your car to the post office, you
also don't have to upgrade a chipset or decode a binary file to be able
to use a personal computer.

But when it comes to making simple repairs or directing a service cen-
ter to do them for you, it does help to know what those things are.

Conventions Used in This Book

This book uses certain conventions to highlight important information
and help you find your way around, including these:

Icons

Helpful suggestions for tasks in the steps lists.

Potentially dangerous things to avoid.

Stuff you type

When you have to type something onscreen using the keyboard you'll
see it in bold. Except for right now.
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Figures

Many have notes or other markings to draw your attention to a spe-
cific part of the figure. The text tells you what to look for; the figure
notes help you find it.

Menu commands

This arrow symbol 5> shows a sequence of steps on a computer menu.
For example, Start=>All Programs=>Accessories means to click the Start
button, click All Programs, and then click Accessories.

Options and buttons

Various versions of Windows use a mix of upper-and-lowercase, all
uppercase, and even sOmetimes an odd construction like this one to
indicate your options. If you're clicking on one of them, their style of
presentation does not matter. (The sOmetimes example is the sort of
thing that appears in some onscreen menus; it is meant to indicate
that in addition to clicking on the words to choose them, you can use
a keyboard combination like Alt plus the capitalized letter. In this
instance, Alt+O would choose the sOmetimes option.)

How This Book Is Organized

This book is organized into logical sections, but you don’t have to
read it front to back.

Part I: A Computer Is Not a Toaster

A toaster, or a bicycle, or a desk fan are each relatively complex pieces
of technology. But when they stop browning bread, pushing the
wheel, or blowing air the reason for their failure is usually very obvi-
ous. You can see the broken part and you might even be able to fix it
with a screwdriver or a hammer. Alas, that’s not the case with a com-
puter. In Chapter 1, I show you how to get to know the parts you can
see, like the mouse, keyboard, monitor, printer, and connection ports.
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In Chapter 2, I take a tour inside the box, to help you understand the
brain of your PC. And in Chapter 3, I introduce you to the operating
system (Windows for most of us) and other major pieces of software.

Part 11: Keeping Your PC Healthy with Preventive Maintenance

Here we explore healthy habits for you and your machine. In Chapter
4 you explore how to maintain, update, and repair Windows and soft-
ware. In Chapter 5 it's time to read about proper computer hygiene,
including keeping things clean and cool. In Chapter 6 it’s time to
think about dealing with evil-doers; I show you how to play defense
against viruses, malware, and spam. In Chapter 7 I'll help you decide
when and how to seek expert assistance and also give some pointers
on weighing the cost of repair against the price of replacement of your
PC or its major parts.

Part I11: Fixing Sick Hardware

Does the hardware exist to run the software, or do you need software
in order to use the hardware? It doesn’t really matter; one is not
much use without the other. In Chapter 8, we'll look into the display
or monitor. In Chapter 9, I'll help you solve basic electrical and
mechanical problems. In Chapter 10, I'll explain how to change or
upgrade your PC’s memory. In Chapter 11, I'll do the same for hard
disk drives and CD or DVD drives. In Chapter 12 we’ll consider ways
to diagnose problems with a malfunctioning printer. And In Chapter
13 we'll explore good mousekeeping and other fixes for the mouse
and keyboard.

Part IU: Resetting the Operating System

I've already posed the question of whether hardware or software is
supreme. The fact is, though, that if the operating system becomes
scrambled, the hardware will sit there like a cold pile of silicon and
metal. In Chapter 14 I begin by explaining how to repair, refresh, and
sometimes reinstall Windows. In Chapter 15 I help you examine and
change system configuration. And in Chapter 16 I tell you how to
restore your computer’s settings back to the condition they were in the
last time the PC worked properly.
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Part U: Troubleshooting Your PC

You've got a problem; here are solutions that don't require a soldering
iron, a doctoral degree, or the bratty neighbor kid. In Chapter 17 I'll
show how to start your machine in Safe Mode, an important tool to
make changes to an injured PC. In Chapter 18 we'll explore the Device
Manager and Windows Troubleshooting Wizard, a pair of power tools
that come with the operating system. Chapter 19 concentrates on fix-
ing the soft side of hard disk drives, including fragmented files, disk
errors, and other issues. In Chapter 20, I give a just-the-news roundup
of fixes to common problems in a PC; these tricks of the trade are
worth the price of admission.

Time to Get Started!

If you're a methodical type, start at the beginning and read about your
PC before you attempt to prevent or correct problems. On the other
hand, if you already know what’s wrong, consult the table of contents
or the index and jump right in to the section that deals with the
problem.

And if you discover a solution not included here (or a problem not
envisioned), I'd like to hear from you. Fire up your PC and send me
an e-mail at fixpc@econoguide. com.
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Getting to Know
the Parts Vou
Can See

ou wouldn’t want a surgeon to operate

without knowing the pertinent parts of the
human body — especially if you're the patient.
By the same token, you really shouldn’t do sur-
gery on your PC if you don’t know what its
components are and what they do.

Fortunately, hardware is more modular and
less costly today than it was in the “good ole
days,” so most of the repairs or enhancements
you want to make aren’t necessarily difficult or
highly technical. You just need to understand
some basics about your computer’s anatomy,
and you should be good to go.

Another reason to know these basics: Whether
or not you ever need to make repairs, under-
standing computer physiology should help you
get more use out of your PC and make your
experience with it less frustrating.
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Part I: A Computer Is Not a Toaster

This chapter isn’t the Gray’s Anatomy of computers; for that, you need a
more-in-depth book such as my Fix Your Own PC (Wiley Publishing).
Think of the chapter as being a form of CliffsNotes — just enough to start
with — and check out the cross-referenced chapters for more details.

Make a Point: Mice and Other Pointing Devices

A pointing device allows you to move a pointer onscreen to work
directly with the elements you find there. Your PC may have some
combination of the following:

w= Mouse: This device gives your computer a hand, in a
metaphorical sort of way. It's one of the most intui-
tive elements of a computer, easy to grasp and to
use. See Chapter 13 for more on mice. You may have
either of two kinds:

¢ Wired: The most common pointing device is the
basic mouse (see Figure 1-1), which is about the
size of a deck of cards. Its two buttons and long
tail (connection wire) make it look vaguely
mouselike. Some mice have three buttons or a
small scroll wheel on top.

® Wireless: A wireless mouse has no tail; instead,
it communicates with the computer via radio-
frequency or infrared waves. You need to keep a
wireless mouse fed (powered) with batteries.

w= Trackball: Some users prefer a trackball (see Figure
1-2), which is essentially an upside-down mouse.
You move the pointer onscreen by spinning the ball.

10
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Left mouse button Scroll wheel  Right mouse button

Figure 1-1

it doesn’t require much desk space and is also easier

@ The trackball is my preferred pointing device because
on the wrist and shoulder than a mouse is.

w= Touchpad: Many PCs feature a touchpad, which is a
matchbook-size, touch-sensitive screen on a laptop
or a stand-alone device that plugs into a desktop
computer. You move the pointer onscreen by push-
ing your finger along the touchpad.

11
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Spin this ball to move the mouse pointer.

Figure 1-2

Stay on Key: Keyboards and Other Input Devices

12
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Keyboard: The keyboard (see Figure 1-3) is the one
part of a computer that most of us have dealt with
for nearly all of our lives. (Remember the typewriter?
Its odd QWERTY layout for the keys is pretty much
unchanged.) Like mice, keyboards come in two fla-
vors: wired and wireless. I discuss keyboards in more
detail in Chapter 13.

Tablet: A tablet is a flat device — an active touch-
screen (like that on a GPS receiver or an automated
teller machine) or a metal or plastic pad — that
allows you to interact with the computer in a way
that resembles using a paper tablet or notebook.
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Although tablet input devices have been around for a
long time, they're still used mostly in high-end
graphics stations and by folks who need to input
precision drawing or graphics data. If, however, you
need to input variable data and just like the concept
of using a penlike stylus to interact with your PC, a
tablet may be for you.

Special computer function keys

Familiar typewriter-style keys
Figure 1-3

See Clearly Now: Monitors

In this book, for simplicity’s sake, I use the terms monitor and display
interchangeably in most descriptions (and cover them interchangeably
in Chapter 8). Technically, though, the two devices are different:

13
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m= Monitor: A monitor is a high-resolution television display
based on a cathode ray tube (CRT). Because of the size
of the CRT, it tends to be large and heavy. A modern PC
can support two monitors to provide more workspace
and to help you separate tasks (see Figure 1-4).

CRT monitor

Dual monitors provide more workspace.

gure 1-4

A working monitor can be used with most comput-
ers. If you buy a new machine or need to replace a
failed monitor, however, you'll probably have to
switch to a display.
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w= Display: A display (see Figure 1-5) uses a flat liquid

crystal diode (LCD) system to show characters and
graphics. Displays, which arrived with the first lap-
tops, are thinner and lighter than monitors; use less
electrical power; generate less heat; and may be
sharper for tired eyes. The newest displays use light-
emitting diodes (LED) instead of an LCD system.

SAMSUNG

|
LCD and LED displays are thinner and lighter than CRT monitors.
Figure 1-5

®

Given a choice, I'd get an LED display. LED displays
are more expensive than LCD models, but they last
longer, use less energy, and run a lot cooler.

15
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Get the Picture (and Sound): Cameras,
Speakers, and Microphones

16

w= Speakers: Laptop computers generally have little

®
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speakers built into their cases; desktop machines
offer connectors for external audio equipment. (For
more information about these connectors, see
“Connect the Parts: Ports and Hubs,” later in

this chapter.)

To get the best sound from your computer, you
should use speakers that have their own amplifier.

Microphone: A computer’s microphone (usually
built in) allows you to chime in with your own nar-
ration or participate in online conference calls. For
some users, a microphone can serve as a replacement
for, or an enhancement to, a keyboard as a way to
enter text and commands.

Video camera: Video cameras for computers, called
Webcams, are both small (some have a lens the size
of the hole in a Cheerio) and inexpensive, so they're
built into most laptops today. If you need to add an
external Webcam to a desktop PC, you can buy one
for $25 to $75. Figure 1-6 shows a typical display-
mounted Webcam from Logitech.
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This 1.3 megapixel camera can mount on top of your display.

Figure 1-6

Go Online: Modems and Routers

m=  Modem: A modem (see Figure 1-7) is an essential
piece of hardware that allows your PC to communi-
cate with the Internet or with other computers on a
local network. It can be either built-in or external.
The appearance, features, and speed of your modem
depend on what kind of service you use to connect

17
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to the Internet or local network: dial-up or digital
subscriber line (DSL) service from the phone com-
pany, or broadband cable from a cable television
provider. You can find some maintenance and repair
tips in Chapter 9.

Lights show connection status.

Figure 1-7

m= Router: A router does what its name says: routes

information from your computer across a network
and out to the Internet. If you have only a single
computer connected to the Internet, you don’t need
a router; you simply plug your computer directly
into the modem. If you want to connect more than
one computer to the Internet, however, you need a
router to serve as a data traffic cop.
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Routers come in many flavors. Some are stand-alone
units; others are built into a wireless access point
that lets your various computers connect wirelessly
to the router and from there to the Internet. Figure
1-8 shows a modern high-speed wireless router.

Wireless router

Figure 1-8

Put It on Paper: Printers

w= Inkjet: Inkjet printers use one or more cartridges
filled with ink that literally spray images or text onto
paper. Whether the printed information is text or
photographs, it consists of tiny dots of ink placed
very close together. The advantages of inkjet printers
are size and cost — both small. (You can buy

19
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a serviceable inkjet printer for less than $50.) The
disadvantages include relatively slow speed and high
ink costs. A high-resolution color printer (the type
you may use to print photographs) may use four or
more ink cartridges, and depending on the amount
of printing you do, the cost of maintaining an inkjet
printer can be fairly high.

If you're willing to spend more for a high-end inkjet
printer, you can get printing speeds of 20 pages per
minute (or faster) for black and white and 10 to 30
seconds per page for color. In addition, you can get
better picture quality than with a consumer-grade
laser printer.

Laser: Laser printers generally cost more than inkjet
printers, but they can be faster, and operating costs
are lower. A laser printer uses a laser beam to draw
characters or images on an electrostatically charged
drum, which attracts a very fine powder called toner
and deposits the resulting image onto a piece of
paper. Finally, the paper is passed through a hot
fuser roller that melts the image onto the paper,
making it permanent.

All-in-one: For home or small-business use, consider
an all-in-one printer (see Figure 1-9). These devices
incorporate a fax machine, digital scanner, and
(usually) inkjet printer in a single package. Prices
are reasonable, and the device combination saves
desk space. For the greatest flexibility, look for a
unit that uses a sheet feeder so that you can scan a
stack of pages or send multiple fax pages
automatically.
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Control panel lets you print with or without a computer

Scanner/copier tray
Figure 1-9

Connect the Parts: Ports and Hubs

w= [ISB (Universal Serial Bus) ports: These simple
rectangular connectors (see Figure 1-10) are nearly
ubiquitous on modern PCs and laptops because
they can be used to link nearly any type of device.
A computer may offer a bank of four or six ports,
which look like tiny pizza ovens.

21
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USB ports
]

Figure 1-10
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The various versions of USB are downwardly compat-
ible with older hardware, so a USB 2.0 port and cable
should work with a device designed for USB 1.0,
although they will exchange information at the
slower speed of the older equipment. When USB 3.0
is available in late 2009 or 2010, it will work with
devices designed for USB 1.0 and 2.0, at their origi-
nal speeds.

Ethernet port: An Ethernet cable plugged into this
port attaches the computer to a local area network or
high-speed modem. For more on this port, see
Chapter 2.

Ethernet switch: An Ethernet switch (see Figure
1-11) contains multiple Ethernet ports that connect
multiple devices — computers, printers, wireless
access points, and so on — to a network.

Hub: Each USB port can connect directly to a single
device or can be shared with multiple pieces of elec-
tronics by means of a hub, which is a bit like the
power strip you may have behind your home enter-
tainment system. A USB hub looks and functions
much like an Ethernet switch. A cable plugged into a
USB port on the PC connects it with the hub, which
has two, four, or sometimes more connectors for
USB cables.
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Status lights show connections and network activity.
Ethernet ports attach devices to a network.

Figure 1-11

23
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Protect Vour PC: Surge Protectors and UPS Devices

w= Surge protector: If a jolt of high voltage gets into
your computer's motherboard (see Chapter 2), your
computer is — to use the technical jargon — fried.
That's why every computer (as well as any other
expensive piece of electronic equipment in your
home or office) should have a surge protector
between its plug and the wall outlet. This device
contains electrical components that can, in most
circumstances, chop off any sudden spurts of high
voltage.

In the worst situations, such as a lightning strike or a
serious malfunction in an electrical line, a surge pro-
tector sacrifices itself like a bodyguard. Its internal
parts melt to break the electrical circuit. With luck,
this process happens so fast that the electrical surge
won’t get into the power supply or beyond.

w= [Ininterruptible power supply (UPS): If you want
the highest level of protection from a power outage,
consider adding a UPS device (see Figure 1-12) to
your collection of equipment. This device is essen-
tially a large battery with a bit of electronics to con-
trol its actions.

Your computer plugs into the UPS and draws its
power from the battery; the UPS plugs into a wall
socket, using the electrical current to keep topping
off the battery. If the power goes off briefly or drops
below ordinary levels momentarily, you should be
able to keep on working without an interruption. In
the case of an extended power outage, your com-
puter should be able to use the battery long enough
to allow you to save any open files and conduct an
orderly shutdown.

24
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Computer and other devices plug here

Input goes to wall plug Telephone line and cable connect here
Figure 1-12

power your computer and its display for a reasonable

@ Be sure to buy a UPS with a battery large enough to
period, such as 10 or 15 minutes.

25
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Thinking Inside
the Box

Before you consider what's inside the box,
think about the box itself: the case. It
may lie on its side like a pizza box (this type
is called a desktop case) or stand upright like a
filing cabinet (and be known as a tower case).
Or you may be using a laptop or an integrated
desktop machine. These configurations
include the monitor with everything else and
have unique shapes that depend on the man-
ufacturers’ whims.

However it stands, your case has four impor-
tant assignments:

w= Holding together the internal compo-
nents of the computer and creating a
frame that allows the installation of cer-
tain features

m= Protecting electrical and other parts from
damage by dirt, liquids, paper clips, and
other threats

w= Working with the cooling fan to remove
the heat that’s generated by the electrical
circuits and moving parts

w= Keeping radio-frequency radiation inside
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Part I: A Computer Is Not a Toaster

Before you get nervous, let me assure you that you may never have to
open the case of your desktop computer. In the case of a laptop com-
puter, you probably wouldn't ever want to try, because it's not easy.
This chapter just shows you what you would see if you were to per-
form a bit of exploratory surgery.

Assemble Your Toolkit

w= Screwdrivers: Most jobs require a single small
Phillips-head (X-shaped) screwdriver; others call for
a small and a medium-size flat-blade screwdriver.

allows you to install or remove a screw by rotating
your wrist; this design may reduce the chance that
the screwdriver will slip out of the screw head. Also,
a magnetized screwdriver helps you hold on to the
screw while it’s going into or coming out of the case.

@ Some technicians prefer a ratchet-style driver that

P If you use a magnetized tool, avoid getting it close to
‘ your hard drive and other electronic components;
they don't like magnets very much!

w= Antistatic strap: | recommend using an antistatic
strap, similar to the one shown in Figure 2-1. You
can buy one for a dollar or two, often from the same
place where you buy computer parts. For details on
using an antistatic strap, see “Get Grounded,” later in
this chapter.

w= Stable work surface: To do the job right, you need a
sturdy, well-lighted workspace with enough elbow
room for you and some additional space to hold any
parts you remove.

w= Writing materials, labels, and containers: Put in
place a notepad, a pencil or a plastic pen, and a set
of numbered or marked containers (an empty egg
carton works quite well).

28
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Antistatic wrist strap

Figure 2-1

®

You don’t have to use a plastic pen, but when work-
ing around sensitive electronic equipment, it's always

best to avoid the chance of shorting components
with anything metal.

As you remove screws, clips, or cables, make notes
about where particular screws used to reside and in
which marked containers you placed them. Use the

labels to identify all cables and connectors on your
computer.

29
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w= Camera: Almost everyone has a digital or video cam-
era. Put it to work by making a full set of images of
the interior of your computer before you make any
changes. If you run into trouble later while reinstall-
ing parts or end up with an orphan screw, you
should be able to figure out the solution by pressing
Play on your camera.

Get Grounded

> Always use one of the techniques in this section to
‘ ground yourself before touching your computer’s

sensitive electronics; otherwise, you could create a
damaging short. Here's what you absolutely do not
want to do: Scuffle across a carpeted floor in your
socks and then reach into the innards of your com-
puter. That's one of the best ways to deliver a static
shock that could blow the mind of your PC.

w= [Ise an antistatic strap. Place the antistatic strap
around one of your wrists. It usually interferes least
if you put it on your nondominant arm (left arm for
righties, right arm for lefties). Then connect the wire
on the strap to a cold-water pipe, or tape it — metal
to metal — to the center screw of a three-hole electri-
cal outlet.

Be careful not to put the wire in one of the holes
meant for an electrical plug.
w= Use a desktop antistatic device. You can install an

antistatic device such as the touchpad shown in

Figure 2-2, or buy a keyboard mat or antistatic touch
strip.
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Touch this antistatic pad before touching your computer.
Figure 2-2

w= Discharge your body’s static into a metal object. If
you don't use an antistatic strap or device, position
your chair close to a cold-water pipe or the center
screw of an electrical outlet; when you're seated and
ready to begin work, touch the pipe or screw to dis-
charge your body’s static electricity into it. If you
can’t do that, seat yourself, touch something metal
and substantial, and then stay where you are without
moving around.

31
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In most cases, simply touching the outside of the

@ computer case before you touch any of the internal
components is enough to bring your body to the
same electrical potential as the component you'll
touch next.

Open the Computer’s Case

32

moments studying the instruction manual first may

@ PCs come in dozens of designs, so spending a few
be helpful.

1. Place your computer on the work surface, with your
tools, writing materials, and parts containers at hand.

2. Unplug the computer’s power cord, and label and
remove all other cables and power connectors.

3. Ground yourself (see “Get Grounded,” earlier in this
chapter).

4. Open the case.

e Clamshell case: If your computer’s case is a clam-
shell design, it opens like a book when you release
one or two latches or clips; no tools are required
(see Figure 2-3).

e Upright tower case: Lay it on its side so that the
motherboard is face up and parallel with your
working surface. Then remove the connecting
screws or clips, placing them in one of the labeled
containers on your work surface.
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Release latch

Figure 2-3

mine how to orient it. Most cases are built as a box
with a top that’s removable when the computer is on
its side, so put the deep side down and remove the
plate on top. If your case has two removable sides,
the proper orientation probably is with the power sup-
ply down on the work surface. (The power supply is
behind the fan opening on the rear of the case; also
see Step 5.)

@ You'll have to inspect your computer case to deter-

5. With the cover removed, examine the inside of the com-
puter (see Figure 2-4). You should be able to spot three
major components easily:
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Microprocessor  Power supply

Motherboard
Figure 2-4

e Power supply: A sealed metal case holds the
power supply. On the outside of the case is the
incoming connector for the AC cord, and within
the case is a thicket of cables (usually black, white,
red, and yellow) and connectors. For more on the
power supply, see “Tour the Computer’s
Infrastructure,” later in this chapter.
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¢ Microprocessor: The microprocessor is easy to
locate because of a fan, heat sink, or sometimes a
plastic tunnel intended to move cooling air over
its top and out a vent. I describe it in more detail
in the next section.

* Motherboard: The flat motherboard (see the next
section for more info) holds dozens of chips and
connectors, including a set of long slots for upright
memory modules. Most motherboards have two or
four such slots, which are usually black with a set
of plastic lockdown/ejector clips at each end. In
Figure 2-5, slots 2 and 4 have memory installed,
latched in place with clips; slots 1 and 3 show
memory modules partially inserted.

Installed memory modules.

Partly installed memory modules.
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Find Out What Makes Your Computer Think

36
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Motherboard: In a modern PC, the motherboard has
two principal purposes:

¢ Providing electrical and communication wiring to
sockets that hold the central processing unit (CPU)
and chipset

¢ Managing the bus — a device that connects the
computer’s brain to its memory, storage devices,
and input/output ports

Microprocessor: Sometimes called the CPU or just
the processor, this chip is the brain of the computer.
Within this small chip are hundreds of millions of
tiny circuits that switch on or off to move or manip-
ulate bits of data. In modern PCs, most microproces-
sors are made by Intel or AMD. Figure 2-6 shows an
Intel Core 2 Quad microprocessor.

Although it’s theoretically possible to take out the
microprocessor in your computer and replace it with
a faster or more capable unit, you may find that the
new brain won't match the personality (see the next
paragraph). Also, this transplant may not make eco-
nomic sense.
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Figure 2-6

w= Chipset: If the microprocessor is the computer’s
brain, the chipset is its personality. The specialized
chips hold instructions that manage the computer’s
ability to (among other things) draw graphics
onscreen; play music through speakers; and react to
input from the keyboard, mouse, or other device.
Figure 2-7 shows an Intel chipset below a Pentium
microprocessor.

37
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Chipset Microprocessor

Figure 2-7

See Where Your Computer Stores Your Stuff

w= Hard drive: A computer’s hard drive is essentially a very
fancy record player. It may have more than one platter
(think of platters as records — see Figure 2-8), and it
can work with data recorded on either side and on
more than one platter. Hard drives are inside a sealed
case because the read/write head (also shown in Figure
2-8) floats or flies like an airplane wing just a few thou-
sandths of an inch above the rotating disk within. The
tiniest piece of dust or bagel crumb would look like an
iceberg in the path of the Titanic, and the result would
be similar: a disastrous loss of computer life.

38
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Platters Read/write head
Figure 2-8

w= Optical disk drive (CD or DVD): Optical drives can
come in three designs:

e Read: Like the CD player you may have in your
car or a DVD player in the rec room, this type of
device can only play back the contents of the disc.

e Read/write: A read/write drive, often referred to as
a CD-R or DVD-R drive, can play back a disc and
also burn data to a recordable blank disc for later
retrieval and use.

e Read/write/rewritable: This type of drive, called a
CD-RW or DVD-RW drive, can play back, write,
erase, and rewrite data on the disc.

Figure 2-9 shows a typical internal optical drive.
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Drive

Data and audio cables

Figure 2-9

w= Flash memory: Flash memory uses external devices
called USB flash drives, memory sticks, memory
cards, or memory keys (similar to the one shown in
Figure 2-10) to store information. I use flash mem-
ory devices to transfer files between computers that
aren’t connected and also to make temporary back-
ups of files. Flash memory is also used in digital
cameras, cellphones, and portable music players.

40
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Flash memory key Case

Figure 2-10

Tour the Computer’s Infrastructure

2

2

Power supply: An essential part of any desktop PC is
the power supply (see Figure 2-11), which converts
electricity coming from a wall outlet from AC (alter-
nating current) to DC (direct current) and reduces
the voltage from 120 or 240 volts (depending on
where you live or work) to the smaller requirements
of your machine. Under the case of your PC, the
power supply usually sits in its own sealed gray or
black metal box. Wall current comes in through a
cord and goes out of the power supply in a series of
colored wires that connect to the motherboard,
memory, storage, and other devices.

Cooling system: A computer’s cooling (or thermal
energy dissipation) system may be easier to under-
stand if you just call it the fan. The processor inside
the computer, its memory, and the motors that spin
the hard drive and optical drive all produce heat,
which can damage components, so designers have to
dump the heat to the outside.
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Figure 2-11

42
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Most modern PCs have an intake hole on the front
of the case and an exhaust port on the back, with
one or more fans that draw air through the system to
flow over the hot spots. Mazelike baffles at the
entrances and exits allow air to pass through but
block radio-frequency radiation from escaping. Your
computer may have only one fan that’s integrated
into the power supply, or it may have multiple fans
inside the case. Figure 2-12 shows a cooling fan for a
Pentium microprocessor.

Clip-on cooling fan
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Never place a computer flat against a wall or other
solid object that would block the air ports and cause
the machine to overheat. Every few months, use a
vacuum to clear dust out of the air intakes and exits.

External ports: Just like their maritime counterparts,
computer ports are designed for coming and going
traffic. Think of them as doorways for data. A typical
set of external ports, shown in Figure 2-13, provides
links to a keyboard and mouse, to external USB
devices (such as a hard drive or flash memory key),
and to an Ethernet network.

On older desktop computers, the back or side panels
are jammed with rows of specialized connectors
(for a monitor, keyboard, mouse, and so on) and
several multipurpose ports for things like modems,
printers, scanners, and external storage. Today’s PCs
dispense with most of these ports, using advanced
multipurpose connectors. Most modern computers
can connect to just about anything through a set of
USB ports.

Internal ports: Inside the case, you'll find ports on
the motherboard that connect to the external ports
or attach the internal hard drive to the motherboard.
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Figure 2-13

Ethernet port USB ports
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Looking Through
Windows and
Other Software

C omputers have two major types of compo-
nents: hardware and software. I discuss the
hardware side in Chapter 2. In this chapter, I
cover basic software that can help you under-
stand how your computer operates and fix
some things that may go wrong.

Windows includes several applications that
you'll probably use regularly to manage your
PC and fix operational issues. You find many
of these applications in Control Panel, a win-
dow on the innards of your computer where
you can twiddle with the dials and throw a few
switches while the machine is running. No screw-
drivers or pliers are required.

You'll also want (and need) several third-party
software packages to help you with everything
from office work such as word processing and
spreadsheet design to scanning, photography,

and other tasks that you'll want to perform as

you find out more about your computer.

| “*apter

Getready to. ..

wm Tour Windows.........c.c.c...... 48
w=» Open Control Panel ............ 49
w= Customize Your Display....... 50
w= Set Internet Options............. 52
w= Configure Mail ................... 53
w=> Use the Network Setup

Wizard......ocoooiiiiiie 55
w= Configure Printers

and Faxes.........ccoceverieiane, 56

= Explore Windows
Accessories ........cuuuveereenenn. 58

w= Use Windows Explorer........ 59
w=> View System Information...... 61

w= Run the Program

Compatibility Wizard.......... 62
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Tour Windows
1. Choose Start=>All Programs=>Accessories.

2. Choose the appropriate command for your version of
Windows:

e Windows XP: Tour Windows XP
¢ Vista: Welcome Center (see Figure 3-1)

e Windows 7: Getting Started

Click a topic to launch a description or connect to the internet to get more information.

(:)@v| W » ControlPanel » Welcome Center > |"-| |§?C_I‘JTJ_‘?

File Edit View Tools Help

Corey Sandler

15300 @ 1.73¢

1. Get started with Windows (14)

FAI View computer details @ Transfer files and settings % Add new users
Ll i
J Windows Anytime Connect to the Internet ! ‘A_’hat‘s new in Windows
Upgrade . | Vista

Show all 14 items...

2, Offers From Toshiba (8]

-~ b i
n Internet Access L Extended Service Plans P #];: Shuterhy foday for
Easy access to the Internet . Upgraded service plans! . \J Get 15 free phata prints
- P i 14
S%__ Visit ToshibaDirect.com I :a’é‘é‘;'ot";”o“gaﬁ?“m'“d C!, Micrasoft Office Live
g Accessories and Services! ¥ Rkt Vahat Muskt Eﬁ Try it today for FREE

Show all 8 iterns...

[]Run at startup (Welcome Center can be found in Control Panel, System and Maintenance)

A

yme Premium &> Show more details

Figure 3-1
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3. In Windows XP, choose whether you want an animated
display with sound or a nonanimated tour. (Vista and
Windows 7 skip this screen and go straight to the one
shown in Figure 3-1.)

4. Choose Go Online to Learn More (Windows 7) or What's
New in Windows (Vista) to visit a Microsoft help site that
provides videos and other information about your ver-
sion of the operating system.

Explorer. For Vista, go to http://windowshelp.
microsoft.com/windows. For Windows 7, go to
www .windows .microsoft.com.

@ You can go directly to the help site from Internet

Open Control Panel

1. Choose Start=>Control Panel or My Computer=>Control
Panel to open the Control Panel window.

2. Choose a different view, if you want, by clicking the
Classic View or Category View option on the left side of
the window (see Figure 3-2). In Classic View, the Control
Panel applications are listed in alphabetical order.

3. Study the Control Panel window to familiarize yourself
with the applications that you can access here.
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Click this option to switch to Category View

Classic view in Windows XP

[} Control Pa nel

Windaows
Firewall

L4

Wireless Link

Wty
<3
&

Wireless

Metwark Set...

S]] %]
File Edit View | Favorites Tools Help ;’f
3 ] ? . ! Search Folders v
& X B @ B G
- — — &,
Accessibility  Add Hardware Add or Remove Administrative Automatic C0/DVD Drive
[} Switch to Category View Options Programs Tools Updates Acoustic Sil...
\:} £ ] A S
See Also A @) e B =/ ¥ [
“ Windows Update thecl'.[tl Date and Time Display Folder Options Fants Game
Diagnostics Contrallers
@) Help and Support
c ¥ ) & = e
- - ( 4 - \
~ B 4] = = 2
Indexing Intel{R) Internet Java Plug-in Keyboard Mouse
Cptions Extreme Gr... Options
&\ N o3 i
| h = [
e g6 B> % S Q
Metwark Metwoark Setup  Phoneand  Power Options  Printers and QuickTime
Connections Wizard Madem ... Faxes
e B 2 Q &
@ =2 L% ) &
Regional and Scanners and Scheduled  Security Center Sounds and Speech
Language ... Cameras Tasks Audio Devices
=71 - — i
P @B & £ B B
System Taskbar and TOSHIBA User Accounts Viewpoint Windows
Start Menu Paower Man... CardSpace

Figure 3-2

Customize Your Display
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1. From Control Panel double-click the Display icon to
launch the Display Properties utility (XP), or choose
Personalization from the Appearance and Personalization
menu in Windows 7 or Vista.

To go directly to the Display Properties dialog without
going through the Control Panel, right-click anywhere
on the Windows Desktop and choose Properties (XP),
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or right-click the Desktop and choose Personalize
(Vista and Windows 7).

2. Select a general area to view or change from the tabs at
the top of the Display Properties dialog (XP) or choose
an area for modification from the menu choices at the
left of the screen (Vista and Windows 7). For example,
you can choose a new desktop background from the
images installed with Windows or use your own art or
photograph (the Desktop tab in XP, or the Personalization
screen in Vista and Windows 7). You can do the same
with the screen saver (Windows screen savers or your
own images).

significantly differently from Windows XP, but the
basic concept is the same. Instead of a tabbed dis-
play, Vista gives you menu choices in the
Personalization display, which you will find under
Appearance and Personalization in the Category
view. Windows 7 uses the Personalization dialog as
well, but in Windows 7 you set desktop themes,
screen saver settings, sounds. and desktop back-
ground, all at once.

@ Vista and Windows 7 handle these display settings

3. Click Apply to preview your changes (XP). In Vista and
Windows 7 the display changes immediately when you
make the choice. See Figure 3-3.

4. Make additional modifications as desired, then click OK
to accept the changes and close the Display Properties
dialog (XP) or just close the Personalization dialog in
Vista and Windows 7. For more information managing
and repairing your monitor and display settings, see
Chapter 8.
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Theme:

A theme is a background plus a set of sounds, icons, and other
elements to help you personalize your computer with one dick.

My Current Theme

v|| Save As... H Delete

Sample:

Active Window
Window Text

[=lE=Es

-

OK

J| Cancel H Apply

Figure 3-3

Click Apply to preview

Set Internet Options

52

1. From Control Panel, double-click the Internet Options
dialog. This choice will be in the Vista and Windows 7
Network and Internet Category. Figure 3-4 shows the
Programs tab from the Vista Internet Options dialog.

2. Click the Programs tab to set a variety of program

options for Internet access. You can choose the programs

you want to use from the pull-down lists at each data
entry field on this dialog.

3. Click the Connections tab to tell Windows how you want
to reach the Internet. Click Setup on this dialog to launch

a Connections Wizard to help you establish an Internet

connection.
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Click the tab to choose the options
you want to view or change.

i Internet Properties | [F =]

| General ; Security | Privacy ! Content |I Connections | Programs !Advanced;

Default web browser

@ Internet Explorer is the default web Make default
browser,

[ Tell me if Internet Explorer is not the default web browser,

Manage add-ons

*',  Enable or disable browser add-ons | Manage add-ons

1¥=| installed in your system,

HTML editing

@ \» Choose the program that you want Internet Explorer to use for
editing HTML files.

HTML editor: Microsoft Word ot |

Internet programs

[T ., Choose the programs you want to use Set programs
1! for other Internet services, such as
e-mail.

[ OIK ]l Cancel |

|
Click OK or Apply to accept the changes.
Figure 3-4

The Internet Options dialog box is available on the
Tools menu of Internet Explorer.

4. Study the choices on the Advanced menu to make your
Internet experience be just what you want it to be. Here's
where you set security options, specify some Explorer dis-
play options, set printing options and more.

Configure Mail

1. From Control Panel double click the Mail icon to display
the Mail Setup dialog. Figure 3-5 shows the Vista Mail
Setup dialog.
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Click E-Mail Accounts to set up a new account
or modify one you've already established.

;.3 Mail Setup - Outlook ==

E-mail Accounts

@ Setup e-mail accounts and directories.

E-mail Accounts...

Data Files
D Change settings for the files Outlook uses

to store e-mail messages and documents,
Data Files...

Profiles
Setup multiple profiles of e-mail accounts

Q and data files. Typically, you only need
one. Show Profiles...
Close

Figure 3-5

client like Outlook Express, which comes with XP.
You'll need to download and configure the new
Windows Live Mail client, a free Windows 7 upgrade.
An earlier version of this client, called simply
Windows Mail, is built into Vista. See Download and
Configure Windows Live Applications later in this
chapter for more information.

@ Windows 7 does not include an intrinsic E-Mail

2. For the most part you can ignore the Data Files and
Profiles options on this dialog. The default settings will
handle all your needs.

3. Click E-mail Accounts to add a new E-mail account or
view or change an existing account. If you have previ-
ously configured an e-mail account, you will see a dialog
that shows that account and lets you modify it or add a
new one. If this is your first e-mail account, Windows
will step you through several dialog screens to input the
information required to make the account work.
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You'll need several pieces of key information to
@ properly add or reconfigure an e-mail account.
Information from your Internet Service Provider
(ISP) will answer these: Account Type (IMAP or
POP3), IMAP or POP3 server, SMTP Server, your
e-mail address (xxx@yyy.zzz), your username (how
you log into the e-mail server), and your password.

4. Click Finish on the final dialog to accept changes or cre-
ate the new e-mail account.

core information for your account, you can click Test
Account Settings to make sure your settings are cor-
rect before you actually create the account.

@ On the e-mail settings screen where you enter the

Use the Network Setup Wizard

1. From Control Panel double-click the Network Setup
Wizard icon (XP and Vista) to launch the wizard. The
Vista setup dialog is shown in Figure 3-6. In Windows 7
open the Network and Sharing center from the Icon view,
or choose Network Status and Tasks in the category view,
then click on Set up a New Connection or Network.

In Vista and Windows 7, this one Control Panel

@ choice lets you configure your local area network and
also set up an Internet connection. In Windows XP
the Network Setup Wizard gets you to the Internet.
To create a new Local Area Network connection,
choose Network Connections from the Control
Panel, and Wireless Network Setup to configure a
wireless network.

2. Click Connect to a Network on the Set up a wireless
router or access point screen to add your computer to an
existing network.
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Click what do | need . . . to learn more about networking.

== =]
I\J' Set up a wirelegs router or access point
Set up a hofne or small business network

If you have muftiple computers in your home or business, you can set up a network to connect to
them. What do [ need to set up a network?

This wizard helps you:
- Configure a wireless router or access point
- Set up file and printer sharing

- Save network settings and get instructions for connecting other computers and devices to your
network.

- The wizard will make this a private network

Depending on your network hardware, some of the options above might not be available.
Other activities:
—Connect te a network

Set up file and printer sharing

| Next_|| Cancel |

Click Next to set up a new network.
Click Connect to a Network if you're
adding a computer to an existing network.

Figure 3-6

3. Click Next at the bottom of this dialog to set up a new
network. Windows will scan for wireless access points
and step you through configuring them for your network.

Configure Printers and Faxes

56

1. From Control Panel, double-click the Printers and Faxes
icon (XP). In Vista and Windows 7 choose Devices and
Printers to view a list with icons of printers and fax devices.

2. Click Add a Printer to add a new device to your com-
puter. Figure 3-7 shows the initial Add a Printer dialog in
Vista and Windows 7. Windows XP displays a wizard
welcome screen, then lets you choose the type of printer
to install on the second dialog.
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Choose Local or Network (remote) printer.

I\_z’" = Add Printer
Choose a local or network printer

—* Add a local printer

Use this option only if you don't have a USB printer. (Windows automatically
installs USB printers when you plug them in.)

—» Add a network, wireless or Bluetooth printer
Make sure that your computer is connected to the network, or that your Bluetooth
or wireless printer is turned on,

| Cancel |

Click Next to let the wizard help you finish the installation.
Figure 3-7

3. Choose Local or Network printer from the wizard dialog
and click Next to move to the next screen. You will see
different screens after this, depending on what type
of printer you are installing. Windows will try to find a
printer to install automatically, but you may be asked
for printer manufacturer, model, network address (for a
remote printer), and other information.

computer or other network device (such as a wireless
access point or router), choose the printer host device
from the port list on the next printer wizard dialog.
For a stand-alone Ethernet connected printer you
may need to create a new TCP/IP.

@ If you are installing a printer attached to a networked

4. Follow the wizard to the next to last page, answering the
questions as you go, and choose Yes to print a test page.
This will verify your settings before you finish the
installation.
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5. On the last screen click Finish to complete the installation.

Explore Windows Accessories

1. Choose Start=>All Programs=>Accessories. Figure 3-8
shows the accessories list from Windows 7. Vista and XP
will have slightly different applications in this list. As
with the Control Panel, study this list to familiarize your-
self with the types of utilities here.

Some entries are applications; others are folders with additional programs.

Accessaries

g Eluetooth File Transfer

Ij Caleulatar

B Command Prompt

@3 Connectto a Mebwork Prajectar

= Connect to a Projectar

| Getting Started

é Math Input Panel

7 Wotepad Music

! Paint

% Remote Desktop Connection

i3] Run

S Snipping Tool Computer

L Sound Recarder
Sticky Notes

@ Sync Center

a Windows Explorer

2 wordpad

Ju Ease of Access
Systern Tools

Games

Tablet PC
4 Bak
‘ Search programs and fiies Windows 7
Evaluation copy. Build 7100

® 5 J S

Hover your mouse pointer over an entry for more information.

Figure 3-8
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Vista and Windows 7 display drop-down menus when
you choose Accessories or one of the Accessories sub-
menus. Windows XP display successive menus as you
hover your mouse over each parent menu.

2. To use one of the Accessories applications, simply click
the menu item you want to use.

3. To exit the Accessories menu, move your mouse pointer
outside the menu area and click on the desktop.

Use Windows Explorer

1. Choose Start=>All Programs=>Accessories.

2. Click Windows Explorer to open this utility. Figure 3-9
shows the Vista Explorer utility.

This is a utility you will use frequently. From the
Accessories program list you can right-drag the

Windows Explorer icon to your desk to create a
shortcut to make access easier.

3. Click the right-facing triangle to the left of a folder name
in the Folders display at the left of the screen to present a
list of the sub-folders within.

4. Click a folder name to display its contents on the right
side of the Explorer screen.

play the folder contents for the source location of a
file or files, then click the triangle to the left of a
main folder on the left to display the destination.
Drag the file from the right window display across to
the folder name to move it to the new location.

@ You can move files easily among directories. First dis-
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Click a folder name on the left of the screen to display its contents on
the right. Note the additional menu items.

G

File Edit

» Video Captures

View Tools Help

‘ Organize v

ﬂ_}' Music
ﬂ:. Documents
,'E Pictures
More »
Folders hd

4 Wl Desktop
|ﬂ Corey Sandler
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- (il SQO04331V05 (C)

- <L} DVD RW Drive (D)
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Control Panel

£ Regyle Bin
. Fix PCfor Seniars for Dumn
. JULDS Backups
. Manuals
PowerPoint Presentations
. Slideshows
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3/7/2008 12:00 ...
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Search

Type
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Figure 3-9

5. Click in the Search field at the upper right of the Explorer

window and type all or a part of a file name to find it.
Narrow the search by first selecting a folder at the left. If
you select Computer (Vista and Windows 7) the search
routine will look in all of your storage devices for the
specified file. In Windows XP click on the Search spyglass
on the Explorer toolbar and fill out the information dis-
played on the next screen.
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6. If you have additional computers or storage devices on
your network, Windows will find them and show them
in the Network list on the left of the screen. If you have
shared resources on these devices, you can access them
from Explorer.

7. Click the back and forward arrows at the upper left of the
display to step through locations you have browsed since
you opened Windows Explorer.

View System Information
1. Choose Start=>All Programs=>Accessories.
2. Select System Tools.

3. Select System Information. The System Information util-
ity generates a complete report on what's in your com-
puter, similar to the one shown in Figure 3-10. You can
refer to this system information at any time to make sure
that you have the latest system updates, as well as to
determine whether your system meets new applications’
criteria for memory, hard drive space, and the like.

Here's a shortcut to system information: Open the

@ Start menu, right-click Computer or My Computer
(Windows XP), and choose Properties from the
shortcut menu.
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Choose Hardware, Applications, or another
topic to drill down into system information.

Note your Windows version,
system memory,

and other key features

of your computer.

I System Informatfon
Edit View Hegp

File

= Hardware Resourcy
Conflicts/Sharini
-DMA

Forced Hardwar|
10

IRQs

- Memaory
Components

o Multimedia
CD-ROM
-Sound Device
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“Infrared

‘Input
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-Metwaork

-Ports

Storage

-Printing

tem

05 MName

Version

Other OS Description
05 Manufacturer
System MName
System Manufacturer
System Model
System Type
Processor

BIOS Version/Date
SMEBICS Version
Windows Directory
System Directory
Boot Device

Locale

Hardware Abstraction Layer
User Name

Time Zone

Value

Microsoft® Windows Vista™ Home Premium
6.0.6001 Service Pack 1 Build 5001

MNat Available

Microsoft Corporation
COREYSAMDLER-PC
TOSHIBA

Satellite P205

XB6-based PC

Intel(R) Core(TM)2 CPU
TOSHIBA V1.30, 3/26/2007
24

Ch\Windows
CAWindows\system32
\Device\HarddiskVolume2
United States

Version = "6.0.6001.18000"
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T5300 @ 1.73GHz, 1733 Mhz, 2 Core(s), 2 Logic...

[T search selected category only

Problem Device Installed Physical Memory (RAM) 2.00 GB

“UsB Total Physical Memory 1.99 GB

=t S:oftware Environmu Available Physical Memory 979 MB

- System Drivers || 141 virtual Memory 421GB

S|gr_19d Drivers Available Virtual Memory 3.05 GB

g--En\flronment ¥a - || Page File Space 228 GB

i Print Inhs y
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Figure 3-10

Run the Program Compatibility Wizard

If anything can go wrong, it will, so you need to know about this utility,
which can help you resolve application problems (see Figure 3-11).
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1. Choose the appropriate command for your operating
system:

e Windows XP: Choose Start=>All Programs=
Accessories; then choose Program Compatibility
Wizard.

e Vista: Open Control Panel; choose Programs, and
select Use an Older Program with This Version of
Windows.

e Windows 7: Open the Control Panel, choose
Programs, and select Run Programs Made for
Previous Versions of Windows.

=| Start Application in Compatibility Mode =)= =]

Program Compatibility Wizard

Welcome to the Program Compatibility Wizard
If you are experiencing problems with a program that worked correctly on

an earlier version of Windows, this wizard helps you select and test
compatibility settings that may fix those problems.

Caution: It is recommended that you do not use this wizard for older virus
detection, backup, or system programs.

To continue, click Next.

| Mext = | | Cancel

Click Next from this opening screen to launch the wizard.
Figure 3-11
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2.

Click Next to launch the Program Compatibility wizard.
What happens next depends on your operating system.
Windows XP will ask whether you want to search for pro-
gram problems, use a program on a CD-ROM, or locate a
program manually; Vista and Windows 7 simply search
your hard drive for applications and display a list of
those applications.

(Windows XP only) Select the program you want to test,
and click Next.

Again, what happens at this point depends on your oper-
ating system. Windows XP asks which Windows version,
if any, you want to test the program against. Vista and
Windows 7 let you choose to test the program or tell the
wizard what problems you have experienced.

After Windows checks the program and prompts you to
do so, launch the program. If the program runs properly,
you can close the wizard. If not, you have an opportunity
to try new settings.
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Keeping Your PC
Healthy with Preventive
Maintenance
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board, upgraded the BIOS and wrote a
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Taking Care
of Software

ou have a choice: Leave your operating sys-
tem and programs untouched, or subject

them to regular updates. In theory, you might
be safe never updating Windows if

w= You never add software.

w= You never make any hardware changes,
using your PC in the same condition in
which it was delivered from the factory.

w= You never connect to the Internet or to
any other computer over a local area
network.

w= You never accept a file from another user
on a CD, DVD, or other device.

If you have that sort of hermetically sealed
machine, though, you're missing out on much
of the fun and productivity that come from
making connections. What's more, your PC’s
operating system and its software programs
may fall behind the times. Without updates,
you won't benefit from improvements, bug
fixes, and new defenses against virus and mal-
ware attacks.

| “*apter
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Sometimes, you also need to update or even replace device drivers —
small collections of programming code that interpret commands
between Windows and devices inside or outside the PC. Drivers some-
times get damaged by things such as electrical spikes, hard disk prob-
lems, or computer viruses.

In this chapter, I show you how to care for Windows and other software.

Check for Windows Updates Manually

1. Choose Start=>Control Panel, and look for the Windows
Update icon in the far-left column of the Control Panel
window. (In Vista, you see the words “Check for
updates.” In 7, you must choose the icon view first.) It
appears there in both Classic View, which displays all the
available major utilities as separate icons, and Category
View, which groups icons of similar types. (See Chapter 3
for more information about Control Panel’s views.)

2. What you do next depends on your version of Windows:
¢ Windows XP: Double-click Windows Update.
e Vista: Click Check for Updates (see Figure 4-1).

e Windows 7: If you're viewing Control Panel in
Classic View, click the Windows Update icon. If
you're in Classic View, click System and Security;
then click Windows Update in the resulting list.

Whichever method you use, a Microsoft Update Web
page appears when system updates are available for your
computer.

ent update pages. In general, however, the update
software goes directly to the Internet, checks for
updates to your system, and then tells you whether
updates are available.

@ Different versions of Windows present slightly differ-
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Update link in Windows Vista’s Control Panel

=EEE=
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@le + Control Panel » - |¢,-| |Sean:h pel |
File Edit View Tools Help
+ Control Panel Home . - .
e System ad Maintenance User Accounts and Family
T A Get started with Windows i Safety
Back up you| computer @ Set up parental controls for any
user
[ SECUI’it)’ @Add of remove user accounts
Check for updates

Check this computer's security — Appearance and
stati h i . .
E:HSOW a program through ' Personalization
®|Winduws Biawall Change desktop background
Change the color scheme

. Network and Internet Adjust screen resolution
¢h View network status and tasks
“S. 5ot up file sharing q Clock, Language, and
. Region

i ’f’ Hardware and Sound o Change keyboards or other input

_"'@ Play CDs or other media methods
automatically pra—
Printer @ Ease of Access
Mouse Let Windows suggest settings
Optimize visual display
Programs B .
h- ! Uninstall a program ::;_ Additional Options
Change startup programs =
Recent Tasks g Mobile PC .
Change battery settings
AR ieen resolution . Adjust commenly used mobility

‘Change the theme settings

C'hange the color scheme

Figure 4-1

3. In the update Web page, choose the Express or Custom
option to install available updates.

4. Click the Install Updates button (see Figure 4-2) to
download and install the updates on your PC, or click
the View Available Updates link to get more information
about them first.
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Click to install all the available updates.

Click to review updates before installing them.

(7 o

[ ;w— | ‘_’gj < System and Maintenance » Windows Update - | 4 | | Search 2 |
File Edit View Tools Help
@

Check for updates :
SEE Windows Update

Change settings

View update history '\@ Download and install updates for yourl computer

Restore hidden updates
. Total: 4 important updates, 109.8 MB | ool asdites i
(2) Updates: frequently asked Also available: 8 optional updates © a

guestions

View available updates
Always install the latest updates to enhance your
computer's security and performance,

Most recent check for updates:  Today at 11:47 AM

Updates were installed: Today at11:49 AM. View update history

You have Windows set to: Automatically install new updates every day at 12:00 PM
(recommended)

You receive updates: For Windows and other products from Microsoft Update

Figure 4-2

Check for Windows Updates Automatically

1. Choose Start=>Control Panel to open the Control Panel
window.

2. Double-click the Automatic Updates icon (see Figure 4-3).
3. Choose one of the available options:

e Automatic Updates: Microsoft recommends this
option, which is marked by a friendly green shield
with a checkmark. If you select this option, you
can set your computer to communicate with the
Microsoft mothership automatically on a particu-
lar day of the week or every day, as well as tell it
what time of day to look for updates.
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I fu @ ¥ Control Panel » All Control Panel Ikems »

- | 4,_' | Search Cantral Parel

P

»

Adjust your computer's settings

Action Center

Backup and Restore

Credential Manager

Desktop Gadgets

Display

Fonts

Indexing Options

Keyboard

Network and Sharing
Center

Performance Information
and Tools

Power Options

Region and Language

Speech Recognition

Taskbar and Start Menu

Windows CardSpace

Windows Update

g

J
]

i

-

£ & @ #

Administrative Tools

BitLocker Drive Encryption

Date and Time

Device Manager

J Ease of Access Center

Getting Started

Internet Options

Location and Other
Sensors

Notification Area Icons

Personalization

Programs and Features

RemoteApp and Desktop
Connections

Sync Center

Troubleshooting

Windows Defender

Wiew byt Largeicons =

@ AutoPlay

0 | Color Management
f@ Default Programs
“qu;i Devices and Printers
Folder Options

Q% HomeGroup

Java

J Mouse
@1 Parental Controls
Phone and Modem
Recovery

.‘j) Sound

[gh;_.' System

User Accounts

ﬁ Windows Firewall

Automatic updates icon
Figure 4-3
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Most users should select this option. I suggest that
you schedule daily checks for updates at a time when
you're least likely to be interrupted.

e Download Updates for Me, but Let Me Choose
When to Install Them: This option allows you to
look at the list of suggested updates that Microsoft
sends your way and accept or reject them
individually.

fication area of the Windows desktop and initiate
putting any new software in place. If you don't, the
updates will be on your computer but won't be
installed in Windows.

@ Remember to check the notification icon in the noti-

¢ Notify Me but Don’t Automatically Download or
Install Them: If you choose this option, Microsoft
sends the updates that it thinks your computer
needs. Read the list, choose the updates you want,
and then initiate installation.

e Turn Off Automatic Updates: This option is deco-
rated with a red shield filled with an X as a warn-
ing. Microsoft advises that your computer will be
vulnerable unless you install updates regularly.
When Automatic Updates is off, it's up to you to
visit Windows Update on your own (see “Check
for Windows Updates Manually,” earlier in this
chapter). This option is not recommended for
general use.

cycle, Microsoft offers a major package of updates
and revisions called a Service Pack, which is about as
close to a completely new version of Windows as you
can get. I cover checking for and installing Service
Pack updates later in this chapter.

@ About once or twice in each operating system’s life
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Update Other Software

1. If you haven't already, register all of your applications
with their manufacturers. It's best to do this when you
first install the software on your computer.

2. Choose your update preference:

e Automatic: Some third-party programs offer regu-
lar automatic updates that last until a new version
of the program is released or for a specific period.
Antivirus and Internet security programs, for exam-
ple, typically come set up to receive updates that
are sent on a regular schedule or whenever new
threats are discovered. You may see an update
notice in your taskbar.

e Manual: If you decide not to get automatic
updates or don't have that option, train yourself to
get on a regular schedule of checking to see
whether updates are being offered. While your PC
is connected to the Internet, click the program'’s
“check for updates” link (usually in a Help menu)
to go online and check for available updates, as
shown in Figure 4-4. Then follow the onscreen
instructions.

have access to high-speed Internet connections, so
they deliver updates online. A few companies offer to
ship a CD or DVD with updates (and may charge
you for that special service).

@ Nearly all software manufacturers assume that users

3. Install any required updates. In addition to fixing bugs,
required updates may add compatibility with new file
formats or keep the software in step with changes in
Windows.
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In McAfee, click this link to check for updates manually.

(comcast. Security

Home

Protection Status
Start Here

Backup and Restore Files
el Brensl While SecurityCenter is checking for updates, you can
Fackeiman eyl continue to perform other tasks with it.

Restore Firewall Defaults

For your convenience, an animated icon appears in your
Windows notification area, at the far right of the taskbar.
When SecurityCenter is finished, the icon automatically
iew Recent Events disappears.

Manage MNetwork

Figure 4-4

4. Decide whether to install optional updates, which are . . .
well, optional. They may address minor issues that may
not apply to your system or to the tasks you perform, or
they may add some functions that you don't need or
want. Read the updates’ descriptions as well as system
requirements, and make your own decision about
whether to put them on your computer.

Check Vour Service Pack Status

1. Choose Start=>Run to open the Run dialog box. In Vista
and Windows 7 type it into the search box.

2. Type winver and then click OK.
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The resulting dialog box shows what version of Windows
you're running and which Service Pack is installed.

ing a Service Pack for a few weeks after it’s released to
the public; I prefer to allow other people to try it first
and look for any major incompatibilities. To take this
course, you'll have to conduct manual updates (see
“Check for Windows Updates Manually,” earlier in
this chapter), because Windows will install Service
Packs for you automatically as part of the update
process.

Check for and Install Service Pack Updates

1. Open Internet Explorer.

@ Cautious users, including me, usually put off install-

2. Go to http://update.microsoft.com.
3. Click Express (Recommended).

If you don't have the latest Service Pack installed,
Windows will display a dialog box similar to the one
shown in Figure 4-5.

If you haven’t updated Windows in a while, you may

@ have additional software to install before you can
install the Service Pack. Follow any onscreen
instructions.

4. Close all running programs.

5. Click the Install button to start the installation.
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'U- E}-" Install Windows® Service Pack

==

Install Windows Vista™ Service Pack 2

Save your work, close all open programs, and then click Install.

The installation might take an hour or more, and your computer might restart several times.
Youwon't be able to use your computer during installation.

During the installation, don't plug in or unplug any devices and don't turn off your
computer.

| InstH Cancel |

Click Install when you're ready to download the latest Server Pack.
Figure 4-5

Download and Configure Windows Live Applications

76

I have some bad news and I have some good news. Don’t worry, the
good news is better than the bad news. The bad news is, Windows 7
doesn’t come with some of the neat and useful applications you've
come to expect from earlier versions of Windows. No E-Mail client, for
example, and no video editing and photo management applications.

Bummer.

But the good news is, Microsoft’'s new concept (Windows Live) offers
all these and more as free downloads. You just have to go online and
install them. And the better news is, these new versions of old favor-
ites have some significant enhancements, so you’ll like them even
better.

Open Internet Explorer and type http://download.
live.com in the browser address bar. The Windows Live
download page appears (see Figure 4-6).
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’@ Essentlals - Windows Live - Windows Internet Explorer [E=EA=x]
'@\__/- v [ ntpraownioadiive.cony @ ‘ 4 ‘ X | [ zing o~
5 Favorites | 5 & suggested Sites ¥ £ | Get More Add-ons ~
| £ Essentials - Windows Live '-’-‘;\, ~ B - [ M= v Page= Safetyv Toolsw ﬁ'
— _ — -
E7windows Live” Hore Profile People Mail Photos Morer MSKT Search Peaple or wetr Sign in ‘E E|
Essentials

e your language!

One download, lots of great stuff :

Mow in one installation, Windows Live Eszentials gives
you instant ressaging, e-mail, blogging, photos, and
more,

English (English) -

Clicking "Download” means you agree to the
Microsoft service agreement and privacy

' statement. The download may indude updates to
203 windows Live programs you already have, vou'll
SRS get future updates to these and other Microzoft
programs from Microsoft Update, Learn rmore

M and e-rmail Bleboe ame Freae Downloa&l—

Stay in touch. With Messenger, you can chat, swap Uze Photo Gallery and Movie Maker to edit and System requirements

photos, and see what's new with friends. Mail organize your photos and movies, and then post
brings together your Hotrmail, Gmail, and other them online or send them to friends, Frograms you can download igclude
accounts, along with multiple calendars, Photo Gallery e
Me_ssenger Movie Maker beta Mail
el Writer
Photo Gallery
EBloggin Webh browsing Movie Maker beta
With Windows Live Writer, blodging is a breeze. With Toolbar, you can customize your browser and Family Safety
You can add photas and videof, format everything  find what you need, fast. Family Safety helps you Taolbar
just so, and publish to most bldgging services, keep your kids safer online, "

= S Additinnal nronrarms: - 4

@ Internet | Protected Mode: On i ov Hi0x -

el o w T B

Click on the links beneath the individual
programs for more information.

Click Download to retrieve all Live programs at once.
Figure 4-6

2. Click Download to open a Download dialog.

3. Click Run if you are asked if you want to Run or Save the
program.

4. Depending on your security settings, you may be asked if
it is OK for the downloaded program to make changes to
your computer. Say Yes. The Windows Live installer will
launch and display the screen shown in Figure 4-7.
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Check the programs you want to install.

£7 Windows Live — . e

Choose the programs you want to install

Click each prograrm name for details,

¥ & Messenger Messenger

& G wail Send instant messages to contacts or groups, play
garnes, share pictures as you chat, and see what's
L] B :
" &' Photo'Gallery new with people you know,
¥ &7 Toolbar

@ b writer Installed with this program:

o Microsoft Application Error Reporting
* Microsoft Visual Studio Runtime

[V @ sikerlight e Windows Live Cormmunications Platform
o Windows Live Call

¥ 80 Family Safety

B movie Maker Beta

Space needed: 169 MEB
Space available: 2,35 GB
Install | | Cancel

Figure 4-7

Click each program name to display a short descrip-
tion to help you decide whether you want to install it.

5. Click Install. You may be asked to close open programs
so the installer can make changes to them.

6. Click Continue after the download and initial install are
complete to set some configuration options.

7. Click Sign Up if you want to create a Windows Live
online ID at this time. If not click Close.

8. Choose Starte>All Programs and click Windows Live to
display a list of the programs you just installed.
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9. Click a program name to launch the application.

Fix Corrupted Program Files

It may be a dirty little secret among computer users, but your program
files and other data can become corrupted and dysfunctional through
no direct fault of your own. If you practice good hardware mainte-
nance and back up your working hard drives regularly, the chance of
suffering corrupted files is small. Fortunately, if your files do become
corrupted (and they probably will, if you use your computer long
enough), you have a way to recover.

1. Close the offending program, if it’s running.

2. Choose Start=>Control Panel to open the Control Panel
window.

3. Follow the instructions in “Uninstall a Misbehaving
Program When All Else Fails,” later in this chapter. You'll
be asked to choose the program from a list.

Fix Corrupted Device Drivers

1. Choose Starte>Control Panel to open the Control Panel
window.

2. Follow the appropriate step for your version of Windows:

e Windows XP: Double-click the System icon; then
click the Hardware tab in the resulting dialog box,
and choose Device Manager.

¢ Vista and Windows 7: Click System and Security
(in Windows 7) or System and Maintenance (in
Vista); then choose System=>Device Manager.

79



Part ll: Keeping Your PC Healthy with Preventive Maintenance

Whichever method you use, the Device Manager dialog
box opens.

3. Select the troublesome hardware device.

4. Click the Driver tab (see Figure 4-8).

Chicony USB 2.0 Camera Properties [7 ==

@=== Chicony USB 2.0 Camera

Driver Provider:  Chicony

Driver Date: 1/9/2007

Driver Version: 6.109.1.0

Digital Sigrer: microsoft windows handware compatibility publist

Driver Details To view details about the driver files.
Update Driver... | To update the driver software for this device.

If the device fails after updating the driver, roll
back to the previously installed driver.

Disable | Disables the selected device.
Wl To uninstall the driver (Advanced).

| oK H Cancel |

Click to launch the Windows update wizard.
Figure 4-8

5. Click the Update Driver button.

6. Follow the onscreen instructions to help Windows find a
driver for the selected hardware. You may be asked to use
the installation CD or DVD that came with your hard-
ware. If you have it, use it; if you don’t, Windows will go
online to search the Internet for the proper driver.

80



Chapter 4: Taking Care of Software

You probably can update the driver yourself, direct
from the source. Go to the manufacturer’s support
Web page and enter the model of your hardware, and
you're likely to be able to download a self-installing
driver. When you take this approach, you may get
additional software, such as (in the case of a camera
or scanner) a photo-editing application.

Uninstall a Misbehaving Program When All Else Fails

You have three ways to remove a program from a computer running
Windows. The first two methods usually work well; the third is dan-
gerous and not recommended.

w=  Windows utility: Use the Add or Remove Programs
utility (Windows XP) or the Uninstall or Change a
Program utility (Vista and Windows 7).

Not all programs that you install on your computer
make use of this utility.

1. Choose Start=>Control Panel to open the Control
Panel window.

2. Follow the appropriate step for your version of
Windows:

¢ Windows XP: Double-click the Add or Remove
Programs icon to open the Add or Remove
Programs window.

e Vista and Windows 7: Click the Programs and
Features icon to open the Programs and Features
window (see Figure 4-9).
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@Ov » Control Panel » Programs and Features - | +5 | | Search pel |
File Edit View Tools Help
Nashs Uninstall or change a program
View installed updates
; To uninstall a program, select it from the list and then click "Uninstall”, "Change”, or "Repair”.
Get new programs online at
Windows Marketplace
View purchased software - \ﬁews -’ @
(digital locker) Name = Publisher Installed ... Size =
§ Tum Windows featuresonor  [HPetf LRGN Adobe Systems Incorporated | 1031/2008 167 ME ;
off " Activation Assistant for the 2007 Microsoft Offi... Microsoft Corporation &/15/2007 13.5 MB =
B Adobe AIR Adobe Systems Inc, 10/31/2008 1
.Adobe Flash Player 10 Plugin Adobe Systems Incorporated 4/9/2009
n‘Adobe Flash Player ActiveX Adobe Systems Incorporated &/15/2008
E Adobe Reader9 Adobe Systems Incorporated 10,/31/2008 202 MB
["] Adobe Shockwave Player Adobe Systems, Inc, 8/15/2007
Mame 4/30/2008 7.2 MB
si' AOL Mail and AIM Gadget AOQLLLC 1/2/2008 576 KB
E-“‘ AQL Uninstaller (Choose which Products to Re... 10/3/2007
‘EAppre Software Update Apple Inc 9/25/2008 215 MB
Bejeweled 2 Deluxe WildTangent &/15/2007 16.4 MB
- Blackhawk Striker 2 WildTangent 8/15/2007 19.7 MB
ag EBlasterball 3 WildTangent 8/15/2007 213 MB
‘B Blueto ath Stack for Windows by Tashiba 3/1/2007 540 MB
|5 | Camera Assistant Software for Toshiba Chicony Electronics Co., Ltd. 8/15/2007 61.58 MB
@ Canon G.726 WMP-Decoder Canon Inc. 6/17/2008 232KB
Canon MovieEdit Task for ZoomBrowser EX Canon Inc. 6/17/2008 49.0 MB
@Canon RAW Image Task for ZoomBrowser EX Canon Inc. 6/17/2008 134 KB
@Canun Utilities CameraWindow Canon Inc, 6/17/2008 2,26 MB
ﬁCanon Utilities CameraWindow DC Canon Inc, 6/17/2008 562 MB
l:*_gc‘anon Utilities CameraWindow DC_DV 6 forZ...  Canonlnc, 6/17/2008 17.2 MB
,@Canon Utilities MyCamera Canon Inc, 6/17/2008 143 MB 2
D Coectos Lozonnn 440 uan

Vista lists all your programs in this window.
Figure 4-9

3. Select the program that you want to uninstall.

4. Click whatever uninstall button the program provides
(such as Change, Remove, Change/Remove, or
Uninstall/Change; see Figure 4-10), and follow any
onscreen instructions.

5. Follow any onscreen instructions.
6. Restart your computer if you're prompted to do so.

w= Manufacturer utility: Use a specialized Remove or
Uninstall utility that the program’s installer put on
your computer along with the software program.
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3‘5 Add or Remove Programs =[E]=)
r'":_l. T
\ﬁ Currently installed programs and updates: Show updates Sort by: | Mame | vl
Change or Y CANON UTITES CameEravwWinaow oo Size T EINE |A
Remove —
Programs c’g Canon Utilities CameraWindow DC_DV 5 for ZoomBrowser EX Size 9.22MB
;j@ Canon Utilities CameraWindow DiZ_DW & for ZoomBrowser EX Size 17.23MB
EB & Canan Utilities ECS Utility Size 11.56ME | =
Add Mew e i
Programs ,_a Canon Utilities MyCamera Size 14.33MB —
,vi_'g Canon Utilities MyCamera DC Size 14.21MB
@ {2} Canon Utilities PhotoStitch Size  G.14MB
Add/Remave " v ;
Windows E Canan Utilities RemoteCapture Task for ZoomBrowser EX Size 15.05MB
Companents ﬁ Canon Utilities ZoomEBrowser EX Size 49,05MB
@ ﬁ Canon ZoomEBrowser EX Memary Card Utility Size 18.54ME
i5 capicom
Set Program
Access and ﬁl Security Update for CAPICOM (KBE931906]
Detallits (&l CO/DVD Drive Acoustic Silencer Size  LOSME
@ Checklt Diagnastics Size 9.53MB

Remave
L

ﬁ‘! DVD-RAM Driver Size 093MBE
Eg Easy Button Size 1.44ME
E getPlus(Rj_oox

@ Goagle Earth Size 3234MB
ﬁ! Intel{R} Extreme Graphics 2 Driver Size 216MB |'v

Click Remove to delete the selected program in Windows XP.
Figure 4-10

In some cases, you may have to find an uninstall util-
ity on the CD or DVD that you used to install the
program, or you may have to download an uninstall
utility from the manufacturer’'s Web site.

1. Choose Start=>All Programs (or Programs) to display a
list of all the programs on your PC.

2. Select the program you want to uninstall. If you see a
right-pointing arrow next to its name, multiple
options are available; place the mouse pointer on the
arrow to expand the menu, and choose the uninstall
option.
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3. Follow any onscreen instructions.
4. Restart your computer if you're prompted to do so.

w= Manual deletion: Delete the program from your
hard drive manually; then search for and remove all
its interconnections with Windows and other

programs.

Brute-force removal of components is not recom-
mended — at least, not for an unassisted amateur.

Merely deleting a program from your hard disk

doesn’t remove all its interconnections with other

applications and may do more harm than good.
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Practicing
Good Computer
Hygiene

T1€ best repair is the one you don’t have to
make. If you can keep your computer up to
date and in tune, you and your PC will live
happier, more productive lives.

The best defense against aging or sudden death
is keeping your computer cool, calm, and col-
lected. By that, I mean ensuring that it doesn't
overheat; that it’s protected from electrical
surges; that the logical parts are efficiently
organized; and that the programs aren’t scram-
bled, garbled, or improperly altered.

In this chapter, I talk about preventive and
diagnostic measures that help you keep your
computer in good health and spot problems
before they become serious. Think of this
chapter as providing vitamin pills, medical
scans, and a safe deposit box for your PC.

| “*apter

Getready to. ..

w= Run the System Configuration

Utility oo, 86
w= Run Microsoft Office

Diagnostics .........ccceevvrennne. 88
w= Clean Up Your Hard

Drive c..oveeiiiicccc 90
w= Defragment Your

Hard Drive.......cccccoeienene. Q1
= Test for Chinks in the

Security Armor.................... 93
w= Keep Things Cool ............... 95
w= Mind Your Monitor ............. 98
w=» Pamper Your Printer .......... 101
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Run the System Configuration Utility
1. Follow the appropriate step for your version of Windows:

¢ Windows XP: Choose Start=>Run to open the Run
dialog box, type msconfig in the Open text box,
and press Enter.

¢ Vista and Windows 7: Click the Start button, type
msconfig in the Search Programs and Files field at
the bottom of the screen, and press Enter; then
click Msconfig in the resulting list.

Whichever method you use, the System Configuration
dialog box opens (see Figure 5-1).

Click a tab to view related settings.

L1 System Conflgufation [

| General | Boot i:Ser\-'ices Skartup Tools ,I

Skartup selection

Mormal startup
Load all device drivers and services

" Selective startup

Load system services
Load starkup items

Use atiginal boat configuration

QK ] | Cancel | | Apply | | Help

Figure 5-1

2. Select Diagnostic Startup on the General tab and then
click OK. The System Configuration utility takes a few
moments to disable all but the most necessary applica-
tions that run at startup; then it displays a Restart
dialog box.
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3. Click Restart to restart your computer in diagnostic
mode. In Windows XP, you see a message reminding you
that diagnostic mode is active. In Vista and Windows 7,
note the change in the Start button; the text-only button
indicates diagnostic mode.

4. Click OK to close the message and launch System
Configuration. In Vista and Windows 7 you have to
relaunch this utility as described above.

5. Leave the utility running, and test your system.

Some things, such as custom Internet Explorer tool-
bars, may not run during testing because the System
Configuration utility disables them.

6. Click the Services tab, and scroll through the list of soft-
ware services that run each time your computer starts,
looking for suspect applications: those from unknown
manufacturers or those with names that don’t seem to fit
anything you're using.

facturer as Microsoft, and most of them will be dis-

@ Most of the services in this list will show the manu-
abled. You can probably ignore those services.

7. Make only one change at a time.

8. On the General tab of the System Configuration dialog
box, select Normal Startup, and click OK. When your com-
puter restarts, see whether you've corrected the problem.

9. If the problem persists, repeat Steps 1-8, adding new
applications one at a time. If the problem returns after
you add an application, you've found the software that is
causing it. Contact the manufacturer, or download an
update from the Internet.

10. Click the Startup tab (see Figure 5-2), and conduct a sim-
ilar inspection and test.

Chapter 5: Practicing Good Computer Hygiene
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Study this list, and reenable applications one at a time.

£l System Conflguration =)
| Gereral | Boot | Services | Startup | Tools |

Startup Ikem Manufacturer Command Location Date Disabled
'__,__I Windows Live Messenger  Microsoft _*E’frj:p; % '.f.\'E:'IJT'p:@:am Fil.... HFE.I‘IIJRSI:'.’.‘.F'I'-’::'-!}-’&. o
I_2| cdloaderz magiclack L.P, "CiiUsersiTom...,  HKCLUVSOFTWA...
] m ] 3

[ Enable all ] I Disable all |

[ oK J | Cancel I l Apply | | Help I
.
Figure 5-2

1 1. Review the list of additional utilities available on the
Tools tab. To use one of these programs, select it and
then click the Launch button at the bottom of the
dialog box.

System Configuration is a useful tool that may help

you uncover problems and certainly will give you
information about your system. Use it cautiously,
however. I recommend that you stay away from the
NI tab in Windows XP and the Boot and Services
tabs in Vista and Windows; you could change some-
thing on these tabs that would make your computer
unusable.

Run Microsoft Office Diagnostics

1. Close all running applications, including Microsoft Office
applications. You shouldn't try to use your computer
while the diagnostics utility is running.
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2. Choose Start=vPrograms=>All Programs=>Microsoft Office.

3. Select Office Tools and then click Microsoft Office
Diagnostics to display the opening dialog box shown in
Figure 5-3.

B Microsoft Office Diagnostics =)

Is Microsoft Office having problems?

Running Office Diagnostics may help.

Office Diagnostics can help to identify problems and may be able to repair your
installation of Office. Diagnostics can take up to 15 minutes to run and may connect to
Microsoft's servers. Click Continue to get started.

I Contigue ]| cancel {

Click Continue to launch a series of health-check utilities.

Figure 5-3

4. Click the Continue button to start the diagnostics rou-
tines, which test items including the following:

e Microsoft Office setup and configuration
e Hard drive health and function

e System memory (RAM)

e Program compatibility

e Known solutions

5. Follow any onscreen instructions.
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Clean Up Your Hard Drive

1. Choose Start=>All Programs=>Accessories.

2. Select System Tools, and click Disk Cleanup to open the
Disk Cleanup dialog box (see Figure 5-4).

Choose the files you want to remove.

= Disk Cleanup for (C:) [

Digk Cleanup !

+ . “ou can use Disk Cleanup to free up to 4.85 MB of disk
space on [

Files to delete:

oaded Program Files
=] Temporary Internet Files 2E7 MB
[#3 Offline Webpages FEEKB
@/ Recycle Bin 583KB -

T |2 [T r

Total amount of disk space you gain: 467 MB
Description

Downloaded Program Files are Activel contrals and Java applets
downloaded automatically from the Intemet when you view certain
pages. They are temporarily stored in the Downloaded Program
Filez falder an vour hard disk.

| 'ﬂ_-g' Clean up syztem files | | Wiew Files

How does Disk Clearup work?

[ ] ]| Cancel |

Click OK to start the cleanup process.
Figure 5-4
3. In the Files to Delete list, check the boxes next to the

names of the files you want to remove, and clear the
boxes next to any files you want to keep.

4. Click the Clean Up System Files button to expand the list
of files you can remove safely, such as error reports and
log files.
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5. Click the More Options tab (which appears after you
click Clean Up System Files in Step 4) to clean up pro-
grams you don't use or to remove System Restore files.

You should remove System Restore files (see Chapter

16) and shadow copies only if you're desperate for
hard drive space. These files can help you get your
system back to normal if the current installation files
become damaged or your configuration gets out of
whack.

6. Click OK to start the cleanup process.

7. When Windows asks you whether you're sure that you
want to delete these files, click Yes.

Disk Defragmenter utility (see the next section) so

@ You should run Disk Cleanup before you run the
the regained disk space will be defragmented too.

Defragment Your Hard Drive

1. Choose Start=>All Programs=>Accessories.

2. Select System Tools, and click Disk Defragmenter to open
the Disk Defragmenter dialog box (see Figure 5-5).

¢ Vista and Windows 7: This dialog box automati-
cally shows you the percentage of fragmentation
on the selected hard drive; proceed to Step 3.

¢ Windows XP: Click the Analyze Disk button to
display a complete report on your hard drive,
including the percentage of fragmentation; then
proceed to Step 3.
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Ej Disk Defragmenter Lil_lﬂ_hj

v Disk Defragmenter consolidates fragrmented files on your computer's hard disk to improve system
« performance, Tell e more about Disk Defragrmenter,

Schedule:

Scheduled defragmentation is turned on | ) Configure schedule..
Run at 1:00 &M every Wednesday

Mext scheduled run: T/22/2009 2:33 Ak

Current status:

Disk Last Run Progress
iy T/16/2009 12:52 A (43 fragmented)

Only disks that can be defragrmented are shown,
To best determine if wour disks need defragrnenting right now, you need to first analyze your disks,

B Analyze disk | | B Defragment disk |

| Close |

Click Analyze Disk to produce a report on the selected drive.
Figure 5-5

3. Check the fragmentation report to decide whether you
need to defragment the selected drive. A drive with 10
percent or more fragmentation should be defragmented.
(If you've been using your computer for a while, the
drive may show 50 percent fragmentation or more.)

4. To defragment the selected drive, quit any other running
programs and then click the Defragment Disk button.
This process can be lengthy, and you really shouldn't be
running any other software while Defragmenter works,
because you could be creating and saving files while the
utility is trying to consolidate them.
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In Windows XP, you have to remember to run the
Defragmenter utility periodically. In Vista and
Windows 7, by default, the utility runs automatically
on all connected hard drives once a week. To set your
own defragmentation schedule, click the Configure
Schedule button in the Disk Defragmenter dialog box.

Test for Chinks in the Security Armor

You can find lots of free security tools online. I rec-

@ ommend ShieldsUP!, which sends a series of probes
to see which ports (think of them as doors; see
Chapter 2) are open on your computer and what details
you're telling the world about yourself or your personal
and business secrets. This tool won't fix the problems
that it finds, but it will give you some indication of
whether the security program you have installed is
doing an adequate job or needs adjustment.

1. Point your Web browser to the Gibson Research Web site
at www.grc.com.

2. Click the ShieldsUP! logo.

3. In the resulting page, scroll down to and click the
ShieldsUP! link.

4. Review the opening screen, which shows you the infor-
mation about your Internet connection that’s presented
when you visit a Web site.

5. Click the Proceed button to display a list of services (see
Figure 5-6). To get more information on any service,
click the Explain This to Me link.
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. Fawarites = 'é Suggested Sites * & | Get More Add-ons ¥

I [ File Sharing

{ User Specified Custom Port Prabe Lool.up Specific Port Information

Or enter a port to lookup, or the pores for & cfstam probe to check, then
choose the service, Your computer at IP 71.F8.197.178 will be tested,

Flease see Explain this fo fnel below for
information about Windowg File Sharing
and Internet port vulngrabilities.

The following pages provife additional
background, insight, and assistance:

6 Explain this to me.
Sharing files among locally-connected computers is incradibly convenient afd makes all kinds of sense, But Local Area Networking (LAN)
technology was never designed for the global Internet, It seems that it wasp't thought through very well, (Qops.)

6 Am 1 really in any danger?
You might be thinking “Hey, the Infernet's & huge place, Hight? Mo one's evdr going to notice me,” Sure, But technically sawyy intruders are
using high-speed "Internet Scanners” that can probe every cormputer in a sfnall country within a short time! Nothing would make themn
happier than lifting your personal information, credit card numbers, bank adeount balances, and so forth through your computer's insecure
connection to the Internet,

4’ What can 1 do about this?
It's possible to spend no money and disappear from their scanners, or to sgend a little bit of money and gain many valuable security
capabilities. I'll show yvou how,

9 MNetwork Bondage.
Microsoft's netwarking technology is only required for sharing files and prifger services with other Microsoft-based PC's| It is not needed
for connecting to the Internet or for using any Internet services, It has no Husiness wandering around the Internet and should be disciplined
to remain within your own computer or local area network,

@ Evil Port Monitors,

Mar cnrmmaniae are alvasde avelaitins the fasr of Trtarnat inkeicine by colllnn maalle had cnlutinne in tha farm of Yinkeoder datarkoee!

Cane @ Internet | Protected Mode: On g v

# 0%

45 GRC | ShieldsUP! — Internet Yulnerability Profiling M- v 7 fdm o+ Pagew Safety Toolv @
HOME. eldsUPIl Service AED
| Common Ports All Service Ports Messenger Spam | Browser Headers ]

-

[€ GRC | ShleldsUP! — Internet Vulnerahllity Proflling - Windows Internet Explorer [E=NIEE
@\J - ||_‘| http ffanunse gre.comne.dil Frhdicyd 2 v| = |'7| % | [ ging o~
e . . . el
£ Windows Live  Bing E * what's Mew  Profile  Mail  Photos  Calendar  MSN  Share 2 [ thadgett@sy., v |

m

Ole - 0O S ma®

Click a service button to begin a test.

Figure 5-6

6. Click a service name to start a scan of your computer.
Figure 5-7 shows the beginning of a Service Ports probe,
which tests the first 1,056 ports. (I've obscured the details
about my computer shown at the top of the scan. You
understand why, don’t you?)

7. Study the finished-test display. All boxes green is a per-
fect score, meaning that all your PC'’s ports are secure.

You should read the support information in this
screen, which provides valuable information about
your computer’s security.
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@ GRC | ShleldsUP! — Service Ports Probe - Windows Internet Explorer
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Figure 5-7

Keep Things Cool

w= Check the vents. Make certain that the intake and
exhaust vents on your computer aren’t blocked. Most
vents are on the back of the computer; if you have a

PC with that design, don't pl
against a wall or curtains.

1)

ace the back of it flush

Clean the vents. Every few months, use a handheld

vacuum to remove dust buildup on the intake and

exhaust vents.
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w= Check airflow. Once a week (more often if your
computer starts to crash or otherwise becomes unre-
liable), check the flow of air coming out of your
computer by placing your hand near the vent. The
air should feel warm but not painfully hot. If you
don't feel air coming out of the exhaust vent, follow
these steps:

1. Visually inspect the fan housing on the back of your
computer (see Chapter 2). If the fan isn’t turning, the
motor may be bad, or a power connector may be
unplugged. If the fan is turning, but little or no air is
coming out, something may be clogging the air path.

2. Shut down the computer.

3. Unplug the power cord and any other cables that
could block your access inside the computer.

4. Place the computer on a sturdy, well-lighted work
surface, and open the case (see Chapter 2). See this
book’s information about grounding yourself.

5. If the fan wasn't turning in Step 1, make sure that its
power connector is attached securely. If it isn't, fix the
connection. If the connection’s already secure, you
probably need a new fan. Contact a computer repair
facility.

6. Carefully feel for hot spots, and look for blockages in
the thermal tunnel that runs (in most modern cases)
from the front to the rear of the unit (see Figure 5-8).

7. Use a vacuum cleaner or a small, clean paintbrush to
remove dust inside the case. Pay particular attention
to the louvers around the outside of the case where air
is supposed to enter the enclosure.
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Check both ends of this tunnel for dust, which could restrict airflow.

Figure 5-8

2 You should keep the inside and outside of your com-
@ puter case clean, but the components are delicate.
Use caution with a vacuum cleaner or brush! You
don’t want to disconnect any wires or damage
anything.

8. Look for additional fans. Many computers have multi-
ple cooling fans, and they all need to work to provide
proper cooling.

9. Close the case, and hook everything back up.
10. Turn on the computer, and recheck airflow.

w= Check the fans. Look and listen to determine
whether the power-supply fan and any auxiliary fans
are running. If small auxiliary fans have stopped
working, you should replace them; if the power-
supply fan isn’t working, you should replace the
entire power-supply unit. See Chapter 9 for details
on both procedures.
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Mind Your Monitor

w= [Ise a surge protector. Never plug your display
directly into wall current. Instead, be sure to use a
good-quality surge protector (see Chapter 1).
Damage caused by an electrical spike ordinarily isn't
covered by manufacturer warranties.

w= Keep the air vents open. Never cover the air vents on
the top or sides of a monitor. Doing so could result
in a dangerous buildup of heat that could damage
components or shorten their lives. Periodically, use a
new paintbrush or the brush attachment of a vacuum
cleaner to remove accumulated dust on the monitor’s
ventilation holes.

w= Leave it on. The most dangerous moment in an elec-
tronic component’s life is when power is first applied,
and the component goes from cold and uncharged to
warm and full of electricity. Avoid turning your moni-
tor on and off more than necessary. You can reduce
power consumption by following these steps:

1. Right-click your desktop, and choose Properties
(Windows XP) or Personalize (Vista and Windows 7)
from the shortcut menu.

2. Follow the appropriate step for your version of
Windows:

e Windows XP: Click the Screen Saver tab of the
Properties dialog box.

¢ Vista and Windows 7: Click the Screen Saver tab
of the Personalize dialog box; then click Change
Power Settings.

Whichever method you use, you see the dialog box
shown in Figure 5-9.
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Click to set the time delay.

=] ] [
oy = . ¢ |
v@vl@ ¥ Control fanel » Hardware and Sound » Power Options - | +y | | Search Cartral Parel 2
Control Panel H @
ontrol Panel Home
Select a power plan
Require a password on wakeup Power plans can help you maximize your computer's performance or conserve energy. Make a plan
active by selecting it, or choose a plan and customize it by changing its power settings. Tell me more
Choose what the power about power plans
buttons do
Create a power plan Preferred plans
[ Choose when to turn off the @ Balanced (recommended) Change plan settings
display Automatically balances performance with energy consurnption an capable hardware.
W Change when the computer R )
sleeps *) Power saver Change plan settings
Saves energy by reducing your cormnputer’s performance where possible,
Show additional plans &

Personalization

User Accounts

Figure 5-9

3. Click Choose When to Turn Off the Display to set the
time delay before Windows turns off your monitor.
You also can set system sleep delay and some other
options in this dialog box.

Vista and Windows 7 have preprogrammed power-
saving settings. You can accept one of these settings
or customize the times.

w= Check the connections. Make sure that the cable
between the monitor and the video card is firmly
attached at each end and not crimped or pinched. If
you need to make adjustments, follow these steps:
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1. If your monitor has a removable cable, unplug it and
then replug it into the receptacle on the monitor (see
Figure 5-10). This step could reset a loose connection
and remove corrosion on any of the connectors.

Unplug and reset all cables.

:Figure 5-10

2. Unplug and reconnect the monitor cable at the com-
puter end. You may have to use a screwdriver or
thumbscrew to unlock the connection before you can
unplug it. Use these locking screws when you replug

the cable.

w= Klutzproof it. Be sure that the monitor is safely
installed on a sturdy desk, with its cable properly out
of tripping range of passersby. I don’t have to warn
you about placing cups of coffee or soda anywhere
in the vicinity, right?
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w= Keep it squeaky-clean. Read the instructions that
come with your printer, and follow the recom-
mended cleaning cycles.

¢ Inkjet printers: For an inkjet, cleaning usually
involves keeping the nozzles clear through regular
use or by running a built-in cleaning program.

months, you may want to remove the ink cartridge
(or each ink cartridge, in the case of color printers)
and store it in a closed case so that it won't dry out.
Figure 5-11 shows a typical inkjet printer with
instructions for changing cartridges under the lid.

@ If you don't expect to use an inkjet printer for several

Open your printer case, and follow the directions for replacing cartidges.

Figure 5-11

Chapter 5: Practicing Good Computer Hygiene

101



Part ll: Keeping Your PC Healthy with Preventive Maintenance

¢ Laser printers: Follow the manufacturer’s cleaning
instructions, which may include careful vacuuming
of the interior of the machine, and keep the inter-
nal drum away from direct sunlight and extreme
temperatures.

w= Control the humidity. Many printers are prone to
paper jams and quality problems in times of high

humidity.

paper in a sealed plastic box, and load it into the

@ One solution for the summertime blues: Keep your
printer tray only when it’s needed.
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Keeping Intruders |,
out of Vour “Bhoprer
Computer

Getready to. ..
How can a box of metal, silicon, and plastic

parts be laid low? Consider the following »= Play Smart Defense .......... 104
ills that computers are heir to: . Configure Windows
> Viruses: A computer virus or other con- Security Center................. 105
dition that falls under the broad term w= Build a Firewall in
malware is an infection that takes over Windows .........cccevevvaan, 107
Windows or another program, making '
your computer do Something you don’t w= Check for Viruses.............. 109
want it to do. w= Fight Malware................... 110
"= Spyware: Spyware, which is another form = Stop Spyware................... 114
of malware, hides on your computer and
watches everything on it: the Web sites w= Avoid Getting Hooked
you visit, your login names and pass- by Phishers....................... 116
words for banking, even the text you
compose for e-mails and instant w=> Can That Spam ................ 118

messages.

w= Phishing (pronounced fishing): This elec-
tronic con game tricks computer users
into revealing valuable information such
as bank account or credit card numbers.
The most common form is an e-mail that
appears to come from your bank or credit
card company, asking you to update your
account or provide additional information.
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w= Spam: Spam is electronic junk mail, unwanted adver-
tisements, or just plain @!*"%&# that arrives in
your inbox. Besides being annoying, it can expose
you to the risk of downloading malware.

In this chapter, I give you pointers on defending your PC from all
these security breaches.

Play Smart Defense

w= Be legal. Buy and use only legal copies of all soft-
ware on your computer, and register your name and
e-mail address with the makers. To put it another
way, don’t buy or use bootleg copies of software, and
be very cautious about using software offered by
companies or people you don't know and trust.

w= Stay current. Keep all software up to date, installing
updates and patches as the manufacturer releases them.
(For details on updating software, see Chapter 4.)

w= Install security. Install a capable antivirus or com-
prehensive security package, and use it regularly to
scan your computer (see “Check for Viruses,” later in
this chapter).

security protection as part of your service package.
Comcast, for example, offers the McAfee antivirus
program (see Figure 6-1).

@ Your Internet service provider may offer antivirus or

w= Take advice. Follow the manufacturers’ recom-
mended security settings for Windows, your Internet
browser, and your security software.
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(Comcast. Security

Home

» Protection Status
Start Here Am I Protected? Yes
Backup and Restore Files ‘Your computer protection services are enabled and up-to-date, No action is required,
Lockdown Firewall

Restore Firewall Defaults
Update

Computer & Files These services are protecting your computer @
et and files:
= Virus Protection

Scan
View Recent Events

Manage Network o Internet & Network # Spyware Protection
&l

Maintain Computer Protected @ * SystemGuards
= Windows Protection
¥ ® PC Health
E-mail & IM
Protected @
Home @ ::t;ﬁggﬁl Controls @ To change your options, dick Configure below.
Reports & Logs @ Configure
Configure SecurityCenter Information
Update Check: 4/21/2009
i Last Scan: 4/3/2009
Tools
L 4 @ Configure @ About
(3) Basic Menu
Security services
.
Figure 6-1

Configure Windows Security Center

1. Choose Start=>Control Panel to open the Control Panel
window.

2. Follow the appropriate step for your version of Windows:

e Windows XP and Vista: In Classic View, double-
click the Security Center icon.

¢ Windows 7: In Classic (icon) View, click Action
Center and then choose Security. In Category
View, click System and Security; then click Action
Center and choose Security.
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Whichever method you use, Windows Security Center

opens, displaying an opening screen similar to the one
shown in Figure 6-2.

Click to get more information online.

= ==
B Windows Update Security essentials
| : To help protect your computer, make sure the four security essentials
Nindows Firewall
below are marked On or OK.
Windows Defender Using Windows Security Center
B Internet Options =
Firewall On @ (&)
St the el sECHmLy ahd @ MchAfee Personal Firewall reports that it is currently turned on.
virus information online from 3 $
; Show me the firewall programs on this computer,
Microseft
Change the way Security Np;e: T\o\:.l o;more firewalls running at the same time can conflict
Center alerts me uEth Each ey
How does a firewall help protect my computer?
Automatic updating On@ (v
‘Malware protection On ©
Virus protection On @
i McAfee Virusbcan reports that it is up to date and virus scanning
is on.
Spy and other malware protection On @
Windows Defender and McAfee VirusScan both report that they are
turned on,
How does anti-malware software help protect my computer?
See also Other security settings OK @ | (v
Backup and Restore —

Note the settings for Security Center’s monitored areas.
Figure 6-2

3. Study this screen to understand what Windows Security
Center is monitoring and make sure that your computer
is protected. If all sections are marked On or green,

Security Center is configured properly, and crucial secu-
rity software is running.
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®

Vista and Windows 7 also include an Other Security
Settings section, where you can check the status of
User Account Control (UAC) and Network Access
Protection (NAP). UAC lets you know when pro-
grams try to make changes in your computer. NAP,
which is for corporate networks, verifies individual
computer configurations and manages automatic
updates.

Build a Firewall in Windows

1. Choose Start=>Control Panel to open the Control Panel
window.

2. Follow the appropriate step for your version of Windows:

e Windows XP: In Classic View, double-click the
Windows Firewall icon.

¢ Vista and Windows 7: In Classic View, click
Windows Firewall. In Category View, click System
and Security and then select Windows Firewall.

Whichever method you use, Windows Firewall opens,
displaying a screen like the one shown in Figure 6-3.

®

A public network is simply one that anyone can access
without entering a passcode. This type of network
may be in your home or at a business. Unless you
live in a remote area, your home network should be
passcode-protected. This topic is beyond the scope of
this book; for full details, see Home Networking For
Dummies, 4th Edition, by Kathy Ivens (Wiley
Publishing).
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108

Click these links to configure your firewall.

=

@;\_/719 » Control Panel » System and Security »  Windows Firewall

= [ 42 || sewen contrat paet

Control Panel Home

Allow a program or feature

through Windows Firewall
18 Change natification settings

“,‘ Turmn Windows Firewall on or
off

1% Restore defaults
i Advanced settings

Troubleshoot my network

See alsc
Action Center

Network and Sharing Center

Help protect your computer with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your computer
through the Internet or a network.

How does a firewall help protect my computer?

What are network locations?

. a‘ Home or work (private) networks Mot Connected (&

MNetworks at home or work where you know and trust the people and devices on the network

Windows Firewall state: On

Incoming connections: Block all connections to programs that are not on the

list of allowed programs
Active home or work (private) networks: MNone

Motification state: Motify me when Windows Firewall blocks a new

program

. @‘ Public networks

Networks in public places such as airports or coffee shops

Connected (4

Windows Firewall state: On

Incoming connections: Block all connections to programs that are not on the

list of allowed programs

Active public networks: 1 Cove'sEnd (5 GHz)

Notification state: Motify me when Windows Firewall blocks a new

program

Figure 6-3

3. If you need to expand access through the firewall, click

the Allow a Program or Feature through Windows
Firewall link. Certain applications, such as Windows Live
Syng, are given expanded access automatically, but you
may also want to give access to devices such as cell-
phones or media players, or to a custom business or per-
sonal application.

4. Click Turn Windows Firewall On or Off if you want to

disable the firewall completely for testing or to allow spe-
cific one-time access. (Just remember to turn the firewall
back on when you finish.)
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If you prefer, you can use a separate firewall product
or one that’s built into a third-party security program.
Follow the manufacturer’s instructions about using
the firewall product on a PC that also has Windows
Firewall installed.

Check for Viruses

If your computer doesn’t have a capable, up-to-date

antivirus or broader Internet security program, stop
reading right now. Go get one of these programs,
install it, and give your computer a full scan. Be sure
to follow the instructions carefully. Some manufac-
turers set up their antivirus products so that they scan
your system before they're installed; others take over
after they're in place.

1. Make sure that you always have the latest updates for
your antivirus or security program. Some programs check
for and download updates automatically based on a
schedule that you set. You can always check for updates
manually as long as you do so regularly (see Figure 6-4).

2. Every week or so, use the program to scan your computer
for viruses.

on your computer — if files are missing or renamed,
for example, or if your Internet home page has
changed without your knowledge. Do this even if
you scanned your PC recently, because viruses can
attack at any time.

@ Run the program any time things suddenly go strange

3. If your computer’s antivirus or Internet security program
displays an ominous warning, follow the onscreen
instructions carefully to remove or quarantine the threat.
Many security-software makers offer specific tools for
removing particular virus strains that broke out into the
wild despite precautions by computer users.
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() LiveUpdate
Options

x]

(2))

P

Privacy statement

Welcome to LiveUpdate ’ symantec..

The following Symantec products and components are installed on
your computer:

@) LiveUpdate -~
D Norton AntiVirus

D Norton AntiVirus Branding Resource Update

El Morton AntiVirus Intemet Worm Protection Signature Upd
[ "I Nerton Antivirus Option Refresh Update ™
< M |

Livellpdate will use the Internet to search for updates to your
installed Symantec products and components.

Click Next to see available updates.

[ Next > ][ Cancel ] [ Help

Click to check for security and antivirus updates.

Figure 6-4

Fight Malware

w= Inspect e-mail before opening it. Pay attention to
the details of an e-mail before you open it. Be espe-
cially cautious about e-mails that are addressed to
undisclosed-recipients or to a name you
don't recognize, and about e-mails that have a blank
or odd Subject line. Anything you receive by e-mail
that seems too good to be true probably is (see

110
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E-mail that's not addressed to you personally means
spam at least and possibly something more nefarious

|| COMGRATULATIONS!! - Cyrillic (Windows) =B &
File Edit VYiew Tools Actions Help

42 Reply s Replyall = | Forward 7% Delete & Mot Junk mail :‘fBIog pm ¢ Previous - Next R '6f'

DrTina Akra Add to contacts

—= To: undisclosed-recipients:

CONGRATULATIONS!!!

POWER BALL ONLINE INT'L JACKPOT/ LOTTERY ASSOCIATION
ASIA PACIFIC REGIONAL OFFICE

Dear Sir/Ma,

We are Pleased to inform you that your email was selected among the winning numbers of the
recently Lotto conducted from the Loot Website and we shall be glad if you can claim your prize,
please respond to this mail within 72 hours otherwise we will assume that you are not interested.
We conduct the Lotto using Loot as part of our tax relief program set up by the International Lottery
Board and America Government, on this note we congratulate you and wish you best of luck as you

claim the prize attached to this Lotto.

For more details visit : http://powerballorganization.

THAILAND CONTACT PERSON: REV. KANE LEE.

(Winner's directorate office)
TEL: + (66) 823-337-
Office Fax: + (66) 273-743

Figure 6-5

If you receive an e-mail from someone you don't

know, the best thing to do is delete it without open-
ing it. Also, never follow a link in an e-mail unless
you're sure where it goes.

w= Be wary of attachments. Never open an attachment
to an e-mail or to an instant message (IM) unless
you know and trust the source — and even then, ask
yourself whether the risk is worth the reward.
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If you do decide to accept an attachment of any kind —

@ music, video, a picture, or any other type of file —
use an antivirus or security program to scan it before
opening it (see “Check for Viruses,” earlier in this
chapter).

w= Be leery of links. If you receive an e-mail or IM with
an embedded Web link, don’t click that link within
the message. If you decide that visiting the Web site
in question is worth your time (and the risk), copy
the link to your computer’s clipboard and then paste
it into your Web browser’s address bar. This method
gives your Internet security program a better chance
to block a malicious Web site or identify other prob-
lems with the link.

w= Message with care. When you're connected to an IM
session, be on the lookout for strange or inappropri-
ate messages, links, or offers of downloads. A person
with bad intentions may have managed to obtain the
password and login information of someone you
know or otherwise found a way to pose as someone
else. End the IM session immediately if something
strange happens, and consider notifying the provider
of the IM service.

w= Avoid autorun. Turn off the autorun feature that
automatically starts the execution of programs on
memory sticks and other USB devices (see Chapter 2).
In Vista and Windows 7, you have a lot of control in
this area. Just follow these steps:

1. Choose Start=>Control Panel to open the Control
Panel window.

2. Click Hardware and Sound and then click AutoPlay to
display a screen like the one shown in Figure 6-6.
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For maximum security, choose Ask Me Every Time for all media.

e
\;TQ [Eg » control Panel » Harduare and Sound » AutaPlay = [ #2 || semen contrat panet 2|
Choose what happens when you insert each type of media or device @ —
[7] Use AutoPlay for all media and devices
Media
(' Audic CD [ Chesse g defult v]
{4 Enhanced audio CD ‘ Choose g default v|
{H DVD movie ‘ Chosse a default v|
¢® Enhanced DVD movie ‘ Chegse g default v|
|
= =~ =|
|7l Software and games ‘ﬂ- sk me evenytime v-'—
|| Pictures ‘ Choose a default v|
[ Video files [ Choose o defautt -
4] Audio files ‘ Choose o default v|
{4 Blank CD | Ghoose a defoutt -
{* Blank DVD | Ghoose o defaut -
|
£ Blank ED [ ioese o default - -
#| Mixed content ‘ Choose g default v|
{2 Blu-ray disc movie ‘ Cheogse g defoult v|
& DVD-Audio ‘ Choose g default v|
- — [ — 1 i
e,

Click Save after making changes.

Figure 6-6

3. Make a new choice from the drop-down menu for any
medium you want to change. (Notice that by default,
Software and Games is set to Ask Me Every Time. It's
probably safe to autoplay DVDs and audio CDs, but if
you have any doubts, leave this menu set to the
default.)

4. Click the Save button to save your changes.
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In Windows XP, you don’t have this level of control,
but you can make some changes in the Internet
Options dialog box, which you access by choosing
Startw>Control Panelr>Internet Options. Click the
Security tab, scroll down to select Prompt under
Launching Applications and Unsafe Files, and then
click OK.

Stop Spyware

w= Block secret transmissions. Set your firewall (see
“Build a Firewall in Windows,” earlier in this chap-
ter) to block any requests by a program to send out-
going messages without your permission.

w= Click Internet ads rarely and carefully. Be very
selective about clicking online advertisements. When
you open an ad, you're communicating with a Web
site, and that communication may trigger the down-
load of malware.

w= Turn off e-mail previews and automatic down-
loads. Most capable e-mail programs allow you to
turn off automatic previews and downloads of e-mail
contents. Figure 6-7 shows the option that you'd dis-
able in Microsoft Outlook Express.

w= Beware of unusual error messages on the Internet. A
Web site may warn you that your computer is at risk or
request your permission to download a free utility.
Unless you asked for this sort of assistance — and also
know and trust the source — close both the Web page
and your Web browser without accepting the offer.

w= Don't take software from strangers. Be very careful
about accepting any offer of free software. The program
you receive may not be what you want, or it may
deliver hidden malware along with a useful function.
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Figure 6-7
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When you install a new piece of software, take the
time to read all the installation options carefully.
Some options may install features that you don’t

want — and that may be contaminated with other
things you don't want.

Heed all security warnings. Pay attention to any
warnings that you receive from your Internet security
program (see “Check for Viruses,” earlier in this
chapter). It may notify you that a Web site is
attempting to install spyware on your computer or
that a program already on your PC is trying to send
information to someone else. Accept the security

program’s recommended action to block or delete
the security threat.

Chapter 6: Keeping Intruders out of Your Computer
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Avoid Getting Hooked by Phishers

w= [Ise an Internet security program that trawls for
phishers. Programs such as Norton Internet Security
add a notification bar to your Web browser to tell
you whether you've reached a properly registered
Web site or a phony/hijacked site, and display
reports such as the one shown in Figure 6-8. These
programs also scan incoming e-mails and block
known attempts at phishing or notify you of danger-
ous communications.

Antiphishing report
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Site is Safe

| ey v Page v Safety - Took - g+

»

Site: hitp:/'www.hudsondrea...
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Photo Gallery
Buy a Copy
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Podcast
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Now Availab
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Henry Hudson: Dreams and Obsession

The Tragic Legacy of the New World's Least Understood Explorer

By Corey Sandler

& Internet

>

B - Bioew -

w

Figure 6-8
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Look up phone numbers yourself. If you receive a
suspicious e-mail that appears to be from your bank
or other financial institution, don't call any phone
number listed in the message. Instead, call the pur-
ported sender by using a number that you obtain
from your own bills, invoices, or cards.

Don't believe everything you see. A site or message
may use official-looking logos and legal-sounding
language to reassure you of its legitimacy. Don't be
fooled. Logos and legalese can be copied from real
communications or simply fabricated. Also don’t be
fooled by statements in an e-mail or on a Web site
that the communication has been scanned by antivi-
rus or security software. Those statements can be
faked too.

Beware of any unsolicited request for your login
info. A common phishing tactic is an e-mail that
tells you to click a link to update your financial
information; otherwise, your accounts will be can-
celed. A legitimate Web site may require you to
change your information from time to time — but
always on the Web site itself and only after you've
already logged in.

Read the fine print on Web sites. Visit the Web sites
of companies that you regularly do business with, and
look for security warnings and other information
posted there. Most legitimate companies are very quick
to post warnings and specific advice about phishing
attempts and other scams aimed at their customers.

Chapter 6: Keeping Intruders out of Your Computer
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If you realize (or suspect) that you've been duped by
a phisher, treat the situation as though your wallet

had just been stolen. Immediately notify all your
credit card issuers and financial institutions, placing
calls to numbers that you have on file from their offi-
cial documents.

Can That Spam

m= Maintain e-mail security. Install an Internet security
program that includes filtering and blocking utilities
for e-mail, and keep it current (see “Check for
Viruses,” earlier in this chapter).

w= When in doubt, throw it out. Don’t open a suspect
message. Just delete it. If you open one by accident,
however, never click any links in it, and never, ever
respond to it.

w= Know who your online friends are. If you use an
IM service, reject any messages from people you
don’t know. Most services allow you to create buddy
lists for that purpose (see Figure 6-9). Unfortunately,
marketers, promoters, salespeople, and crooks can
find your ID and make themselves your buddy in an
effort to reach you. Delete any name in your buddy
list that you don't recognize.
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Check your buddy list whenever you open your IM program.
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Figure 6-9
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Getting Help
When Prevention
Fails

Wnat a terrible question to have to answer:
Should a valued, trusted computer live
or die? The economics of personal computing,
however, mean that a heroic effort to keep a

wounded or dying machine alive isn’t always
the rational answer.

As you ponder this existential issue, consider
these facts:

w= Every few months, a new wave of com-
puters arrives, and the new models are
faster, better, and often less expensive
than the ones that came before.

w= In terms of monetary value, the whole of
a PC is considerably less than the sum of
its parts.

w= Forget about the hardware, and think
about any data stored on your computer
that’s not also safely stored on a backup
disk or drive. To borrow an aphorism
from a credit card commercial: A brand-
new PC, $500. Your letters, e-mails, and
photos, priceless.
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In this chapter, I point you to sources of help for an ailing computer
and give you some tips to help with the repair-or-replace decision.

Identify the Problem: Hardware or Software

For information on diagnosing and repairing hard-

@ ware, see the appropriate chapters in Part III.
Software remedies are often specific to the program,
but I provide some general tips in Chapter 4. Also see
Part IV for fixes for your PC's operating system
(Windows).

w= Hardware failure: When hardware fails, it usually
can be replaced. Notice that I don't say repaired.
Modern computers have very little hardware that an
amateur technician can fix, and the few parts that an
expert might be able to repair (such as the motor for
a hard disk drive) don’t make economic sense to
repair . . . unless the value of the data stored on that
drive convinces you otherwise. (For more informa-
tion, see “Weigh the Cost of Repair versus
Replacement,” later in this chapter.)

Q: How many computer hardware technicians does it

@ take to change a light bulb? A: None. That's a soft-
ware problem. (The light bulb is a replaceable con-
sumable, aka software; the wiring and power grid
that support it are permanent hardware.)

If you don’t want to go under the hood to replace a

@ hard drive (see Chapter 11), one alternative is attach-
ing a new external hard drive to your PC via its USB
port. (Figure 7-1 shows a typical external hard drive.)
You may have to install a device driver provided by
the drive’s manufacturer, or Windows may recognize
the drive and help you configure it.
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USB connector Power connector

Figure 7-1

w= Software failure: On the software side, things are dif-
ferent. Almost anything can be fixed, and the process
doesn’t involve the use of a screwdriver (see Chapter
4). Instead, you can use the advanced features of
Windows to fix certain problems or reinstall the oper-
ating system or programs when repairs aren’t possible.

Find a Helper

w= Computer manufacturers: In recent years, manufac-
turers have cut back sharply on their technical sup-
port departments or tried to turn what used to be
free support service into a source of profit. Still, this
option may be worth a try, especially if the computer
is still under warranty or if you purchased an
extended warranty that’s still in effect.

shopping for a new computer. You can start with a
support Web page. To get a feel for the type and
quality of customer care you'll receive, contact the

@ The time to test manufacturer support is when you're
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manufacturer before you buy the PC, and ask a ques-
tion about something you don’t understand. If the
company doesn’t treat you well before it has your
money, what makes you think that it'll be helpful
after your check has cleared?

obtain an extended warranty or access to technical
support. Make sure that you understand the terms,
however. Ask whether the company will assist you
with any problem, even if it’s related to hardware or
software that you add on your own or to the operat-
ing system.

@ Sometimes it's worthwhile to pay a bit extra to

w= Computer repair services: I'm more than a little
wary of dealing with many third-party computer
repair services. Investigate them — and seek recom-
mendations from friends — just as you would before
getting an auto repair. Remember that most of these
shops charge by the hour and also hope to sell you
replacement parts. That combination (and the poten-
tial conflict of interest) could cost you a lot of
money if the shop isn’t good at what it does or hon-
est about the way it conducts business.

w= Tech-savvy friends or relatives: This option may be
your best bet. Ask around. Do you have a friend or
relative who's capable of repairing a computer? If so,
offer him a reasonable flat fee to fix your machine —
say, $50, a free dinner, or a mention in your will. If
your friendly technician recommends replacing a
part, pay him the actual cost of getting the part
replaced at a reputable store. (Call a few stores to
find out what that cost would be.)

fix your computer? No problem — you may be able
to get help through Windows Remote Assistance,
which T cover in the following sections. Windows

@ Don't have a nearby friend, relative, or repair shop to
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Remote Assistance allows anyone whom you invite —
such as a professional technician or a friend who's
offered to help — to take control of your computer.
The connection between the computers is encrypted
to protect your data from interception by snoops on
the Internet. In Microsoft lingo, the user asking for
help is the novice, and the person coming to the res-
cue is the expert.

Get Remote Assistance in Windows XP

This process is complex enough and different enough
@ in each version of Windows that I can give you only
the highlights in this chapter. For full information on
using Remote Assistance, go to www.microsoft.
com or www . bing . com, search for Windows Remote
Assistance, and click the link for your version.

1. Choose Start=>Help and Support to open the Windows
Help and Support window.

2. In the Ask for Assistance section, click Invite a Friend to
Connect to Your Computer with Remote Assistance.
Windows Remote Assistance opens.

3. Click Invite Someone to Help You.

4. In the next screen, choose the option you want to use to
contact your helper: Windows Messenger or e-mail.

5. Follow the step that corresponds with the option you
chose in Step 4:

e Windows Messenger: Sign into Messenger, enter a
contact name and password, and send your helper
an IM invitation.

¢ E-mail: In the Use E-Mail section of the resulting
dialog box, enter your helper’s e-mail address;
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then click Invite This Person and follow the
onscreen instructions to fill out and send the
e-mail invitation.

6. When your helper accepts the invitation, a dialog box
pops up on your screen, asking for permission to give
this person access to your computer. Click Yes to start the
Remote Assistance session.

7. The expert will ask to take control of your computer by
clicking a button in her console, and a message will
appear on your screen to tell you about the request. Click
Yes (or, if you change your mind, No).

When an expert has taken control of the computer,
both ends of the communication share control of the
keyboard and the mouse. To prevent confusion, keep
your hands by your side.

8. Watch carefully to see what the expert is doing. If you
think that she’s straying into areas that aren't related to
your problem, end the session in any of the following
ways:

¢ (Click Stop Control.
e Press the Esc key on your keyboard.

e (Click Disconnect.

If you cancel a Remote Assistance session, you can
always reconnect later.

Get Remote Assistance in Uista

1. Choose Start=>Windows Help and Support to open the
Help and Support Window (see Figure 7-2).
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Figure 7-2

2. In the Invite Someone section, click the Windows

Remote Assistance link. Windows Remote Assistance

opens (see Figure 7-3).

Another way to display the Remote Assistance win-
dow is to choose Start>All Programs=>Maintenance

and then select Remote Assistance.

3. Click Invite Someone You Trust to Help You.

4. In the next screen, choose the option you want to use to
contact your helper: Windows Messenger or e-mail.

5. Follow the step that corresponds with the option you

chose in Step 4:

e Windows Messenger: Sign into Messenger, enter a
contact name and password, and send your helper

an IM invitation.
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Invite your helper from this page.

o

v oL Windows Remote Assistance
==y
Do you want to ask for or offer help?

Windows Remote Assistance connects two computers so that one person can help troubleshoot
or fix problems on the other person's computer,

B [nvite someone you trust to help you
If you've used Remote Assistance before, you can use a previous
invitation to get help from the same person.

Offer to help someone
Offer Remote Assistance to someone or open a Remote Assistance
invitation,

Cancel

Figure 7-3

e E-mail: In the Use E-Mail section of the resulting
dialog box, enter your helper’s e-mail address;
then click Invite This Person and follow the
onscreen instructions. Your helper gets an auto-
matic e-mail invitation that’s really a file contain-
ing all the information (except the password) that
your helper needs to find your computer and
log in.

6. After you send the invitation, you see the Waiting for
Incoming Connection window (see Figure 7-4). Leave it
open until the person you invited accepts.
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Leave this window open until the helper logs on to your computer.

L. Windows Remote Assistance ===

Waiting for incoming connection...

5 s Il © » @

Cancel I F Settings  Chat 1 file Hélp

Figure 7-4

7. When your helper accepts the invitation, a dialog box
pops up on your screen, asking for permission to give
this person access to your computer. Click Yes to start the
Remote Assistance session.

8. The expert will ask to take control of your computer by
clicking a button in his console, and a message appears
on your screen to tell you about the request. Click Yes
(or, if you change your mind, No).

When an expert has taken control of the computer,
both ends of the communication share control of the
keyboard and the mouse. To prevent confusion, keep
your hands by your side.

9. Watch carefully to see what the expert does. If you think
that he's straying into areas that aren't related to your
problem, end the session in any of the following ways:

¢ Click Stop Sharing.
¢ Click Cancel.
e Press Alt+T on your keyboard.

e Choose SettingswUse ESC to Stop Sharing Control
and then press the Esc key on your keyboard.

If you cancel a Remote Assistance session, you can
always reconnect later.
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Get Remote Assistance in Windows 7

1. Choose Start=>All Programs=>Maintenance and then
select Windows Remote Assistance. Windows Remote
Assistance opens.

2. Click Invite Someone You Trust to Help You (see
Figure 7-5).

Click to invite a helper.

-

) ol Windows Remote Assistance
g
Do you want to ask for or offer help?

Windows Remote Assistance connects two computers so that one person can help troubleshoot
or fix problems on the other person’'s computer,

& Invite someone you trust to help you
If you've used Remote Assistance before, you can use a previous
invitation to get help from the same person.

Offer to help someone
Offer Remnote Assistance to someone or open a Remote Assistance
invitation,

Cancel

Figure 7-5

Here’s another way to invite a helper: Choose Start=>
Control Panel, choose System and Security in Category
View, click Troubleshoot Computer Problems in
Action Center, and then click Get Help from Someone
You Trust on the left side of the screen.
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3. Choose the way you want to contact your helper: save
the invitation as a file, send the invitation as an e-mail,
or use Easy Connect.

If you choose to use Easy Connect, which is a
Windows 7 utility, your helper must also have access
to Easy Connect.

4. Follow the onscreen instructions for whichever method
you chose in Step 3 to send the invitation (see Figure 7-6).

Sending the invitation as an e-mail

| You have received a Remote Assistance invitation =B 58
File Edit View Insert Format Tools Actions Help
& Send | Save 5| |ﬁ] Attach  2F J_,“ ¢ 3 RSign = = lél
] Te: Fram: |csand|er@| - ‘|
Hl Ce
i1 Bea
Subject: | Yoy have received a Remote Assistance invitation
: 2| RATicket.MsRcIncident (1.15 KB) :
i Add photos 57 Layout 33 - & Stationery A Arial - AB10- B J U A- i=- =

Hi,

I need help with my computer. Would you please use Windows Remote Assistance to connect to my
computer so you can help me? After you connect, you can view my screen and we can chat online.

To accept this invitation, double-click the file attached to this message.

(If you are running Windows Vista, you can also save the file to a location on vour computer. Then you
can open Remote Assistance. click Offer to help someone. and then open this file)

Thanks.

| Note: Do not accept this invitation unless you know and trust the person who sent it.

Figure 7-6

5. After you send the invitation, you see the Waiting for
Incoming Connection window. Leave it open until the
person you invited accepts.
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6. When your helper accepts the invitation, a dialog box
pops up on your screen, asking for permission to give
this person access to your computer. Click Yes to start the
Remote Assistance session.

7. The expert will ask to take control of your computer by
clicking a button in her console, and a message appears
on your screen to tell you about the request. Click Yes
(or, if you change your mind, No).

When an expert has taken control of the computer,
both ends of the communication share control of the
keyboard and the mouse. To prevent confusion, keep
your hands by your side.

8. Watch carefully to see what the expert is doing. If you think
that she’s straying into areas that aren't related to your prob-
lem, end the session in any of the following ways:

e Click Stop Sharing.
¢ Press Alt+T on your keyboard.

e Choose Settings=>Use ESC to Stop Sharing Control
and then press the Esc key on your keyboard.

If you cancel a Remote Assistance session, you can
always reconnect later.

Weigh the Cost of Repair versus Replacement

1. Calculate the difference between what you'd spend for a
new computer and what you'd spend for the replacement
parts you need:

¢ Fully equipped new computer: In this chapter’s
introduction, I mention that the cost of a modern
PC is almost always much less than the sum of its
parts. A fully equipped computer may cost $500
and would include a fresh version of Windows.

132




Chapter 7: Getting Help When Prevention Fails

¢ Parts sold separately: Compared with purchasing
a new PC, buying all the parts separately would
cost . . . well, you can do the math yourself.

Replacement motherboard with microprocessor:
$200-$400

Memory module, 2GB of RAM: $25-$50
Hard disk drive, 500GB: $50-$75
CD/DVD drive: $40

Power supply: $30-$50

Computer case (see Figure 7-7): $50
Keyboard and mouse: $20-$50
Windows operating system: $100-$200

Basic applications: may vary from $40-$150 to
replace or upgrade

Here's the value of looking at a computer in this way:

@ If you have a reasonably current PC, and a couple of
fairly inexpensive parts fail (such as the power sup-
ply, keyboard, and/or hard drive), it probably makes
sense to repair what's broken.

2. Apply the 50 percent rule, which states that if the cost of
repairs (including any labor costs you may choose to pay
to an expert) is less than half the price of a new machine,
a fix-up job may make sense. On the other hand, if the
motherboard fails, you're probably looking at a repair
that crosses the 50 percent yardline. (By the way, if a
motherboard gets fried, the power supply and memory
modules often are damaged as well and need to be
replaced.)
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You can start with a bare-bones case and add the essentials—at a cost.

134 Figure 7-7
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The 50 percent rule should also apply to extended
warranties and support. I wouldn’t consider it ratio-
nal to pay more than half the cost of a new PC for
technical support.

3. Consider one very important exception to the 50 percent
rule: If your hard disk drive fails, and you don't have
backups of your irreplaceable data, it may make sense to
pay hundreds of dollars to a professional disk-rescue
company, which often (but not always) can extract data
from failed drives.

Internet for hard disk data recovery. Typical fees are

@ To find a hard-disk rescue company, search the
$200-$400.
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Repairing the
Monitor

Wth the birth of the personal computer,

we've all come to use the monitor (or dis-
play) as the window into the hard electronic soul
of the device. A monitor lets us read words, look
at images, and (together with a graphical user
interface such as the Windows operating system)
move things around or issue commands.

In Chapter 1, I explain the distinction between
the two main kinds of computer monitors:

w= CRT (cathode ray tube), which is like an
old-style television set

w=  LCD (liquid crystal display), which is
used in most flat-panel TVs and laptop
computers

Though LCDs have just about completely
replaced CRTs, there’s no good reason to change
the terms you use for them. You can call these
devices either monitors or displays, as I do in this
book; people will get the picture either way.

I don’t need to get very technical here. After a
monitor is connected to your computer, there’s
very little to do with it other than sit back and
watch it work.
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But what do you do when the lights won’t go on? In this chapter, I
show you how to fix some common problems with monitors.

Check the Display

1. If your display won't display, make sure that it's turned
on. Nearly all units have an indicator light to show that
they're receiving power. Sometimes the light glows one
color when the power is on but no signal is being
received (amber or red, usually) and another color when
it is getting a signal (probably green or blue).

2. If the monitor is turned on but the indicator light isn't
lit, examine the power cord to make sure that it's con-
nected to both the monitor and its source of power. (If
you have an LCD screen, you may have to check three or
four plugs connecting the wall outlet, the power adapter,
and the display.)

3. Make certain that power is flowing through the wall out-
let. The best test is to plug in a radio or lamp that you
know is working. If the outlet isn’t supplying power, it
may be connected to a turned-off wall switch (a connec-
tion you should avoid for computers and monitors), or
the circuit may be dead because of a blown circuit
breaker or other electrical problem.

4. 1f you have an older CRT, check the brightness, contrast,
and other manual controls. Someone — any children or
mischievous coworkers in the vicinity? — may have
turned those dials or buttons all the way off. (Newer
CRTs and all modern LCDs make their adjustments
through onscreen utilities accessible from the keyboard.)

5. If everything so far is fine, check for the following problems:
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e Monitor failure (CRT): A CRT monitor uses high
voltage and somewhat delicate transformers and
other parts. Its electronics eventually wear out —
or can be fried by electrical surges or undervoltage
(brownouts).

Turn your monitor off and wait about 30 seconds;
then turn the monitor back on. Watch and listen
carefully. Did you see any hint of light as the power
came on? Did you hear the high voltage energizing
the CRT tube? Also, place the back of your hand
close to the screen to feel for static electricity. If the
monitor passes one or more of these tests, the power
supply is working, the monitor has high voltage, and
your problem probably is in the cable or the computer.

® Monitor failure (LCD): An LCD display requires
lower voltage than a CRT does and usually has a
longer life. The components that are most likely to
fail are the backlight (a tiny fluorescent lamp that
produces light that shines through the screen) and
the thin LCD panel itself, which can get scratched,
cut, cracked, or warped.

With the monitor turned on, press one of the moni-
tor configuration buttons, probably on the front, on
the side, or covered by a trap door. (You may need to
find your monitor manual to find out which button
to push for various adjustments.) You should see a
pop-up menu. If you do, the monitor has power, and
the screen is working. The problem must be in the
cable connection or in your computer.

e Trouble with video output from your computer:
I cover this situation in “Troubleshoot a Video
Adapter” and “Reset a Video Driver,” later in this
chapter.
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¢ Trouble with the video connections: You may
find a crimp, break, or other fault in the connec-
tors on the PC or the display, or in the cable that
runs between them (see Figure 8-1). Video cables
should be carefully screwed into place when con-
nector posts are available, and you should make
sure that the cables aren’t bent, left on top of heat
registers, or otherwise endangered.

Check for bent or broken pins at both ends or the coble.
Figure 8-1

One possible indicator of a problem with a cable or

@ connector on an analog link is the loss of one or two
of the primary colors (red, green, and blue) that are
combined to produce other hues.
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Troubleshoot the Display

1. One way to determine the likely source of problems with
a display is to watch carefully as your computer starts up.
If the opening screen (see Figure 8-2 for Vista’s) suddenly
goes blank or is replaced by an error message, the moni-
tor and its connecting cable are likely working properly.
The problem may be either the video adapter on the
motherboard or a setting that you changed in the video
adapter’s driver or in Windows.

If you see a startup screen in your version of Windows,
your monitor and cable probably work.

Figure 8-2

If you see a blue screen on startup — a condition

@ called the Blue Screen of Death (or Doom) — you
have a different problem. See “Beat the Blue Screen
of Death,” later in this chapter.
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2.

Restart your computer in safe mode, which automatically
uses a very basic video setting. When Windows is loaded,
choose Start=>Control Panel, and change the video set-
tings back to an acceptable set of parameters (see “Check
and Change Display Settings,” later in this chapter). I
explain how to use safe mode in Chapter 17.

If Step 2 doesn’t help, try attaching the suspect monitor
to a computer that you know to be working. (Maybe you
have another computer in your home or can take your
monitor to a friend’s house.) If the monitor delivers the
proper image, you know to concentrate your attention on
your computer.

If your monitor uses a cable that detaches at both ends,
swap it with a substitute for a second test. (Some cables,
though, are attached permanently at the monitor end.)

Never attach a cable to a computer that’s powered
up. A slight misalignment of the plug can produce a

short that could damage the video adapter, monitor,
motherboard, or all three devices. Turn off both the
monitor and the computer before making any
cabling changes.

Beat the Blue Screen of Death
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1.

2.

Start the computer again. If the problem doesn't recur,
consider yourself lucky — for the moment. Make backup
copies of all your important data files and then check out
the computer by using Device Manager and any diagnos-
tics programs provided by the manufacturer. For details
on Device Manager, see Chapter 18.

Use the Last Known Good Configuration option (see
Figure 8-3) to restart the PC with settings that were suc-
cessful recently. See Chapter 16 for details.



Chapter 8: Repairing the Monitor

Last Known Good Configuration option

Figure 8-3

3. Try to repair Windows. The files for your computer’s
installation of Windows may have been damaged (in
technical terms, corrupted) as the result of a problem with
the hard disk, an electrical spike that got past your surge
protector and into the computer, or a computer virus (see
Chapter 6). For directions on repairing Windows, see
Chapter 14.

4. Reinstall Windows, which essentially refreshes all your
system files and leaves your data and software programs
intact. In the worst-case scenario, you may have to per-
form a clean install, which requires electrically wiping the
disk clean, reformatting it, and installing Windows all
over again. For details, see Chapter 14.
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Check and Change Display Settings
in Windows XP and Uista

1. Right-click anywhere on the desktop and choose
Properties from the shortcut menu, or choose
Startw>Control Panel and double-click the Display icon.
The Display Properties dialog box opens.

panels to computer systems. You may find some
more advanced customization settings in these con-
trol panels, as well as diagnostic tools specific to your
PC'’s hardware.

@ Some advanced video adapters add their own control

2. Click the Settings tab. You see the screen resolution
and color quality that your video adapter is using (see
Figure 8-4).

Display Properties 2] %]

Themes || Desktop | Screen Saver | Appearance | Settings

Drrag the monitor icons to match the physical amangement of your monitars.

1

Display:
1. Plug and Play Maoritor on Intel(R) 82852/82855 GM/GME Graphics |

Screen resolution Color qualty
- e P 7
$ess | More Highest {22 bit) v

1230 by 300 pifels I ' ' 'm

I Identify ][ Troubleshoot ... ] I Advanced I

[ 0K H Cancsl ]l Apply ]

Slide to change the display’s configuration.

Choose a new setting from this drop-down menu.
Figure 8-4
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If your adapter and its drivers are installed properly, the
color and resolution settings offer only options that are
within the capabilities of your adapter. For the most
modern adapters, you may see only Highest (32 Bit) or
Medium (16 Bit) options; older adapters may offer set-
tings that identify the number of colors, beginning as low
as 16 or 256 and moving on to true color (16 bit for
65KB colors to 32 bit for more than 4 billion colors).

3. Make any changes you want.

4. Click OK to save your changes.

er's device driver (see the appropriate section for your
version of Windows later in this chapter) or made an
error in choosing adapter settings, you're caught in a
conundrum — a computer Catch-22. How do you
troubleshoot a device when you need to use that
device to see the screen? Here's how: Restart your
computer in safe mode and then perform the steps in
this section. (For the full start-in-safe-mode proce-
dure, flip to Chapter 17.)

@ If you can’t check a problem with your video adapt-

Check and Change Display Settings in Windows 7

1. Right-click anywhere on the desktop, and choose
Personalize from the shortcut menu. The Personalization
window opens (see Figure 8-5).

2. Click Display in the bottom-left corner to open the
Display screen.
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Change your account picture
J|i|
Unsaved Theme

Get more themes online

Lero Theres (T)

Windows 7 Architecture Characters Landscapes Mature

=

o [ 50
\J\J |ﬂ' » Control Panel » Appearance and Personalization » Personalization - |¢’| ‘ Search Cortral Panel Fel |
Control Panel Home 5 @
Change the visuals and sounds on your computer
Change desktop icons Click a theme to change the desktop background, window color, sounds, and screen saver all at once,
Change mouse pointers Wy Thernes (1) -

m

Scenes United States -
See also h =3
o =2 IS
isplay
S AL Desktop Background Window Color Sounds Screen Saver
FaseckiccessBentes Solid Color Custom Custom None

Choose a theme to change multiple setftings simultaneously.

Click to access screen resolution and color quality.

Figure 8-5

3. Click Adjust Resolution on the left side of the
Display screen. The Screen Resolution screen opens
(see Figure 8-6).

You can also access the screen-resolution settings
from the shortcut menu when you right-click your
desktop.

4. Click the Advanced Settings link to open the Advanced
Settings dialog box.
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Adjust the slider to set the desired screen resolution.

@Uv!ﬂ » Contral Panel » Appearance and Pegsonalization » Display » Screen Resolution - |+y| | Search Cantrofl Panel gel

Change thelappearance of your display

r Detect
| -

Display: L. Color LCD ~|
Resolution: 1024 = 768 v‘
Otientation: High

1920 = 1200 (recommended)
Advanced settings

Make text and gthel

What display s§tti

n

OK Cancel | Appl

e S 1024 % 768

800 x 600

Figure 8-6

5. Click the Monitor tab, and make a choice from the
Colors drop-down menu in the bottom-left corner (see
Figure 8-7).

6. Make any other changes you want.
7. Click OK to save your changes and close the dialog box.

8. Close both of the windows.
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Generlc PnP Monltor and ATI Mobllity Radeon HD 4850 (M... i)

Monitar Type

L Generic PnP Monitor
-

| E 'Properties I

Monitar Settings

Screen refresh rate:

&0 Hertz 5.t

Hide modes that this monitor cannot display

Calors:

True Colar (32 bit) A

High Calor {16 bit
B 1/ Color (32 bit)

| oK | | Cancel | Apply

Choose color settings.
Figure 8-7

Troubleshoot a Video Adapter in Windows XP and Vista

1. Choose Start=>Control Panel, and double-click the
System icon. The System Properties dialog box opens.

2. Click the Hardware tab.

3. Click Device Manager to open Device Manager (see
Figure 8-8).

4. Click the plus sign (+) next to the Display Adapters list-
ing to expand it. A yellow question mark next to any-
thing indicates possible trouble; a red exclamation mark
tells you that you definitely have a problem.
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[ Disk drives
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G-y DVD/CD-ROM drives
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Click this listing to see your PC’s video adapters.

Figure 8-8

5. Double-click an adapter to display its Properties

dialog box.

6. Click the General tab (see Figure 8-9), and check the
Device Status box to see whether the system is reporting
a problem. If so, click the Troubleshoot button, and fol-
low the onscreen instructions. If not, click OK to close

the dialog box.
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Any problems will be listed here.

Mobile Intel(R) 945 Express Chipset Family Properti...| 7 5]

General | Driver | Detais | Resources |

k Mobile Intel(R) 545 Express Chipset Family

Device type: Dizplay adapters
Manufacturer: Intel Corporation
Location: PClbus 0, device 2, function 0

Device status

This device is working property.

L 1

oK | l Cancel

Figure 8-9

Troubleshoot a Uideo Adapter in Windows 7

1. Choose StarttvControl Panel, and click Hardware and
Sound to display the Hardware and Sound screen.

2. Click the Device Manager link under the Devices and
Printers heading. Device Manager opens (refer to Figure
8-8, earlier in this chapter).

3. Click the plus sign (+) next to the Display Adapters list-
ing to expand it. A yellow question mark next to any-
thing indicates possible trouble; a red exclamation mark
tells you that you definitely have a problem.

4. Double-click an adapter to display its Properties
dialog box.
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5. Click the General tab, and check the Device Status box to
see whether the system is reporting a problem. If so, click
the Troubleshoot button, and follow the onscreen
instructions. If not, click OK to close the dialog box.

Reset a Uideo Driver

1. Follow the steps in “Troubleshoot a Video Adapter” for
your version of Windows, earlier in this chapter, to open
the adapter’s Properties dialog box.

2. Click the Driver tab to display settings like the ones
shown in Figure 8-10.

Mobile Intel(R) 945 Express Chipset Family Properti...| 7 |[E5]

k Mabile Intel(R) 545 Express Chipset Family

Driver Provider: Intel Corporation
Driver Date: 8/24/2007
Driver Version: 7.14.10.1322

Digital Signer: microsoft windows hardware compatibility publist |

Driver Details To view details about the driver files.
| Update Driver... | To update the driver software for this device.

If the device fails after updating the driver, roll
back to the previously installed driver.

Disable | Disables the selected device.
W| To uninstall the diver (Advanced).

| oK H Cancel |

Click these buttons to view and change driver settings.
Figure 8-10

3. Click the appropriate button:

e Driver Details: Click to display details about the
driver files in use.
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e Update Driver: Follow the instructions to update
the driver from a supplied disc or from a file
you've downloaded from the manufacturer's Web
site. (See Chapter 4 for more info on updating
software.)

e Roll Back Driver: If the device fails to operate
properly after you install an updated driver, you
can choose this option to uninstall the new driver
and reinstate the old one.

e Disable: Don't click this button unless you have
more than one video adapter in your system. With
your only video adapter disabled, you wouldn’t be
able to view your computer’s data.

¢ Uninstall: Choose this option to remove the exist-
ing driver without installing a replacement.

- A word of existential warning: If you choose the

‘ Uninstall option for your default video adapter, you
may be unable to view the screen, because the adapter
won't be able to communicate with Windows. Restart
in safe mode (see Chapter 17), and follow the steps in
“Check and Change Display Settings” for your version
of Windows, earlier in this chapter, to roll back to the
preceding driver or reinstall a driver.

4. Click OK to save your changes and close the dialog box.

Prevent Future Picture Problems

w= Reduce the number of open programs or windows.
The more programs you have open, the higher the
demand on system resources. Close any programs
that aren’t necessary.
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w= Avoid running too many graphics-intensive

1

programs at the same time. Certain program
combinations — a video player and a graphical
drawing program running together, for example —
may overwhelm your PC and its video adapter. The
images you see onscreen may load slowly, skip, or
jitter. Again, close any programs that aren’t
necessary.

Reduce the display resolution. In general, the high-
est resolutions and the highest number of colors in
the palette require the most system resources. Try
reducing the resolution (see “Check and Change
Display Settings” for your version of Windows,
earlier in this chapter) to see whether problems

go away. If so, consider adding more RAM to the
system. Chapter 10 gives you details on installing
memory.
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Solving Electrical
and Mechanical
Problems

ou can divide a computer’s essential vital
systems into four areas:

w= FElectrical: Electrical power energizes the
machine’s brain, storage, and other
functions.

m= Mechanical: Tiny electrical motors and
mechanisms run disks, drives, and fans.

w=s Electronic: A collection of circuits cen-
tered on a microprocessor manipulates
data in a computer.

m= Logical: All the hardware in a computer
exists to respond to commands from var-
ious types of software, which make up
the computer’s logical system.

Fixing electronic circuits is far beyond the
scope of this book, and software problems are
covered in Chapter 4 and in Part IV, which
deals with the operating system. So in this
chapter, I cover the two remaining types of prob-
lems: electrical and mechanical (except for hard
drives, which are the subject of Chapter 11). I
also briefly mention modems, which can have
both electrical and mechanical ailments.

| “*apter

Getready to. ..

w= Diagnose a Failing
Power Supply ......covevveen.

w=> Research a Replacement
Power Supply ......cccevveen.

w= Remove and Replace the
Power Supply .......covevvenen.

w= Replace the Cooling Fan....

w= Mend a Modem ...............
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For purposes of this chapter, I'm going to assume that before your
computer stopped working, it was running properly.

Diagnose a Failing Power Supply

w= Is the electrical outlet supplying current? Test it
with a lamp or radio. If a circuit breaker has shut off
current to the outlet, try to determine what caused it
to close down. Is another major appliance (such as a
refrigerator, large-screen television set, or space
heater) using the same circuit?

w= Are the computer’s fans and drives still running? If
so, that fact may indicate that the power supply is still
functioning. On the other hand, if none of the comput-
er’s indicator lights, fans, or other electrical parts seems
to be alive, the power supply may not be supplying.

w= Do you smell anything? Often, the first sign of
impending doom is a whiff of the particular acrid
odor of fried electronics; sometimes, the smell pre-
cedes the failure.

w= Do you hear anything? Did you hear a pop or sizzle
coming from the computer? This auditory clue fre-
quently precedes the olfactory hint that something
electrical is shorting out or failing. Turn off power
now, and check inside the case to find out what's hot
and what's not.

w= Do you see anything? Electrical scorch marks or
melted wiring are possible signs of a failure of the
power supply.

P If you see smoke (or flames), immediately turn off
‘ the computer by using the switch on your surge pro-
tector or removing the electrical cord from the wall
socket. If things dont calm down quickly, call the
fire department and head out the door.
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Research a Replacement Power Supply

1. Open the case of your PC, following the directions in
Chapter 2.

2. Locate the power supply, which is almost always a large
metallic box in a corner of the case (see Figure 9-1).

Power supply

Figure 9-1
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You can also look for the point where the electrical
cord from the wall current attaches to the computer
and follow it to the power supply at the other end,

inside the case.

3. Make note of any model information and specifications
that you find on the power supply.

4. Write down the details about the power supply’s form fac-
tor, a term that refers to the size and shape of the power
supply and the way it bolts to the case. The most com-
mon designs for modern computers are

e ATX: In this design, a 20-pin connector delivers
power to the motherboard, and a separate 4-pin
cable and connector together deliver the same set
of voltages and control circuits to the microproces-
sor (see Figure 9-2).

e BTX: A 24-pin connector goes directly to a 24-pin
receptacle on the motherboard. Note, however,
that BTX motherboards are fairly rare commodi-
ties; few manufacturers converted to this proposed
Intel design, and newer, smaller computer circuits
pretty much leapfrogged it.
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Cables and connectors of an ATX power supply

Figure 9-2

5. Check the wattage. The power supply has to produce at
least the minimum amount of wattage to power the
motherboard and everything else attached to the system.
Supplies are usually rated for the amount of continuous
and peak wattage that they can deliver. Look for this
information on the manufacturer’s label, like the one
shown in Figure 9-3.
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Key information about the manufacturer and ratings
usually appear on a label like this one.

Figure 9-3

machine. If you replace a 500-watt power supply
with a 750-watt unit, for example, you need to know
whether your computer is capable of exhausting the
extra heat that the larger unit will produce. Seek guid-
ance from suppliers if necessary.

@ Keep in mind the proper thermal fit for your

6. Check the cables and connectors. Make a list of the types
of connectors your computer uses and the number
required of each type. Here’s what you have to match:
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e P1 connector: A modern computer has one main
connector from a standard power supply to the
motherboard. Designers refer to it as the PC main
connector or (as I do) P1. It’s the largest and most
important of the cables and connectors running
from the power supply. Depending on design, a P1
may use a connector with 20 or 24 pins (refer to
the descriptions of ATX and BTX designs in Step 4).
You can see in Figure 9-4 that this connector is very
large compared with anything else on the mother-
board. You should have no problem finding that
connector again if you're reconnecting the existing
power supply or installing a new one.

P1 connector attaches here on an ATX motherboard.

Figure 9-4
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If you have a really old computer (one that was
put into service more than a decade ago), it may
use an AT power supply. This design brings power
to the motherboard through two separate sets of
cables and connectors, labeled P8 and P9 (see
Figure 9-5).

difficulty, .

de .
aler for Prompt Service

ATTENTIQN, Z0NE DINBEIIEUSE

P8 and P9 connectors
Figure 9-5

e P4 connector: The superfast microprocessors on
modern motherboards are fed by their own source
of 12-volt power, delivered through a 4-pin con-
nector labeled P4 (see Figure 9-6). Some high-end
computers require two P4 connections or a single
8-pin connector.
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P4 microprocessor power connector
Figure 9-6

® Molex connectors: The next set of connectors com-
ing off the power supply (see Figure 9-7) delivers
current to peripherals such as hard drives and in
some designs to special adapters plugged into the
system'’s electrical bus. The attachment points of
these Molex connectors are about an inch long
and are fed by four wires — typically, a red wire
carrying +5 volts, a yellow wire delivering +12
volts, and two black wires that serve as grounds.

e Auxiliary power connectors: Lowest on the electri-
cal totem pole are auxiliary power connectors (see
Figure 9-8), which are often used to deliver cur-
rent to tiny fans placed atop particularly hot
microprocessors and graphics cards. Some of these
small assemblies involve only two wires and a
connector the size of a match head.
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|
Typical Molex hard drive and
peripheral power connector
Figure 9-7

=

Miniature auxiliary power connector

Figure 9-8

7. With all this information in hand, visit a full-service
computer retailer or online store. A competent salesper-

son or support representative should be able to help you
make the proper match.

Remove and Replace the Power Supply

1. Prepare a well-lit, stable working space. For details on

setting up your working environment and tools, see
Chapter 2.
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Choose Starte>Shut Down to close Windows and turn off
your computer.

Unplug the electrical cord that connects the power supply
to wall current. Also remove any cables and plugs that
attach to ports on the computer if they might interfere
with your ability to open the case and work inside.

Open the computer’s case (see Chapter 2).

. Carefully examine the placement of the power supply, as

well as the wires and connectors that exit it inside the
case (see “Research a Replacement Power Supply,” earlier
in this chapter).

To remind yourself what plugs in where, put a piece of
masking tape on each connector coming from the power
supply, and mark it with a number; then put a piece of
tape marked with the same number on the connection
point (on the motherboard or an internal device such as
a hard drive).

or

With a digital or video camera, take a series of close-up
shots of the interior of the computer to help you remem-
ber how things looked before you began your surgery.

devices, a large static discharge can still damage deli-

@ Although modern computers are pretty sturdy

cate components. It's good practice to touch the case
with one hand and then touch the motherboard with
the other hand. Without removing the hand that’s on
the motherboard, now you can move the hand that’s
on the case to the motherboard to help you discon-
nect the wires.

7. When all the connections have been labeled, photo-

graphed, or filmed, unfasten the power cables that attach
to the motherboard. Most wires and cables inside the
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case are held in place by clips along the side of connec-
tors or merely by the friction of a tight fit. Take your
time, and be careful: These connectors aren’t designed for
heavy use, and the motherboard itself can be fragile.

8. Remove the screws that attach the power supply to the

case. In general, you need to use a screwdriver (either a
flat-head or an X-shaped Phillips-head tool) to remove
these screws. In many designs, all the attachment points
are on the outside frame.

Take great care using any metal tool inside the case
so that you don't scratch the fine electrical traces that

carry power between parts on the motherboard. Also,
be very careful not to drop any screws into the inte-
rior of the case. If any do land there, you must
retrieve them before you turn the computer back on;
otherwise, they will short out electrical parts.

9. Remove the power supply itself.

10. To install the new power supply, perform Steps 9-3

in reverse order. Make sure that you correctly reinstall
the power connectors to the motherboard and all other
internal parts.

Replace the Cooling Fan

168

1. Prepare a well-lit, stable working space. For details on

setting up your working environment and tools, see
Chapter 2.

2. Choose Start=>Shut Down to close Windows and turn off

your computer.

3. Unplug the electrical cord that connects the power supply

to wall current. Also remove any cables and plugs that
attach to ports on the computer if they might interfere
with your ability to open the case and work inside.
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Figure 9-9 shows the back of a computer case with an
auxiliary fan below the power supply fan.

Remove screws or clips that hold the fan in place.

Figure 9-9
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4. Open the case (see Chapter 2).

5. Locate the malfunctioning fan. There usually is a fan
mounted on the back of the case or sometimes on the
front toward the bottom of the case. You may also see a
fan on top of the motherboard or mounted directly on
top of the microprocessor.

inside the power supply. If that fan has failed, you
may have other problems. Either take the power sup-
ply to a professional repair technician or replace it
yourself (see “Remove and Replace the Power
Supply,” earlier in this chapter).

@ I don't recommend that you try to replace the fan

6. Locate the power cord, trace it back to the accessory plug,
and unplug it.

7. Remove the mounting screws (or sometimes just sliders
or snaps) that hold the fan in place (see Figure 9-10). A
motherboard-mounted fan may sit in a board expansion
slot; a microprocessor fan just snaps to the top of the
chip’s heat sink or carrier.

8. Lift the fan out of the case.

9. To install the new fan, perform Steps 8-3 in reverse
order.

carrier instead of attaching directly to the case. If you
have such a model, after you remove the fan and car-
rier, disassemble the unit to remove the fan and
install the new fan in the carrier before replacing the
assembly in the computer case.

@ Your PC’s fan may reside on (or in) a plastic or metal
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Remove screws or clips that hold the fan in place.

Figure 9-10

Mend a Modem

1. Make sure that the modem is receiving electrical power. If
not, plug it into an active electrical outlet.

2. Check the indicator lights to see whether the modem is
connected to a live signal from the company that pro-
vides your Internet service. Any flashing red or yellow
lights may indicate a problem with the signal. Figure
9-11 shows an integrated cable modem, wireless access
point, and voice gateway with all lights green except the
wireless lamp at the bottom.
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Check the modem lights for network and Internet connection status.

Figure 9-11
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vice, check to see whether any TV set on the premises
is receiving a picture. If the TV screen is blank, the
problem lies somewhere between the cable company
and the modem. It could be that the local system is
out of service for the moment, a repair crew is work-
ing somewhere in your neighborhood, or the wiring
in your home or office is damaged. Call the cable
company's technical support number, and ask a sup-
port representative to check for problems.

@ If you have a cable modem and cable television ser-

3. Make sure that you have proper connections between the
modem and your computer.

4. 1f the modem has electrical power, a live signal, and cor-
rect connections but still isn't working, try doing a
power-off reset of your modem. Some models have an
actual on/off switch; you turn off others by unplugging
them. Leave the modem off for about 15 seconds and
then reapply the power.

your ISP’s support department. Someone there can
log in to your modem, test the settings, and probably
get things working again if you don’t have hardware
issues.

@ If everything seems to check out at your end, call
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Installing
Memory

0ne of the most basic — and not terribly
complex — operations you can perform
inside the case of your computer involves
installing system memory modules, or RAM
(which stands for random-access memory). No
soldering or arc-welding is involved, and the
lifting is very light. You just have to pay close
attention to details and take care not to dam-
age your computer while you try to make it
better.

Adding memory (up to your machine’s specific
limit) is generally the most cost-efficient way to
increase its speed. Doubling a modern PC's
memory from 1GB to 2GB of RAM may boost
overall operation speed by as much as 50 per-
cent; going from 2GB to 4GB could give you a
25 percent improvement. Why the discrepancy?
That first jump gives Windows and other pro-
grams most of the space they need for efficient
operation. Moving from 2GB to 4GB improves
performance, but not as much as the first step
up does.

In this chapter, I show you the basics on
installing memory. For much more informa-
tion, check out my book Fix Your Own PC
(Wiley Publishing).
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Find the Right Memory Module

Check the specifications for your computer to find
the maximum amount of RAM it’s capable of manag-
ing. Most modern computers sold to consumers can
handle no more than 4GB; paying for and installing
more than the maximum is a waste of money and
could cause problems in some machines.

176

To find out what kind of memory modules you already have installed
in your PC (and need to purchase), use one of these methods:

m= Choose Start=>All Programs=Accessories=>System
Tools=>System Information. The System Information
window opens, displaying a report on memory
(among other things), as shown in Figure 10-1.

(@) System Information
File Edit View Tools Help

[ Search selected categoiy only [ Search category names anly

1 Summary Item | Value

EJ Hardware Resources 0S Name Microsoft Windows XP Home Edition

- Components Version 5.1.2600 Service Pack 2 Build 2600

- Software Environment 0S Manufacturer Microsoft Corporation

@ Intemet Settings gviem mamef " galﬁﬁ‘ﬁ.

- . ystem Manufacturer ellInc.

g_ gxz;&:s”"w”"s System Model Dell DXPOS1
System Type X86-based PC
Processor %86 Family 6 Model 15 Stepping & Genuinelntel ~2393 Mhz
Processor %86 Family 6 Model 15 Stepping B Genuinelntel 2394 Mhz
BIOS Version/Date DellInc. 1.0.3, 8/14/2006
SMBIOS Version 23
Windows Directory CAWINDOWS
System Directory CAWINDOWS\system32
Boot Device \Device\HarddiskVolume2
Locale United States
Hardware Abstraction Layer  Version = "'5.1.2600.2705 (xpsp.050622-1524]"
User Name \Corey Sandler
Time Zone Eastem Standard Time
Total Physical Memory 2,048.00 MB
Available Physical Memory 1.17GB
Total Vitual Memory 200 GB
Available Virtual Memory 1.96 GB
Page File Space 335GB
Page File C:\pagefile.sys

& [ | >
Find what: | Find

Physical memory is what's installed on physical modules inside your PC.

Figure 10-1




Chapter 10: Installing Memory

w= Visit your PC maker's Web site, which may have a
feature that will scan your system or tell you what
memory was installed at the time of purchase.

w= Visit a computer retailer's Web site, and look up the
parts you need by entering the manufacturer and
model number of your computer. The System
Information window (refer to Figure 10-1) displays
the manufacturer name and model.

w= Get an online memory scan. Several companies that
sell memory modules offer an online scan of your
computer that identifies the kind of memory you
need. One example is Micron Technology’s Crucial
System Scanner at www.crucial.com.

SDRAM, DDR, DDR2, and DDR3? Not really, except
to recognize that these are four of the most common
types of memory modules for modern PCs. How
about the speed difference between, say, PC2-5200
and PC2-5300? Same thing applies. If your system is
designed to use DDR PC2-5200 memory, that's what
you should shop for.

@ Do you really need to know the difference among

Install a New Memory Module

Nearly all memory vendors provide instructions for

@ installing their modules. Many also answer questions
over the phone or through a chat feature on their
Web sites.

1. Prepare your workspace, assemble your tools, and ground
yourself properly (see Chapter 2).

2. Make sure that the computer is turned off, and unplug
the power cord and cables.
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3. Place the computer on a sturdy, well-lighted surface, and
open its case (see Chapter 2).

4. Look for a set of long slots that hold upright DIMM
memory modules. Most motherboards have two or four
such slots, usually black, with a set of plastic lockdown/
ejector clips at each end. The system shown in Figure
10-2 has a four-slot motherboard.

Installed memory modules, latched into place by clips.

Partly installed memory modules

Figure 10-2

If you've already run a scanning program (see “Find the
Right Memory Module,” earlier in this chapter), you
should know how many DIMM slots to look for and how
many of them are already filled. In general, you should
have two or four identical modules. If you are installing
larger or faster modules as a pair, they should go in the
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first two slots. In most designs, the slots closest to the
microprocessor are considered to be slots 0 and 1 (and
are marked that way on the motherboard in tiny letters).

[ mention SDRAM (Synchronous Dynamic Random

@ Access Memory), DDR (Double Data Rate), and
other memory types earlier in this section. These
terms refer to how the memory chips work. DIMM
(Dual Inline Memory Module) refers to how the
chips are mounted on a circuit board and installed in
your system.

5. If you need to remove an old module to install a new
one, press evenly on both of the lockdown/ejector clips
to release the unit; then lift the module straight up and
out of the slot. Place the removed module on a noncon-
ductive surface such as a cardboard box or plastic bag.

6. Take the new module out of its antistatic bag, holding it
by the edges. Avoid touching the metallic connectors on
each side of the bottom of the module to keep oils from
your fingers from interfering with the module’s contact
with the motherboard.

7. Follow the installation instructions provided by the
memory seller. In most situations, you'll be asked to put
the largest-capacity modules in the first slots and the
smaller ones in the higher-numbered slots; for a small
number of motherboards, you'll be asked to do things
the other way around.

8. Locate the notch in the row of pins at the bottom of the
module. It needs to line up with a matching pin or key in
the DIMM slot on your motherboard (see Figure 10-3).
The location of the notch depends on the type of module
your computer uses.
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This notch lines up with a pin on the motherboard.

Figure 10-3

If the notch and pin don't line up, turn the module
180 degrees and try that way.

9. With the notch and pin aligned, press evenly on both
ends of the module until it’s fully inserted into the slot
on the motherboard and the lockdown/ejector clips click
into place.

Don’t attempt to force the module into the slot if it
seems to be a complete mismatch. Contact the pro-
vider of the memory module to make sure that you

received the proper type for your PC.

10. Spend a minute or two examining the inside of the case
to make sure that all the memory modules are locked
down properly and that you didn’t leave any tools, pens,
or other objects inside.

1 1. Put the cover back on, secure it properly, and return the
machine to its usual location.

12. Reattach the cables and power cord, and turn on the juice.
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13. Check the amount of installed memory, which you can
do in either of two ways:

e Watch the startup screen carefully. Many com-
puters display the amount of installed memory in
the startup screen — usually in megabytes, so a bit
of translation may be necessary. In computer
math, 1,024MB is 1,000 megabytes, which is the
same as 1 gigabyte (1GB). So if you put 4GB of
memory in your machine, you may see it dis-
played as 4,096MB.

e Check the System Information dialog box. To
open this dialog box, refer to “Find the Right
Memory Module,” earlier in this chapter.

Troubleshoot Jumbled Memory

So what do you do if your computer doesn’t recognize the new mem-
ory or refuses to start up after you install a new module?

w= [f the computer starts but displays an error message
during startup, read the details of the message care-
fully. Some computers may detect new memory and
then ask you to restart so that the memory settings
are updated.

Output System) chips that don’t recognize more
modern memory modules or larger amounts of
memory. See the next paragraph for details on what
to do.

@ Some older computers may have BIOS (Basic Input
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If your computer starts after the installation of new
modules but reports an incorrect amount of RAM,
perform the troubleshooting steps at the end of this
section to make certain that the new units are
installed properly. If the problem continues, check
with the maker of your machine to see whether a
BIOS update is available. In most cases, the update
can be delivered to you over the Internet.

If the computer won't start, first make sure that you
reconnected the power cords and other cables to
your PC after installing memory.

If all the connections are in place but the computer
still won't start, reopen the case (see Steps 1-3 of
“Install a New Memory Module,” earlier in this chap-
ter) and then follow these steps:

Go back to the start of the installation instructions,
and recheck each step.

Make certain that the modules are fully seated in their
slots, with the lockdown/ejector clips latched into
place at both ends.

Remove the modules (see Step 5 of “Install a New
Memory Module,” earlier in this chapter), and examine
them carefully (see Figure 10-4). Make sure that the
notches in the modules line up with the pins in the
motherboard slots and then reinstall them.

Look around inside your computer to make sure that
you haven’t accidentally disconnected one of the
internal power cables to the hard drive or other
components.
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Carefully remove the newly installed modules and re-install them.

Figure 10-4

3. If you tried all these troubleshooting steps and still
can’t bring your computer to life or get it to recognize
new memory, return the computer to the condition it
was in before you put in new modules (see Chapter
16), reinstall the original modules, and then test
the PC.
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6. If the computer works with the old memory but not
with the new memory, contact the seller of the RAM
module. You may have purchased the wrong type, or
you may be the unlucky owner of a defective module.
Manufacturers usually test memory modules, so fail-
ure is rare, but it's possible.

184



Changing a Drive,
Made Easy

W hy replace a hard drive? I can give you
two very good reasons:

w  Cost: If a hard drive fails, it has to be
replaced, because there’s no cost-efficient
way to repair it.

w= Performance: The other reason to change
a hard drive is to increase your comput-
er’s efficiency or capacity. A larger hard
drive not only gives you more storage
space, but also lets Windows use more
virtual memory for faster operation.

If you're considering installing a new hard drive
because the old one has run out of space, a
quick and easy solution is an external drive.
You can buy one almost anywhere: a computer
supply store, a discount superstore, an electron-
ics shop, or one of thousands of online outlets.
Just plug the drive into a USB port or a network
switch, and it’s ready to go. If your current hard
drive still works (and isn’t too old), you can
add a second drive without having to reinstall
Windows and all your applications.

In this chapter, I help you with what some
people consider to be the “hard” parts of add-
ing or replacing a drive, but as you'll see, the
process isn't too difficult.
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procedures, see my book Fix Your Own PC (Wiley

@ For much more detail on hard drives and installation

Publishing).

Determine What You Need

186

1.

Will you be installing a new boot drive — the one your
computer starts from — or an additional drive to use
for storage? On most PCs, the boot drive is connected to
the first data port on the motherboard. (By techie tradi-
tion, the first port is marked 0, the second is 1, and so
on.) There’s no difference in the construction of boot and
storage drives, but if you're installing a boot drive, you'll
have to instruct your computer where to look for
Windows and the essential tracks it uses to bring itself to
life (see “Format the Drive,” later in this chapter).

What kind of data cables does your hard drive use?
Nearly all current PCs use a variation on the ATA
(Advanced Technology Attachment) design called either
PATA or SATA:

e PATA (parallel ATA): Until about 2007, ATA used
a wide, flat ribbon cable carrying 40 wires (see
Figure 11-1), and the 16 bits of each computer
word moved along the cable in parallel — one
alongside another — from the motherboard to the
drive, or vice versa.

e SATA (serial ATA): Today, most PCs have switched
to a thin round cable with just eight wires (see
Figure 11-2), and the bits of information move
along the cable in serial communication, with one
bit behind another. In addition, the changeover to
thin round cables reduces much of the clutter under
the covers of a modern PC and improves the flow
of cooling air inside the box.
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Older computers use a wide ribbon cable for hard drive data.

T L L LLLLLARALY

T L L ALALAAR

Figure 1 1-1
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Most new machines use the compact serial wire.

Figure 11-2

3. What attachment points are available?

¢ Internal drives: Some computers have a cage with
rails like the side ribs of an oven; a hard drive
slides into the cage along the rails and then is
secured by screws or latches (see Figure 11-3).
Other computers have multiple slots or rails along
the frame of the case (see Figure 11-4).

disk drive is located, because (unlike a CD or DVD

@ Generally, it doesn’t matter where in the case a hard
drive) it doesn’t provide external access. You do need

188



Chapter 11: Changing a Drive, Made Easy

to secure the drive, however, so that it doesn’t fall on
other parts inside the case. Also make sure that it
doesn’t block the flow of air inside the computer.

e External drives: Between the PC and the external
drive is a communication cable that plugs into
each device. Most external drives also require con-
nection to an electrical outlet, although a few
devices can draw their power from the PC through
a USB or FireWire cable (see “Install a New
External Drive,” later in this chapter).

Slide the hard drive into the cage.

o :

Wi m

W
10 1

|

Figure 11-3
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Installed hard drive Slot for additional drive
Figure 11-4

4. What type of power-supply connector does the disk
drive use? The computer’s power supply (see Chapter 9)
provides DC voltage to spin the drive’s internal platters,
move the read/write head back and forth, and communi-
cate with the computer itself. Your hard drive may use
one of the following kinds of cables to connect to the
power supply:

e Molex connector: Older PATA drives generally use
a large, fat white Molex connector (see Figure
11-5). A key on the male connector mates with a
slot on the female receptacle on the drive, making
it difficult (but not impossible) to install the cable
upside down.
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Molex connectors  PATA drive
Figure 11-5
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e SATA connector: Newer SATA drives use a thin
black connector (see Figure 11-6) that provides
added protection against accidents during installa-
tion. Some SATA drives also include a Molex con-
nector as a backup.

SATA cable connector
Figure 11-6

in your motherboard to a connector that will fit
into a SATA receptacle. Just search the Internet for
PATA to SATA adapter. You'll find many sources,
including www . TigerDirect.com and www.
satacables.com.

@ You can use a converter to change a Molex connector



Install a New Internal Drive

1.

2.

3.

Prepare your workspace, assemble your tools, and ground
yourself properly (see Chapter 2).

If you're replacing your boot drive, make sure to back
up any data that you want to save and install on your
new hard drive.

Make sure that the computer is turned off, and unplug
the power cord and cables.

Place the computer on a sturdy, well-lighted surface, and
open its case (see Chapter 2).

. If you're replacing a drive, unplug its data and power

cables, and remove it from the case. This process may be
as simple as sliding the drive out of a cage. In other cases,
you have to remove two or four screws on the sides of
the drive. (Put the screws aside so that you can use them
with the new drive.)

5. If your new drive needs rails to mount in the case,

remove the rails from the drive you took out before
installing the rails that should have come with the
new drive.

. Slide the new drive partway into the slot you just vacated

or, if you're adding a second drive, partway into a vacant
slot. Installing the drive only partway holds it in place
but gives you flexibility while you hook up the data and
power cables (see Steps 7-8). You'll seat the drive in the
slot later.

be easier to connect the data and power cables before

@ Depending on the design of your computer, it may

you slide the drive into place.

Chapter 11: Changing a Drive, Made Easy
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7. Find an available data cable and connector near the loca-

tion where you'll be installing the new drive, and plug
this cable into the data port of your new hard drive. Data
cables are just lying around inside the case, connected to
the motherboard on one end and to nothing or to
another hard drive on the other.

Most PATA ribbon cables can connect to two devices,
with one device marked master and the other marked
slave. (If you're using a PATA system, consult the drive
maker’s instructions to find out how to configure the tiny
jumpers or switches on the device to match its status as
master or slave.) On the other hand, SATA data cables are
one to a customer, connecting one device to one interface
on the motherboard.

generally need to use the first data connector, which
usually is marked 0 on the motherboard. If the drive
will be used as an additional storage device, you can
attach it to any other available data connector.

@ If the new drive is going to be your boot drive, you

8. Locate an appropriate power cable, again choosing one

near where the new drive will be installed, and plug this
cable into the power connector on the new hard drive.

9. Slide the drive into place (see Figure 11-7).

10. Make sure that the drive and cables are properly secured

and that you didn't leave any tools or other objects inside
the case.

1 1. Put the case back on, secure it, and return the computer

to its usual location.
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Front-of-case slot for SATA drive

Figure 11-7
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12. Reattach the cables and power cord, and turn on the
computer.

13. Skip to “Partition the Drive,” later in this chapter.

Install a New External Drive

196

port, so I cover that type in this section. For details
on installing a different type, consult the instruction
manual or my book Fix Your Own PC (Wiley
Publishing).

@ Most external drives connect to a computer’'s USB

1. Plug the drive’s USB cable into a free USB port on your
computer.

Your PC can be on or off when you plug in a USB
device.

2. Plug the other end of the USB cable into the external
drive’s USB connector (see Figure 11-8).

3. Attach the power cord to the drive, and plug it into
wall current or — better yet — a surge protector (see
Chapter 1).

4. Turn on the power to the external drive (and to your
computer, if you turned it off before installing the
new drive).

Nearly all devices proceed to install any necessary drivers
or utilities automatically when you turn them on. Follow
any onscreen instructions.
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If Windows or your antivirus software displays a
security alert during installation, click Accept or
Continue. If you can’t get past this warning, you can
disable your firewall or other security software (see
Chapter 6) before continuing with the installation.

5. Proceed to the next section, “Partition the Drive.”

Power connector USB connector
Figure 11-8
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Partition the Drive

198

The next step in preparing a new disk is partitioning, which assigns
logical units and file systems to the hard drive. Partitions are the basic
containers for data. Each partition exists in a specified physical loca-
tion on the hard drive and functions almost like a separate drive.

1. Decide how many partitions you want to have on your
hard drive. Depending on the size of the drive and the
version of Windows you're using, you may be able to use
a single huge partition. This configuration is the easiest
and (in my opinion) best one to use, if your computer
supports it. If not, you have to create two or more
smaller partitions. A 250GB drive, for example, could be
set up as two logical drives of 125GB each, or as one
50GB drive and two 100GB drives.

tion, you may want to create at least two partitions.
Some professionals recommend creating a relatively
small partition — 20MB or so — to hold only
Windows and using the rest of the drive for all other
programs and data.

@ Even if your computer can support one large parti-

2. Use the manufacturer’s utility to create the partitions.
Hard drive manufacturers usually provide a utility that
automates the creation of partitions; this utility (such as
the Western Digital example shown in Figure 11-9)
comes on the drive itself or on an accompanying CD or
DVD. Follow the instructions faithfully, and accept the
utility’s recommendations on what partitions to create.

Most external drives come preformatted and ready to
run immediately in Windows. For information on
reformatting, see the next section, “Format the Drive.”
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Follow the utility’s instructions to partition your new drive.

Western

Digital Data Lifeguard Tools™ ..,

View Installation Tutorial will ask you to
select the model number of the new }ﬂewlli'lstallaﬁhgwnTuloﬁal
Western Digital drive you wish to install. nstruclions on how (o connect a

i c s hard drive t ter.
It will then create step by step instructions niew harc crive o your computer
on how to add the new drive to your
system.

Set Up Your Hard Drive
Set up a hard drive already
connected to your computer.

Utilities
Drive-to-drive partition copy
and other disk tools.

Hard Drive Information
Jumper settings and other
technical infermation about
your hard drive.

Figure 11-9

Format the Drive

Formatting a drive applies a set of magnetic markers to the disk plat-
ters, allowing your computer to set up a file system that indexes what
data is placed where.

1. Use the formatting utility included with the hard drive
(such as the example shown in Figure 11-10) to format
the device. For most users, the best practice is to accept
the manufacturer’s recommended (default) settings. The
program may create one of the following types of file
systems:
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Format Maxtor 300GB External (... ==

Capacity:

|279 8 -
File sy=tem

NTF5 (Defauit) x|

Allocation unit size

512 bytes -|

| Restore device defaults

Volume label
Maxtor 300GE External

Format options

[7] Quick Format

Start I I Cloze

Make any required changes
before you start the process.

Figure 11-10

e FAT (File Attribute Table): You would use FAT or
FAT32 (see the next paragraph) only if you need to
maintain compatibility with older equipment or if
you intend to load and switch between a current
version of Windows (XP, Vista, or 7) and an older
one (such as Windows 95, 98, or ME). That situa-
tion isn't likely to apply to most readers of this
book.

e FAT32: Like FAT, FAT32 is an older file system.
Generally, it's unable to deal with drives (or parti-
tions within drives) larger than 32GB.
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e NTFS (Windows NT File System): If you're using
Windows XP, Vista, or 7, the preferred file system
is NTFS, which is more efficient than FAT and
FAT32, and also more capable of recovering from
certain types of disk errors. NTFS is essential for
use with large disk drives.

On most new external drives, the standard setup

@ provides a single FAT32 partition, which means that
Windows will use the entire capacity of the new
drive as a single volume. If you choose to reparti-
tion the drive so that it appears to Windows to be
two or more drives, you can do so — but doing so
will erase any preloaded software or utilities that
came with the drive.

2. If you intend to use the new hard drive as your boot
drive, install special boot tracks and Windows itself on
that drive. You accomplish this task by using a utility
provided with the operating system. In most instances,
you turn off your computer, place the Windows DVD in
your CD/DVD drive, and then turn the computer on
again. The computer recognizes the presence of the DVD
and gives you the option of installing the operating sys-
tem on your hard disk drive (see Figure 11-11).

Follow the instructions carefully, and be prepared for a
lengthy process; most installations require several hours
to complete.

were called A and B. To maintain compatibility with
older hardware and software, those two letters are not
available to identify hard drives in a standard setup.
Drive C usually is the boot drive, followed by drives
D through Z. (Special utilities are available for rare
and unusual configurations with dozens of drives, but
that topic is well beyond the scope of this book.)

@ Early PCs had one or two floppy disk drives, which
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Windows XP Professional Setup

Welcome to Setup.
This portion of the Setup progran prepares Microsoft(R)
Vindows{R) %P to run on your conputer.

e To set up Windows XP now, press ENTER.

+ To repair a Uindows XP installation using
Recovery Console, press R.

¢ To quit Setup without installing Windows XP, press Fi.

EN[ER=Continue R=Repair F3=Quit

Press Enter to start a new Windows installation.
Figure 11-11

Troubleshoot a New Internal Drive

1. Make sure that you've connected the PATA or SATA data
cable securely to the proper port on the motherboard, as
described in “Install a New Internal Drive,” earlier in this
chapter. (For a refresher on the cables themselves, see
“Determine What You Need,” earlier in this chapter.)

2. Check the power-cable connection (also described in
“Install a New Internal Drive,” earlier in this chapter).

3. Open the case (see Chapter 2), plug in the PC's power
cord, and turn the computer on. Listen for hard drive
activity (you should hear the heads moving on an active
drive), and check the disk activity light on the front of
the case. If the power supply or other internal electronics
may have failed; contact the manufacturer for advice on a
possible repair.
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4. Open Device Manager (see Chapter 18), or open the My
Computer or Computer window, as follows:

e Windows XP: Choose StartoMy Computer.

¢ Vista and Windows 7: Choose Start>Computer.

and Windows 7 is to click the Start button and then
type device manager in the Search Programs and
Files text box.

@ The easiest way to access Device Manager in Vista

5. View the Disk Drives list. If the drive is in the list, you
can double-click it to display a Properties dialog box like
the one shown in Figure 11-12.

Click the tabs to review hardware and driver status.

L TOSHIBA MK2035G5S ATA Device Properties [7==
= Genersl [ Polies | Volumes [ Daver | Detais|

TOSHIBA MK2035G55 ATA Device

Device type: Disk drives
Manufacturer: {Standard disk drives)
Location: Location 0 (Channel 0, Target 0, Lun 0)

Device status

[This device is working propery.

OK I l Cancel

Figure 11-12

Chapter 11: Changing a Drive, Made Easy
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6. If the drive doesn’t show up in the Computer/My
Computer window or in Device Manager, it's not com-
municating with the computer. Recheck all cables.

7. If the drive still doesn’t respond or appear in the My
Computer/Computer window or in Device Manager, call
the manufacturer for technical support.

Troubleshoot a New External Drive

1. Make sure that the external drive is plugged into a live
electrical outlet, turned on, and receiving power. Nearly
all external drives use an adapter that transforms AC wall
voltage to DC voltage; check to see that all plugs are
seated properly in their receptacles.

2. Listen for any activity. I have yet to find a completely
silent disk drive. You should be able to hear the drive
motor, an internal cooling fan, or both. If the device is
switched on and receiving power, but you detect no signs
of life, the new drive’s power supply or other internal
electronics may have failed. Contact the manufacturer for
advice on a possible repair.

3. Open Device Manager (see Chapter 18), or open the My
Computer or Computer window, as follows:

¢ Windows XP: Choose Start=>My Computer.

¢ Vista and Windows 7: Choose Start>Computer.

and Windows 7 is to click the Start button and then
type device manager in the Search Programs and
Files text box.

@ The easiest way to access Device Manager in Vista
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4. Pull down the Disk Drives list to see whether the new
drive is displayed.

5. If the drive doesn’t show up in the Computer/My
Computer window or in Device Manager, it's not com-
municating with the computer. Recheck all cables.

6. If the drive still doesn't respond or appear in the My
Computer/Computer window or in Device Manager, call
the manufacturer for technical support.

7. Try reinstalling the drive’s software and device drivers
(see Chapter 4).

8. Run a diagnostics program (see Chapter 5) to find out
whether the computer’s ports are functioning properly.
Follow any onscreen instructions.

9. Take advantage of the external drive’s portability by test-
ing it on another PC. You could try plugging it into a
friend’s computer to see whether it recognizes the drive,
or maybe a local computer repair shop will allow you to
make the same test on its equipment. Don’t forget to
take — and use — the AC adapter and data cable that
came with the drive.

Install a New Internal CD/DVD Drive

You can use either an internal or an external

@ CD/DVD drive. External drives simply plug into
your computer, so I discuss installing an internal
drive in this section.

1. Prepare your workspace, assemble your tools, and ground
yourself properly (see Chapter 2).
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2. Make sure that the computer is turned off, and unplug
the power cord and cables.

3. Place the computer on a sturdy, well-lighted surface, and
open its case (see Chapter 2) after you've grounded
yourself.

4. 1f your new drive needs rails to mount inside the case,
install the rails that should have come with it.

5. Prepare the location for the new drive. You probably
need to remove a cover on the front of your case where
the new drive will go. This cover may snap off and on, or
it may be attached by small screws that you'll need to
remove. (Put the screws aside so that you can use them
to secure the new drive.)

6. Slide the new drive into the mounting slot. Depending
on your case design, you may need to slide the new
drive in from the front or (more likely) insert the drive
from inside the case so that it sits flush with the front
of the case.

Depending on the design of your computer, it may
be easier to connect the data and power cables (Steps

7-8) before you slide the drive into place.

7. Find an available data cable and connector near the loca-
tion where you'll be installing the new drive, and plug
this cable into the data port on your new hard drive (see
“Install a New Internal Drive,” earlier in this chapter).

8. Locate an appropriate power cable, again choosing one
near where the new drive will be installed, and plug it
into the power connector on the new drive.
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CD and DVD drives provide audio as well as data to
your computer. New drives use the data connection
for audio only. Check your documentation. If your
drive requires an analog audio connection, attach the
supplied cable from the drive’s audio out to your
sound card’s audio input connector.

9. Make sure that the drive and cables are properly secured
and that you didn’t leave any tools or other objects inside
the case.

10. Put the case back on, secure it, and return the computer
to its usual location.

T 1. Reattach the cables and power cord, and turn on the
computer.

Test a New CD/DUD Drive

1. Open Device Manager (see Chapter 18).

2. Click the plus sign (Windows XP) or the right-facing
arrow (Vista and Windows 7) next to the DVD/CD ROM
Drives entry.

3. Double-click the DVD/CD drive name in this list to dis-
play the Device Properties dialog box (see Figure 11-13),
and check for the message This device is working
properly.

4. (Windows XP only) Click the Properties tab, and make
sure that the check box titled Enable Digital CD Audio
for This CD-ROM Device is checked.
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& Devilce Manager

File Action View Help

e | EH HmE & 2 %d

4 = Windows-T-Imac
£) Bluetooth Radios
M Computer
g Disk drives
B Display adapters
) DVDYCD-ROM drives
l_Jr, OFTIARC DWD R AD-56705 ATA Device
e YM&X Magiclack USE Device
% Human Interface Devices
‘g IDE ATAATAPT controllers
- JEEE 1284.4 compatible printer
-fimn JEEE 1254.4 devices
: Q IEEE 1594 Bus host controllers
Z5 Imaging devices
= Keyboards
S Mice and other pointing devices
B Monitors
¥ Metwork adapters
\iF Other devices
Built-in isight
Coprocessor
5 HP Photosmart 7550 series Printer
B8 Portable Devices
B F
D Processars
% Sound, video and game controllers
M systemn devices
b Universal erial Bus controllers

OPTIARC DVD RW AD-5670S ATA Devlce Propertles = |

Genersl | DVD Region | Yolumes | Dri\;i Details |

- % OPTIARC DVD Rw AD-5E703 ATA Device
=

Device type: DWD/CD-ROM drives
Manufacturer. [Standard CD-ROM drives)

Location: Location O [Channel 1, Target 0, Lun 0]

Device statuz

Thiz device iz warking properly.

Ok | | Cancel

Check whether the new drive is working properly.

Figure 11-13

5. If everything is working properly, click OK to close the
Device Properties dialog box. If you don’t, follow the
troubleshooting steps for your type of drive — internal or
external — earlier in this chapter.

6. Install the software that came with the new drive.
Windows includes a fairly simple disk-burning applica-
tion, but your new drive probably includes a more robust
program. Install it now according to the manufacturer’s

instructions.




Fixing a
Malfunctioning
Printer

ou're looking at a beautifully formatted

page of text in your word processor or
studying an uproarious list of jokes sent by a
friend in an e-mail (which, to some people, is
the real purpose of the Internet). Or maybe
your children have sent some incomparably
adorable pictures of your grandchildren. In any
case, you want a printed copy to treasure.

You click the Print button in the computer pro-
gram you're using to get a printout of what
you're viewing, and something like this
happens:

w= Nothing happens.

w= A few lights on the printer flash, but no
motors churn.

w= The printer fires up its engine, begins to
load a piece of paper, and then grinds to
a stop.

w= The printer actually prints a page, but
you can hardly read it because of light
print or skipped characters.

| “*apter
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What do you do? In this chapter, I show you some solutions to com-
mon printer problems.

Check Printed Pages for Problems

w= Dark vertical or horizontal lines: Dark lines run-
ning the length or width of a printed page, as you
see in Figure 12-1, may be caused by a dirty or dam-
aged printhead (inkjet printer), contamination of
components (laser printer), or low ink or toner lev-
els (both types). On a laser printer, these lines may
also be caused by a scratch or other damage on the
drum, which usually is part of the laser cartridge
that’s replaced when toner is depleted.

w= [Ineven print tones: If the characters or images on
the page are uneven in darkness, that result usually
indicates low ink or toner.

a few dozen more pages from a cartridge by remov-

@ If you're using a laser printer, you can usually eke out
ing it and gently shaking it to redistribute the toner.

On a laser printer, other possible causes of uneven
printing are damage to the photoreceptor or a light
leak into the receptor from a nearby lamp or win-
dow. You don't have to operate a laser printer in a
darkroom, but you should keep its cover in place
except when you have to replace the toner and drum
or clear a paper jam. (I keep my laser printer in a
corner, away from the windows.)

w= White vertical lines (laser printers): White gaps or
lines down the page may be caused by damage to
the toner cartridge or debris in the path between the
cartridge and the drum. You may be able to remove
the obstacles; otherwise, you'll have to replace the
cartridge.
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= USB cable
= Lanyard
* Quick Start Guide (this manual)

HOW TO OPERATE FLASH PADLOCK
Flash Padlock ships in an unlocked config-
uration ready to use in your computer.

To enable Flash Padiock’s security, you
will need to set up a combination,

‘our combination must be between a
minimum of one (1) and a maximum of
ten (1) digits.

ration at the Corsair Website
orsaircom,/padi

Figure 12-1

clan e a
will revet back to its old combination and
you will need to restart the process. If no
combination was set. Flash Padliock will
revert back fo its orginal unopened status,

Step §: The GREEN LED will biink to inclicate
the combination has been set. When the
GREEN LED is flashing, Flash Padiock will
remain unfocked for about 15 seconds.

When the GREEN LED stops flashing, Flash
Padiock will Auto-Lock and will require you
to enter in your PIN to uniock.

NOTE: Auto-Lock will automatically lock
Flash Padlock. This is your way of locking
your Flash Paciock drive.

HOW TO UNLOCK FLASH PADLOCK

Step 1: Firmly press and quickly release
the KEY button. The RED LED will blink to
indicate Flash Padlock is locked, but ready
for you to enter your combination. You
have about 5 seconds to begin Step 2.
NOTE: if you hoid the KEY button down for
fonger than 2 secands, you will get an error;
GREEN and RED lights alternately biinking,

Step 2: While the RED LED is blinking,
enter your cambination then firmly press
and quickly release the KEY button,
During this combination entry stage, tha
RED and GREEM LED lights will blink in
unison. IF any of the lights turn off, you
will need to repeat Step 1.

Step 3: The GREEN LED will blink to
indicate Flash Padlock is unlocked.

Step 4: Wh
and quickly

Step 5: Botl
lights will bl
re-enter you
antering the
press and ri
NOTE: If you
before the A
turr off (apd
Padfock will
tion and youl

Step 6: The
indicate the|
‘When the Gl
{approximat)
feature will

into its lock

HOW TO Lg
Step 1: You
while it is pl|
Disconnect
computer.

Step 2: FlasH
feature will 5
15 seconds.
stops blinkin
the drive,
NOTE: If Fial
combinatior]
and the driv]
to have Aut
tions on “hol

n you are done, firmly press
felease the KEY button

the RED and GREEN LED
k. You will then need to
F combination to verify. After
combination a second time,
ease the KEY button.

oo not venlfy your combination
D and GREEN LED lights
Foximately 15 seconds) Flash
[evert back to its old combina-
will need to restart the process.

[ZREEN LED light will blink to
jcombination has been set.
REEMN LED light stops blinking
Ely 15 seconds), the Auto-Lock
mable and Flash Padlock goes
d state.

ICK FLASH PADLOCK
fannot lock Flash Padlock
loged into your computer.
lash Padlock from your

Padlock's Aute-Locking
poure the drive in approximat
['hen the GREEN LED light

b, Aute-Lock has secured

h Padiock does not have &

set, Auto-Lock cannot enable

p will remain open. If you want

-Lock enabled, see instrue-

v to set a combination™.
Continued e next page

If you see this, check for dirt in the printer or a damaged component.
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w= Black or white blotches: Blotches of black or white
on the paper may indicate contamination of the
drum or the fusing roller. The drum isn’t easy to
clean, but if your cartridge includes a drum, like the
one shown in Figure 12-2, the problem will be fixed
when you replace the cartridge. Most printers include
a small brush and sometimes a cleaning solution for
the fusing roller. Consult the printer’s instruction
manual for advice.

A laser cartridge like this replaces all the
critical printer components each time you replace it.

Figure 12-2

w= Streaky lines (laser printers): Streaks on the page
sometimes tell you that toner needs to be cleaned off
the printer’s rollers or electrostatic parts.
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w= Low resolution or dropouts (inkjet printers): The
tiny ink nozzles on the print head of an inkjet
printer are prone to clogs that can result in loss of
resolution or dropouts in text or graphics. Many
printers include a utility for cleaning the inkjet head;
consult the manual for details.

One other issue to consider is the quality and type of
@ paper you use in your printer. To get the most out of
a laser printer, use good-quality copy paper that’s
certified for a laser printer or copy machine. Inkjet
printers generally require a smoother paper surface
because the ink is applied wet, and the text or image
can become fuzzy if the ink is absorbed into the
paper. Photorealistic inkjet printers work best with
glossy or coated stock. Consult the printer manual for
advice, and don’t be afraid to experiment with small
quantities of different paper grades; some office-
supply stores offer free sample packs for testing.

Test the Printer’s Hardware

1. Make sure that the printer is turned on and plugged into
a live electrical outlet. If the printer doesn’t seem to have
power, test the outlet by plugging in a lamp or radio that
you know is working properly. If the lamp lights or the
radio sings but the printer won’t come to life, the printer
may have suffered an electrical failure.

2. Check the printer’s paper and ink levels. Some printers
are smart enough to stop the job when you run out of
supplies but not communicative enough to tell you why.
Study the printer’s instruction manual to find the mean-
ing of any error lights on the printer or messages on your
PC’s monitor.
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©)

Many — probably most — printers today include
software that notifies your Windows printer driver
when ink supplies are low. Get into the habit of
checking your printer's window each time you send
a document to it, and look for a low-ink warning.
Click this warning to find out which cartridge will
need to be replaced soon.

3. Check for a paper jam. Paper jams are usually caused by
one of three conditions:

®

¢ Debris stuck in the paper path: Consult the
instruction manual for advice on cleaning the
paper path. Use a vacuum cleaner with a soft
brush to remove debris (including tiny pieces
of paper).

e High humidity: Humidity causes paper to stick to
other pieces of paper or to printer rollers.

One way to deal with humidity is to store your paper
in a sealed box, installing only as much as you need
to print a job.

e Inappropriate paper: Check your printer’s specifi-
cations for acceptable weights and grades of paper.
Stock that’s too thin, thick, or glossy can jam a
printer. (Also see “Check Printed Pages for
Problems,” earlier in this chapter.)

4. Run the printer’s built-in self-test. Consult the manual
or call the manufacturer to find out how to test the
machine.

e If the self-test fails, and the test program makes
no suggestions about repairs (such as cleaning
certain parts or replacing ink or toner cartridges),
the printer may need servicing at a professional
repair shop.
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If your printer needs servicing, but its warranty has
expired, replacing it probably makes more economic
sense than repairing it.

e If the self-test works, move on to the next step.

5. Print a test page. To send the test page, turn on the
printer and follow these steps:

a. Choose Start>Control Panel= Printers and Faxes
(Windows XP), Starte>Settings= Printers (Vista), or
Start=>Devices and Printers (Windows 7).

b. Right-click the printer’s icon, and choose Properties
(XP and Vista) or Printer Properties (Windows 7)
from the shortcut menu. The printer’s Properties
dialog box opens (see Figure 12-3).

=1 HP LaserJet 6P/6MP PostScript on CS92 Properties  [=5]

| ColorManagement |  Secuity |  Device Sefings |
General | Sharing T Ports I Advanced |
=
-

Location:

Comment:

Model: HP LaserJet 6P/6MP Post Script
Features
Caolor: No Paper available:
Double-sided: MNo Letter
Staple: Mo
Speed: B ppm

Maxdimum resclution: 600 dpi

| Printing Preferences... | l Print Test Page

[ ok ][ cance |

Click Print Test Page to eliminate a
particular application as the problem.
Figure 12-3
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6.

7.

c. On the General tab, click the Print Test Page button.
Windows displays a message confirming that the test
page was sent.

e If the test page prints successfully, as shown in
Figure 12-4, your problem is most likely a setting
within a program, such as your word processor.
Try resetting the program'’s printer options.

e If the test page doesn’t print, click the
Troubleshoot Printer Problems link in the test-
page confirmation message. The resulting help
screen (see Figure 12-5) presents the most likely
problems and helps you find the support Web site
for your particular brand of printer. Click the most
appropriate link for your problem. If you don't see
your problem listed, click Show All to see a page
of other possibilities, including issues with device
drivers and spoolers (features that store print jobs
on the hard drive temporarily while the printer
processes other jobs).

Switch printer cables. Substitute a data cable that you
know to be good, and print a test page again. If the
printer works, the original cable has failed and should be
replaced.

Connect the printer cable to a different USB port. Most
computers have at least four and sometimes eight USB
ports, and on rare occasions, one may go out of order. To
test the port you use to connect to the printer, plug in
another device (such as an external disk drive, a flash
memory key, or a digital camera) to see whether the sys-
tem recognizes its presence.

Check Device Manager to see whether it's reporting any
hardware failures or indicating a problem with any port
or printer drivers. For details on using Device Manager,

see Chapter 18.
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Ay Windows XP

my .
Windows  Printer Test Page

Congratulations!

If you can read this information, you have correctly installed your HP Laserlet
6P/BMP PostScript on C592.

The information below describes your printer driver and port settings.

Submitted Time: 10:37:18 aM 7/1/2009
Computer name: €592

Printer name: AUto HP Laserlet 6P/6MP PostScript on COREY
Printer model: HP Laserlet 6P/GMP PostScript

color support: No

Port name(s): use001

Data format: RAW

Share name: Printer2
Location:

Ccomment ;

Driver name: PSCRIPTS.DLL
pata file: HPLJ6P_4.PPD
Config file: PSSUL.DLL

Help tile: PSCRIPT.HLP
priver version: 6,00
Environment: windows NT x86

Additional files used by this driver:
C:\WINDOWS\System32'spool \DRIVERS\W32X86\I\PSCRIPT .NTF

This is the end of the printer test page.

Result of a successful test
Figure 12-4
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Click to show all
Links to help pages on common printer problems

Search Help pe)

» Showall =

Troubleshoot printer problems

Here are solutions to common problems with printers.
b My printer doesn't print.

¥ I see an error message about "spocler” problems, or the printer is printing more slowly
than usual.

¥ The printer only prints part of a page, prints blurry ink, or prints faded or inaccurate
colors.

» The printer is out of paper.

¥ Paper is caught in the printer (paper jam).

m

See also

® Find a printer manufacturer's website
# Troubleshoot netwaork printer problems
® (Cancel printing

= Pause or resume printing

e View the print gueue

‘Was this information helpful?

[ Yes ][ No ][ Somewhat

4

Read the orivacy statement anline

!‘f_ Ask someone or expand your search

Cnline Help =

Figure 12-5

9. Hook the printer up to another computer that you know
is working properly. You may be able to use a friend’s or
neighbor’s PC. Alternatively, some computer stores may
let you bring in your printer to run this test in the hope
that you'll end up buying something.
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Test the Printer’s Software

1.

Make sure that you're using the appropriate printer driver
and that it's in good condition. A printer’s built-in intelli-
gence can freeze or produce garbled output if you use an

incorrect, outdated, or corrupted printer driver. To check,
follow these steps:

a. Choose Start=>Control Panel=>Printers and Faxes (XP),
Starte>Settingsey Printers (Vista), or Start=>Devices and
Printers (Windows 7).

b. Right-click the printer’s icon, and choose Properties
(XP and Vista) or Printer Properties (Windows 7)
from the shortcut menu. The printer’s Properties dia-
log box opens.

c. Click the Advanced tab (see Figure 12-6), and make
sure that the driver settings are correct and that the
appropriate driver is being used. The driver name
should match the brand and model of your printer. If
it doesn’t match, you could somehow have installed
the wrong driver; even if it does match, you can try
installing a new driver. To do so, click the New Driver
button, and follow the printer wizard’s instructions.

See whether your printer has enough memory by printing
a complex document. If the document doesn’t print or is
of unacceptable quality, you may need to add more
memory to your printer or adjust printer settings to mini-
mize the amount of memory that the document requires.
Consult the instruction manual for specifics on adjusting
these settings.

Chapter 12: Fixing a Malfunctioning Printer
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Update your driver here.

Figure 12-6
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Taking Care of
Vour Mouse

(or Trackball )
and Keyboard

The good news is that mice, trackballs, and
keyboards make computing easy. The bad
news is that because they're mechanical, they
eventually wear out. How people use them
affects their life span too. Some users treat the
devices gently; others have a clicking and typ-
ing style that closely resembles a worker on a
chain gang pounding rocks.

You can do a few things to improve the perfor-
mance of these devices and perhaps extend
their lives. Attempting to repair broken units
may not make sense, however, because they're
so inexpensive. Replacement keyboards, for
example, sell for as little as $10.

The really good news is that new mice, track-
balls, and keyboards are truly “plug and play”
devices. Removing the one that came with
your computer and replacing it with a new
one takes about as much effort and technical
expertise as unplugging an electric lamp and
plugging it back in.

| “*apter
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Keyboard...........ccovennen.. 225
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> Vet Your Mouse................. 232

w= Revive a Dead Mouse,
Trackball, or Keyboard...... 235

w= Replace a Dead Mouse,
Trackball, or Keyboard...... 235
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In this chapter, I give you the lowdown on caring for these devices so
that you don’t have to replace them before their time — and show you
what to do when replacement day finally comes.

Keep Your Keyboard Clean

w= Never, ever get it wet. Here's a rule that's more
ignored than observed:

Don’t place a cup of coffee, a can of soda, or any

other liquid anywhere near your keyboard — or your
PC, for that matter. Spilled liquids are very likely to
short out the electronics. Although you may be able
to clean a keyboard that’s been doused with soda,
this is a problem that you don’t need and can easily
avoid.

@ If your keyboard is bound to be in a wet or sloppy

environment (a kitchen or a restaurant, for example),
you should look into purchasing a keyboard skin.
The impervious clear plastic covers all the keys and
still lets you peck them. You can also purchase an
industrialized keyboard that comes sealed in a water-
proof or water-resistant membrane. You can start
with www . sealshield. com, which carries a line of
guaranteed-waterproof keyboards and mice.

= Give it a good cleaning every few months. To clean
a keyboard, follow these steps:

1. Turn off the power to the PC, unplug the keyboard,
and turn it over to shake out dust and dirt.

your PC with a USB cable (see Figure 13-1), you can

@ If you have a USB keyboard or mouse that attaches to
unplug it while the computer is turned on. If your
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mouse is old enough that it uses a PS/2 connector
(see “Vet Your Mouse,” later in this chapter), the saf-
est way to proceed is to shut down the PC before
removing the plug.

USB cable

Figure 13-1

2. For even better cleaning, use a can of compressed air
(available at office-supply stores) to blow between
individual keys, or use a vacuum cleaner’s crevice-tool
attachment to suck out dirt. This tool concentrates the
power of the vacuum and can pull debris out from
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between and under the keys. Just use caution; this tool
normally is made of hard plastic, so you don’t want to
be too aggressive with your cleaning.

and other parts of the computer is a soft, unused
paintbrush. I keep a couple of different sizes on or
near my desk at all times. The soft bristles won't
scratch hardware or screen surfaces, and they can
reach between keys and into other cracks and crevices
to remove dust and other undesirable debris (see
Figure 13-2).

@ An excellent tool for cleaning the keyboard, screen,

Use commercial air or a soft brush (even a clean
paintbrush) to keep your keyboard shipshape.

Figure 13-2
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3. Use a soft cloth dampened with a weak plastic cleaner
or a small amount of isopropyl alcohol to polish the
keys and the surrounding case. The most fastidious
among you may want to use the same solution on a
cotton swab to clean between the keys.

If it's absolutely necessary, you can remove individ-

@ ual keys with a special tool that’s supplied with many
keyboards; a technician’s tweezers with hooked ends
will also work. Work very carefully to avoid breaking
the plastic keycaps or the somewhat delicate switches
beneath them.

4. Let the keyboard dry for a half an hour or so.

drying process. Just keep the air stream moving,
and don’t get the nozzle too close to sensitive
plastic parts.

@ You can use a hairdryer on low heat to speed the

5. When the keyboard is nice and dry, reattach it to your
computer.

is on. If your mouse is an older model with a PS/2

@ You can plug in a USB keyboard while the computer
connector, reattach it before you turn on the power.

Diagnose a Troubled Keyboard

1. If the keyboard completely stops responding, check to see
whether the device is connected properly at the computer
end, and look for any cuts or crimps in the cable. Fix any
loose connections and straighten any kinks; if the cable is
cut, replace it.

225



Part lll: Fixing Sick Hardware

226

2. If the connections and cable are fine, try rebooting the
computer to see whether the keyboard comes back to life.
With luck, you were experiencing a once-in-a-blue-moon
system lockup.

If the keyboard freezes more frequently than a blue
moon, or if the intervals between freeze-ups begin to
shorten, you may be seeing early symptoms of the
impending failure of a major component, such as the
motherboard or the power supply. Run a diagnostic
program such as the one that ships with many com-
puters, or take the computer to a repair shop for a
good once-over.

3. Check the connection between the PC and the keyboard,
as well as the status of the keyboard’s device driver, as
follows:

a.

Choose Start=>Control Panel=>Keyboard (XP) to open
the Keyboard Properties dialog box. In Windows 7
and Vista this direct path is available from the icon
view of the control panel.

. Click the Hardware tab. You should see the name or

type of keyboard (listed in the Devices list), as well as
the manufacturer and the means of communicating
with the system.

. Check the Device Status entry to see whether the com-

puter is communicating with the keyboard properly
(see Figure 13-3).

. Click the Properties button to display another

Properties dialog box; then click the Driver tab to
examine the details of the driver and make any
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necessary changes or updates. (For details, see “Revive

a Dead Mouse, Trackball, or Keyboard,” later in this
chapter.)

You rarely have to make driver changes for a basic
component such as a keyboard unless there’s been

some sort of electrical corruption of the device or the
driver has been deleted or changed.

Click for error messages in
the Device Properties section.

<~ Keyboard Properties ==l

Devices:

Name

Type

Device Properties

Manufacturer: (Standard keyboards)
Location: plugged into keyboard port

Device Status: This device is working properly.

[ ok [ ceneet |

Figure 13-3

e. While you're in the neighborhood, you can close the
second Properties dialog box and click the Speed tab
of the Keyboard Properties dialog box (see Figure
13-4) to make a few adjustments in the response of
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the keyboard, such as the repeat rate (how quickly the
keyboard produces a string of repeated characters
when a key is held down).

These settings tell your keyboard
how quickly to respond.

~- Keyboard Properties
| Spesd [ Hardware |
Character repeat

i Repeat delay:

Long Iy gShort—|
Repeat rate; J
Slow |_J Fast

Click here and hold down a key to test repeat rate:

Cursor blink rate

| None [ J Fast

Figure 13-4

This function really isn’t related to the keyboard, but

@ You can also set the cursor’s blink rate in this tab.
technicians had to put the control somewhere.

f. Click OK to save your settings and close the dialog
box.

4. Every few months (to be especially conscientious), run
the keyboard test that’s part of most diagnostic programs
to test the electronic logic of the keyboard and the moth-
erboard’s keyboard controller. The test also forces you to
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run through all the keys on the board, including a few
that you may not ordinarily use. Follow any instructions
that the program gives you.

®

If you're still having problems, turn to “Revive a
Dead Mouse, Trackball, or Keyboard,” later in this
chapter.

Practice Good Mousekeeping

®

[T 2

1

Much of what I say about mice in this chapter also
applies to trackballs and other pointing devices (see
Chapter 1). Also, except where I indicate otherwise,
these tips apply to both mechanical and optical mice.

Keep your desktop clean. Your mouse travels miles
and miles, sliding back and forth on your desktop.
Along the way, it picks up dust, pollen, oils, cookie
crumbs, and whatever else is floating around your
office. Sooner or later, the going is going to get a bit
sticky. To give your mouse a clear path, wipe off your
desktop — and your mouse pad, if you use one —
once a month or more often if you notice any kind
of buildup on your mouse pad.

Give your mouse a bath. If your mouse seems to
have lost its way, the first thing to do is give it a
good cleaning, like so:

¢ Mechanical mouse: Unplug the mouse from the

computer, turn it over, and (on most mice) rotate
the plastic or rubber ring to release the rubber
roller ball (see Figure 13-5). Use a can of com-
pressed air or the crevice-tool attachment of a
vacuum cleaner to remove debris from the cavity.
Then clean the ball (and rollers, if any) with mild
soap and water or alcohol, using a lint-free cloth.
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Twist this ring to free the roller ball.
Figure 13-5

e Trackball: A trackball is essentially an upside-
down mechanical mouse with its roller ball built
into a mouse body or even into a keyboard (see
Figure 13-6). The ball rests loosely in a cavity,
where sensors track horizontal and vertical move-
ment. Instead of moving the hardware across the
desk, you use your hand to spin the ball in place.
You clean a trackball the same way that you clean
a mechanical mouse. (See the manual for direc-
tions on how to remove the roller ball on your
particular model.)
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Spin this ball to move the mouse pointer.

g ot
- ‘\‘i‘“\' *
2 o o oo

Figure 13-6

You should clean a mechanical mouse or trackball

@ every few months, whether or not you think it needs
cleaning. Check the manual that came with your
mouse for any specific instructions.

e Optical mouse: Cleaning an optical mouse is sim-
ple because it contains no moving parts. Use an
alcohol cleaner or a small spray of window cleaner
on a rag to remove any buildup from the sensor
on its bottom.
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Vet Vour Mouse

1. If your mouse or other pointing device is acting peculiar,
first make sure that it's connected to the computer prop-
erly. Fix any loose connections, and adjust or replace any
twisted or damaged cable.

2. If the connection is fine, choose Startt®Control Panel>
Mouse (in Classic View in Vista and Windows 7) to open
the Mouse Properties dialog box. Click the Hardware tab
and then click Properties (see Figure 13-7) to see whether
Windows is reporting a failure of a USB port (or a PS/2
serial port, if you have an older mouse that uses that type
of port, such as the one shown in Figure 13-8).

Check location and device status.

Synaptics PS/2 Port TouchPad Properties [F ==

| General | Diver | Details | Resources |

? Synaptics PS/2 Port TouchPad

Device type: Mice and other pointing devices
Manufacturer:; Synaptics

Location: plugged into P5/2 mouse port

Device status

b This device is working propery.

OK | I Cancel

Figure 13-7
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PS/2 serial port connection for older mouse

Figure 13-8

3. If you see no report of a problem with a port, click the
Driver tab of this dialog box to check for conflicts or
problems with device drivers (see “Revive a Dead Mouse,
Trackball, or Keyboard,” later in this chapter).

to see whether updated or corrected device drivers

@ You should also consult the manufacturer’'s Web site
have been released for your mouse.
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4. To adjust the ways in which your mouse responds, click
the other tabs of the Mouse Properties dialog box (such
as the Buttons tab, shown in Figure 13-9), and make any
changes you want. Each manufacturer offers different
types of adjustments for its mouse device, so the tabs in
your dialog box may differ from those in the figure.

lMouse Properties 23

Buttons | Pairters || Peinter Options || Hardware | TouchPad On/Off |

Button configuration
[ Switch primary and secondary buttons

Select this check box to make the button on the
right the one you use for primary functions such
as selecting and dragging.

Doubleclick speed

Double-click the folder to test your setting. ff the
Folder does not open or close, try using a slower
setting.

Speed:  Slow -] Fast D

ClicklLock
[ Tum on Click Lock

Enables you to highlight or drafp without holding down the mouse
button. To set, briefly press thg mouse button. To release, click the
mouse button again.

[ QK H Cancsl ]

Move this slider to adjust click speed
Figure 13-9

5. Click OK to save your changes and close the dialog box.

6. If your mouse or trackball came with a control program
for setting up special features, the same program usually
offers basic test software. Run this software to see how
your mouse is performing, and follow any onscreen
instructions.

If you're still having problems, read on; the next sec-
tion of this chapter may help.
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Revive a Dead Mouse, Trackball, or Keyboard

1. If your mouse, trackball, or keyboard isn't functioning at
all, restart the computer in safe mode (see Chapter 17).

somehow disabled the keyboard or pointing device
and can't use either to get where you need to go to
set matters right.

@ Restarting in safe mode is also the thing to do if you

2. Working in safe mode, you should be able to repair or rest
the device's driver in Device Manager (see Chapter 18).

3. If the hardware itself has failed — which eventually will
be the case with mechanical devices like these — the
solution is to unplug the old and plug in the new, as |
describe in the next section.

beyond repair, you can try a radical approach: Put it
in the dishwasher. Although no hardware manufac-
turer officially sanctions this sort of repair, people do
it, and I've done it myself. Use a gentle cycle, cool
dry, with little or no soap, and let the device dry out
for a week or so before you plug it in again. You have
nothing to lose, and this method does work
sometimes.

@ If you've decided that your keyboard or mouse is

Replace a Dead Mouse, Trackball, or Keyboard
1. Remove the deceased device from your computer.

e USB devices: You can leave the computer on while
you disconnect (see Figure 13-10).

e PS/2 devices: Turn the computer off before you
disconnect.
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You can attach and detach a USB keyboard while your PC is running.
Figure 13-10

2. Plug in the replacement keyboard or pointing device.
3. If you turned the computer off in Step 1, turn it back on.

4. Follow all instructions from the maker of the replace-
ment device to install the new device’s driver or utility

program.

mouse or trackball and keyboard on hand. Like hard
drives and other mechanical elements of a PC, these
devices are bound to fail sooner or later. Keeping
replacements in your supply closet (they won't go
stale) can save you time and aggravation.

@ I recommend that you always have a replacement
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Repairing,
Refreshing, and
Reinstalling
Windows

W hen you buy a new PC from a retailer or
directly from a manufacturer, it ordinar-

ily comes with Windows already installed. It's
almost always better — both financially and
technically — to get Windows this way. The
maker of the computer should have installed
all the necessary drivers and made any neces-
sary tweaks in settings to match the particular
combination of hardware in the box.

In four situations, however, you may need to
install or reinstall Windows yourself:

m= Adding a new hard disk drive to replace
the original boot drive (see Chapter 11)

w= Repairing an existing installation of
Windows

w= Reinstalling the existing operating system

to fix otherwise-irreparable damage

w= Upgrading Windows from one version to

another

| “*apter

Getready to. ..

w= Repair a Windows XP
Installation...........ccceveen.

w= Repair a Vista or
Windows 7 Installation......

w= Refresh Windows..............

w= Know When to Reinstall

Windows ......oovvvveeeeeain.,

w= Reinstall Windows ............
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In this chapter, I show you how to repair and replace Windows on

your PC.

Be sure to keep the alphanumeric product key that
came with your Windows installation disc. You can’t
install Windows properly without this key.

Repair a Windows XP Installation

240

1.

6.

Choose Start>Turn Off Computer=>Restart to restart your
computer, and watch the screen carefully. You should see
a message to press a function key (F2 probably) or
another key combination to enter the BIOS (Basic Input
Output System) screen. See the manufacturer’s documen-
tation for more information on your particular computer.

Press the designated key or key combination. You have
only a few seconds to press this key to interrupt the
startup process and enter the BIOS screen.

Look for an option called First Boot Device, Boot
Sequence, or something similar. (You may have to select
Advanced Options or another submenu to find it.) Press
the arrow keys on your keyboard to select this field; then
press Enter.

In the resulting screen, select CDROM/DVD.

Press the Esc key until you return to the main BIOS
screen.

Follow the onscreen instructions to save your new set-
tings and exit BIOS setup. Your computer will restart
from the CD/DVD drive.
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7. Insert your Windows XP Setup CD into the drive.

pennies by not providing a copy of the Windows disc
with the systems they ship. If you didn't receive a
Windows disc with your computer, the maker may
have placed a recovery utility in a separate partition
on the computer’s original hard drive. Visit the man-
ufacturer’s Web site for advice on how to access that
hidden partition during startup.

The problem with this sort of hidden partition is that

@ Some computer manufacturers tried to save a few

it doesn’t allow you to install Windows on a replace-
ment hard disk drive. You'll have to purchase physi-
cal Windows discs from the computer maker or from
a computer store.

8. Restart your computer. A startup screen like the one
shown in Figure 14-1 appears. (Depending on the
Windows or setup discs you have for your computer, you
may see a slightly different menu.)

confirm that you want to start from the CD/DVD
drive. Follow the onscreen instructions (which usu-
ally are to press any key).

@ You may see an interim message that asks you to

9. Choose Install Windows XP.

10. In the next screen, if you're asked whether you want to
install Windows XP now, select that option. (Don't
choose the option to use the Recovery Console.)

1 1. In the next screen, press F8 to accept the Windows XP
licensing agreement.
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Choose Install Windows XP.

® Welcome 1o Microsoft Win lows XP

h Welcome to Microsoft Windows XP

}E:é What do you want to do?

3] Install Windows XP

(2] Learn more about the setup process
r—iﬂ| Install optional Windows components
(3] Perform additional tasks

(3] check system compatibility

X Exit

Figure 14-1

12. If you have multiple operating systems or multiple ver-
sions of Windows installed on your computer, the next
screen displays a list of those operating systems. Choose
the one you want to repair or reinstall. Figure 14-2
shows this screen for a PC with only one version of
Windows installed, which is the normal configuration.

1 3. Press the R key on your keyboard to repair the operating
system.

14. Follow the onscreen instructions.
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Select the operating system you want to reinstall or repair.

Windows AP Home Edition Setup

one of the following Windows XP installations is damaged,
;up can try to repair it.

se the UP and DOWN ARROW keys to select an installation.

pair the selected Windows XP installation.

esh copy of Windows KP

Flgure 14- 2 |

Repair a Vista or Windows 7 Installation

1. Choose Start=>Turn Off Computer=>Restart to restart your
computer, and watch the screen carefully. You should see
a message to press a function key (F2 probably) or
another key combination to enter the BIOS (Basic Input
Output System) screen. See the manufacturer’'s documen-
tation for more information on your particular computer.

2. Press the designated key or key combination. You have
only a few seconds to press this key to interrupt the
startup process and enter the BIOS screen.
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3. Look for an option called First Boot Device, Boot
Sequence, or something similar. (You may have to select
Advanced Options or another submenu to find it.) Press
the arrow keys on your keyboard to select this field; then
press Enter.

4. 1n the resulting screen, select CDROM/DVD.

5. Press the Esc key until you return to the main BIOS
screen.

6. Follow the onscreen instructions to save your new set-
tings and exit BIOS setup. Your computer will restart
from the CD/DVD drive.

7. Insert the Windows Vista or Windows 7 installation CD
into the drive.

®

Some computer manufacturers tried to save a few
pennies by not providing a copy of the Windows disc
with the systems they ship. If you didn't receive a
Windows disc with your computer, the maker may
have placed a recovery utility in a separate partition
on the computer’s original hard drive. Read the
instruction manual for advice on how to access that
hidden partition during startup.

The problem with this sort of hidden partition is that
it doesn't allow you to install Windows on a replace-
ment hard disk drive. You'll have to purchase physical
Windows discs from the computer maker or from a
computer store.

8. Restart your computer.

9. If you're prompted to do so, press any key to start the
Windows installation from the CD/DVD drive.



10. In the resulting screen, select language settings, and
click Next.

1 1. In the next screen, click Repair Your Computer.

12. In the next screen, select the operating system or version
of Windows that you want to repair, and click Next.

ery software on your hard drive, check the Web site
for directions on how to proceed. You may be asked
to press one of the function keys as the system
restarts to go to a hidden partition.

@ If the maker of your computer preinstalled the recov-

13. In the System Recovery Options window, select Startup
Repair (see Figure 14-3). The utility scans your installa-
tion of Windows to determine which files need to be
repaired or replaced.

14. Follow any onscreen instructions.

Select Startup Repair to begin the process.

P System Recovery Cptions x|

Choose a recoverjy tool
Operating system: Unknown on {Unknown) Local Disk

Automatically fix problems that are preventing Windows from starting

Restore Windows to an earlier pointin time

CompletePC Restore

=4

{ System Restore
1=

r‘
= Restore your computer from a CompletePC Backup image

E" Windows Memory Diagnostic Tool
L= Check your computer for memory hardware errors

=== Command Prompt
Open a command prompt window

Shut Down Restart

Figure 14-3

_ Chapter 14: Repairing, Refreshing, and Reinstalling Windows
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version of a file with an older version, click No. If the
installation process finds a newer version of a file on
your computer, it means that you've upgraded the
file from an online source; you should keep the
newer file.

@ If you're asked whether you want to replace a current

15. Wait to see what the utility reports:

e Successful repair: If the problem with your
Windows installation is relatively minor, Startup
Repair may be able to bring it back to health with-
out erasing your software and personal files.

e Failure to repair: If Startup Repair can’t cure your
PC's illness, it displays a report that provides some
details on the problem. Make full notes, and dis-
cuss the issue with the manufacturer’s support
department or a repair technician.

as a failing hard disk drive that corrupts files. (See
Chapter 11 for more info on hard drives.) Also, it
can’t remove all the tendrils of a virus. A capable
security software program should scrub away all
traces of viruses and other forms of malware (see
Chapter 6).

Refresh Windows

Another option is reinstalling Windows over the existing version —
a process called refreshing. Refreshing may fix a few problems that
repairing doesn’t, but it can’t fix viruses or conflicts between versions
of system files. The process I describe in this section applies to all
current versions of Windows, though the precise screens you see will
be a little different in each Windows version. To do a refresh, follow
these steps:

@ Startup Repair can’t correct hardware failures, such
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1. Start your computer from the CD/DVD drive, as
described in Steps 1-6 of the preceding two sections.

2. Insert your Windows installation disc into the drive.

3. Restart your computer. You see a screen similar to the
one shown in Figure 14-4.

4. Select the Install Now option.

Don'’t choose an option to change partitions or refor-
mat the drive. Either option would erase all your
software and personal data.

5. Follow the onscreen instructions.

Choose Install Now.

% Install Windows

»

Windows Vista:

Install now ‘&

What to know before installing Windows

Repair your computer

> 2006 Microsoft Corporation. All ights reserved

igure 14-4
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Know When to Reinstall Windows

If repair attempts fail (see “Repair a Windows XP Installation” or
“Repair a Vista or Windows 7 Installation,” earlier in this chapter), and
if refreshing doesn’t have the desired effect (see “Refresh Windows,”
earlier in this chapter), reinstalling Windows should fix almost any
problem. Reinstallation works best if:

w= The manufacturer supplied a restore disk with
the computer. That disk returns a PC to its original
factory-delivered state. If you don’t have a restore
disk, you have to perform an ordinary installation
from the original Windows discs.

You may be able to fix things with System Restore
(see Figure 14-5). This process returns your system
to an earlier state — before you installed updates

or third-party software — but doesn’t affect your
data files.

w= Your computer is able to start, and you can get to the
operating system.

w= You can make backup copies of all your personal
data. The easiest way to do this is to plug in an exter-
nal hard disk drive (see Chapter 11) and copy the
files from your computer to the external drive. You
can also make backups on a DVD (about 4.7GB of
data) or on a CD (about 700MB of data) if your
computer is capable of burning discs and if the
CD/DVD drive is functioning.

The bad news? A complete reinstallation wipes the
hard drive clean, removing all software and all your
personal files. Also, reinstalling Windows won't

fix any problems with misbehaving hardware or
incompatible devices that you added on your own.
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(You may be able to obtain assistance from the mak-
ers of those pieces of hardware, including updated
device drivers and other adaptations that make the
products work better with Windows.)

Select Recommended Restore, and click Next.

i System Restore ==

Restore system files and settings

System Restore can help fix problems that might be making your
computer run slowly or stop responding.

System Restore does not affect any of your documents, pictures, or
other personal data, and the process is reversible. How does System
Restore work?

—=0) Recommended restore:

Select this option to unde the most recent update, driver,
or software installation if you think it is causing problems.

7/6/2009 5:44:22 PM Install: Windows Update
Current time zone: Eastern Daylight Time
Choose a different restore point

To create a restore point, open System Protection.

Next > | | Cancel

Figure 14-5

Reinstall Windows

1. Make copies of all the personal files on your computer:
word processing, spreadsheet, database, photos, videos,
music, and so on. You don’t need to make backup copies
of your software programs; you'll need to reinstall those
programs anyway when Windows is back in place.

2. Start your computer from the CD/DVD drive, as
described in Steps 1-6 of “Repair a Windows XP
Installation” or “Repair a Vista or Windows 7
Installation” earlier in this chapter.
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3. Insert your Windows installation CD into the drive.
4. Restart your computer.

Windows XP, Vista, and Windows 7 present slightly

@ different startup screens. I describe the Windows 7
procedure in the following steps, but the procedures
in Windows XP and Vista are similar. The object is to
get through the opening screens to the custom install
screen, where you can reformat your hard drive and
begin a clean installation.

5. In the startup screen, select the Install Now option.

6. In the next screen, select I Accept the License Terms, and
click the Next button.

7. When you're asked what kind of installation you want to
do, select Custom (Advanced).

8. If you're given a choice of partitions, select the one in
which you want to install Windows. In most cases, you
have only one or two choices: maybe a small partition
(200MB or so) and a large one (30GB-100GB or larger).
Select the larger partition for your Windows installation.

9. In the next screen, click Advanced to expand the options
at the bottom of the screen, and choose the option to
reformat your drive.

10. Follow the onscreen instructions to reformat your drive
and install Windows.

1 1. When you're prompted to do so, enter the Windows
product key (see the example in Figure 14-6). This
key — a set of 25 letters and numbers — may be on
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the Windows CD/DVD case or on a separate sheet of
paper that came with the software. Some manufacturers

also place a copy of the key on a sticker affixed to the
computer case.

Windows XP Professional Setup i

Your Product Key
Wour Product Key uriguely identifies your copy of Windows XP.

" O PROOUCT KEY: " The 25-character Product Key appears on the yellow sticker
| DTS o6 the hack of your Windows CD folder.

Type the Praduct Key below:

FProduct Key:
AdAARA - 12345 S LY - 12345 B LT

Windows product key
Figure 14-6

12. Follow the onscreen instructions to complete the job.
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Checking and
Changing System
Configuration

ou and [ are sentient beings. We can

perceive our world. PCs, however, know
nothing. All they can do is move around
numbers that humans have placed in their
nonliving memory.

But every computer has a feature that gives it a
personality of sorts, as well as information
about its parts and capabilities. This feature
falls under the general category of system con-
figuration or system setup.

Part of this setup or configuration information
is stored in a special part of the computer’s
memory where it won't get lost when the
power is turned off (the BIOS). Part of it is
stored on the system’s hard drive. This founda-
tional memory tells the computer about its
world — what disk drives are attached, what
other kinds of memory it has, and other details
involving all the hardware that makes up the
machine.

This information is stored when the computer
is built. Sometimes, it’s useful to look at this
data to reconfigure the PC or help identify
problems.

| “*apter
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System Setup Screens........ 254

= View System Configuration

in Windows XP................. 256
w= Select Diagnostic Startup

in Windows XP................. 258
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in Vista and Windows 7.... 260
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In this chapter, I show you how to use the System Configuration tool
to search for the sources of problems caused by corrupted, missing, or
misassigned programs and elements of Windows.

Very technical elements of system configuration, such

@ as setting BIOS (Basic Input and Output System) and
CMOS (Complimentary Metal Oxide Silicon, a type
of solid-state memory), are beyond the scope of this
book. You may want to leave this type of configura-
tion to an expert.

View and Document System Setup Screens

Here’s an example of the process for viewing system
setup information on a Dell Dimension PC. Your PC
may have a slightly different procedure.

1. Turn on or restart the computer, and watch the monitor
closely. When you see the blue Dell logo, the F2 prompt
should appear soon afterward (see Figure 15-1). This
prompt indicates that the BIOS has initialized the
keyboard — prepared it for first use.

F2 prompt

www.dell.com

Figure 15-1
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2. Immediately press the F2 key on your keyboard. After a
short pause, a system-setup screen should appear. Your
PC may display slightly different information from the
screen shown in Figure 15-2.

Navigation pane

GX620 I (e, de11. com)

System Info

Figure 15-2

If you press F2 too late, your PC will proceed to load
Windows. Don't turn it off; wait for Windows to
load, restart your computer, and try again.

3. Select options in the navigation pane by using the arrow
keys on your keyboard to scroll up and down through
the navigation pane. (You need to use the arrow keys
because your mouse or other pointing device probably
won't be working this early in the startup process.) As
you select each option, the screen displays details on cur-
rent and available settings.

pressing the Enter key or arrow keys expands or
collapses a list of available options. The onscreen
display should tell you how to navigate the list.

@ Depending on the design of your PC's setup screen,
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4. Write down all the settings you see in each screen.

images of setup screens. If you go this route, make
sure that you can read all the information in the
images.

@ Some people use a digital camera to take close-up

5. Consult the instruction manual or online support pages
for your computer model to find a list of your computer’s
standard (default) settings, and identify the process for
restoring all the settings to their original default condi-
tion. You may not want or need to use this emergency
parachute, but someday, it may be the way to get out of
an otherwise-unresolvable technical bind.

handwritten notes or digital photographs — with the
rest of your computer documentation so that it’s
available if you need it later to solve a configuration
problem.

@ Store all the information you've gathered — including

6. Press the Esc key one or more times until you see a
prompt that asks whether you want to exit this utility
or save the data and exit. You should not have changed
anything during this inspection tour, so select the exit
option. Your system should resume the normal startup
process and return you to Windows.

View System Configuration in Windows XP
1. Choose Start=>Run to open the Run dialog box.

2. Type msconfig in the Open text box, and click OK. The
System Configuration Utility dialog box appears (see
Figure 15-3), displaying seven tabs:
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Tabs

# Systern Configuration Utility

eneral | SYSTEM.IMI | WIN.INI | BOOT.INI | Services | Startup | Tools
Startup Selection
%) Mormal Starkup - load all device drivers and services
() Diagnostic Startup - lnad hasic devices and services anly

() Selective Starkup

[ Launch System Restare ] [ Expand File... ]

I =

Figure 15-3

e General

SYSTEM.INI

WIN.INI

BOOT.INI

Services

Startup

Tools

Each of these tabs contains settings for various elements
of your PC. In the following steps, I cover the ones that
you may want to investigate.

It’s best to stay away from all the .INI tabs. You

can’t change much on those tabs to help solve
problems, and changing some settings could really
mess things up.
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3. Click the Services tab, which displays a long list of the
current software services running in Windows. Most of
these services won't mean a whole lot to you, but it's
interesting and surprising to see what's loaded on your
computer. If you're using this utility to solve a problem,
see “Select Diagnostic Startup,” later in this chapter.

4. Click the Startup tab, which lists the programs that
launch every time you start your machine. You'll recog-
nize some applications that you use regularly, such as
Microsoft Office or your antivirus program. The ones you
don't recognize are launchers or helpers for other hard-
ware and software that help improve performance or are
required for some operations.

5. Click the Tools tab, which lists the software tools you can
use to inspect or troubleshoot your system. (Interestingly,
Microsoft’s help-desk technicians may use the same tools
to help you uncover and repair a problem with your
computer.)

You can experiment with these tools, but use caution.
Tools such as Registry Editor can cause some serious
system ills if they're used incorrectly.

6. When you're ready to get on with other computer tasks,
click the OK button to close the System Configuration
Utility dialog box.

Select Diagnostic Startup in Windows XP

It certainly is interesting to poke around inside the
System Configuration Utility (see the preceding sec-
tion), but you also can use it as a serious diagnostic
tool.
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1. Choose Start=>Run to open the Run dialog box, type
msconfig in the Open text box, and click OK to open the
System Configuration Utility dialog box.

2. On the General tab, select Diagnostic Startup, and click
OK. The utility takes a few seconds to disable all but the
most essential startup programs and services.

3. When the Restart/Exit prompt appears, click Restart.

4. When the diagnostics notification appears, click OK.
Windows displays the System Configuration Utility
dialog box again.

5. Click the Startup tab, scan the list for a program that’s a
likely troublemaker, and check its check box.

You recognize a troublemaker through a process of
@ elimination and good guessing. Analyze the problem
that you're experiencing, and try to find an applica-
tion that may have something to do with it. I suggest
starting with anything that isn't a Microsoft product
and, therefore, may be incompatible with Windows.

6. Click OK to restart your computer in Selective Startup
mode.

7. If the problem recurs, proceed to Step 8. If the problem
doesn’t occur, repeat the steps until you locate the
offending application.

8. Reinstall the problem program or contact the software
manufacturer for help.

9. Follow the steps in the next section to return your system
to normal startup.
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Return to Normal Startup in Windows XP
1. Choose Start=>Run to open the Run dialog box.

2. Type msconfig in the Open text box, and click OK. The
System Configuration Utility dialog box opens.

3. On the General tab, select Normal Startup, and click OK.
Your computer restarts with all its programs enabled.

View System Configuration in Vista and Windows 7

1. Click the Start button and then click inside the Search
Programs and Files field (Start Search in Vista) at the bot-
tom of the screen. The msconfig program appears at the
top of the search box.

2. Click msconfig to display the System Configuration
dialog box. Vista displays a UserAccount Control notice.

3. Investigate the Services, Startup, and Tools tabs, which are
essentially the same as those in the System Configuration
Utility dialog box in Windows XP (see “View System
Configuration in Windows XP,” earlier in this chapter).

Missing from the System Configuration dialog box,
however, are the .INI tabs from Windows XP — which
is probably a good thing, because you shouldn’t change
those settings anyway.

4. Click the Boot tab to display the dialog box shown in
Figure 15-4.
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L3 System Conflguration [

| General | Book | Services | Startup | Toals |

Windows 7 (Ci\windows) : Current 0F; Default 05

Advanced options. .. Sek as default Delete

Timeout:
[§] 5afe boak [ Mo LI boat 30 seconds
@ Minimal [ Boot log
() Alkernate shell [ Base video
() Active Directory repair [T 05 boat information [7]Make all boot settings
: permansnt
() Mebwork,
I oK | | Cancel I I Apply | | Help

Select Safe Boot and then experiment with
different settings for troubleshooting.

Figure 15-4

5. Click the General tab, choose Diagnostic Startup, and
click OK to test your system with minimal applications
loaded (see “Select Diagnostic Startup in Windows XP,”
earlier in this chapter).

6. When your testing is complete, select Normal Startup on
the General tab, and click OK to return to normal startup
mode. Your computer restarts with all its applications
enabled.
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Restoring Your
Computer’s
Settings

If your PC ran fine yesterday (or just a few
minutes ago), but all of a sudden it won't
load Windows, ask yourself this essential ques-
tion: What has changed since the last time this
computer performed properly? Here are a few
possible answers:

2

1

[ 2

2

1=

=y

1=

You installed new software.
You uninstalled or deleted software.

Microsoft or another software company
delivered a major update to your
computer.

You installed new or updated device
drivers.

You recently changed the settings or con-
figuration of Windows.

You deleted or changed one of the system
files of Windows or another program.

The lights just dimmed or the power
went out, perhaps because of an electrical
storm.

| “*apter

16

Getready to. ..
w= Undo Something You

Just Did e 264
w= Uninstall a Problematic
Program........ccccooeveiienis, 264

w=» Choose the Right Utility
to Solve Your Problem ....... 267

= Reset Your PC with System
Restore .......cccovevvieenncenn. 267

w= Create a Restore Point
Manually in Windows XP... 275

w= Create a Restore Point
Manually in Vista.............. 275

w= Create a Restore Point
Manually in Windows 7 ... 275

w= Revert to the Last Known
Good Configuration.......... 276
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Any of these events could result in unexpected, unwanted changes in
critical files on your computer. Fortunately, you may be able to turn
back the clock to resolve problems. I show you how in this chapter.

PC, or if an existing piece of hardware has failed, you
should start by troubleshooting the equipment, not
the software.

Undo Something You Just Did

1. Start Windows in safe mode. This mode loads only the
most basic functionality for things like the keyboard and
mouse, and displays a different screen from what you're
used to seeing. Figure 16-1 provides additional informa-
tion. For details, see Chapter 17.

@ If you recently installed new hardware inside your

2. When you have Windows running in this limited mode,
undo the changes you just made.

3. Restart the computer.

Uninstall a Problematic Program
1. Follow the appropriate step for your version of Windows:

¢ Windows XP: Choose Start=>Control Panel to
open the Control Panel window; then double-click
the Add or Remove Programs icon to open the
Add or Remove Programs window.

¢ Vista and Windows 7: Choose Startz>Control
Panel to open the Control Panel window. Then (in
Classic View) select Programs and Features or (in
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Category View) select Uninstall a Program in the
Programs category. Either action opens the
Uninstall or Change a Program window.

Use Windows Help at any time to learn more about Windows topics.

SafTede Microsoft (R) Windows (R) (Build 6002: Service Pack 2) Safe Mode|
- A

Recycle Bin 1609 _theforg...

.Q.Windows Help and Support _|o| x|
P = W g3 s« options ~

. . | ch Help b

PowerPoint Fix PC for . > =1
Presentations Seniors f... What is safe mode?

Safe mode is a troubleshooting option for Wi NS starts your computer in a limited

state, Only the basic files and dr e started. The words "Safe

Meode" appear in the corners of the display to identify which Windows mode you are using.
If an existing problem does not reappear when you start in safe mode, you can eliminate the
default settings and basic device drivers as possible causes.

Manials autasync 1049 If you don't know the cause of the problem, you can use the process of elimination to help

you find the problem. Try starting all of the programs you commonly use, including the
programs in your Startup folder, one by one, to see if a program might be the cause of the
problem.

‘ If your computer automatically starts in safe mode without prompting, a problem with your
| computer might be preventing Windows from starting normally, I you think the cause of
the problem might be a recently installed program or device, try using System Restore, For
more information, see What is System Restore?

Video Captures JULDS Backups

See also

# Advanced startup options {including safe made)]
Start your computer in safe mode

-

# Diagnaostictools to use in safe made 1
Slideshows #» Trouble oting problems while in safe mode

#* ‘Which drivers get loaded in safe mode? ﬂ

% Ask someone or expand your search
Safe Mode

:'Starl| Quicklaunch @ e @ 5 @ J il B =2 & @ Windows ... |Desktop [ &y 4:16 PM

Figure 16-1
2. Select the program that you want to remove.

If you're not certain that this program is causing the
problem, you could try the repair option in Windows
7 first. If that doesn’t work, proceed with the
uninstallation.
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266

3. Click the button titled something like Change/Remove,
Uninstall/Change, or Uninstall. The name of this button
or option may differ from program to program. Some
programs provide a Change button that opens a separate
utility in which you can modify or remove the program;
others offer a Remove button that does just that. Still
other programs have a single button called Change/
Remove that offers a more complex set of options. Figure
16-2 shows one program’s response after the Uninstall/
Change button is clicked.

Uninstall Driver for Samsung Mobile phone

Ready ta uninstall 5amsung Mobile phone driver Software

Urinstall | Cancel |

Click Uninstall to start the process.

Figure 16-2

4. Follow the onscreen instructions to remove the program.
When the selected program is removed, you should see a
confirmation dialog box like the one shown in Figure 16-3.

Click OK to close the confirmation dialog box.

Uninstall Driver for Samsung Mobile phone

[ . , Samsung Mobile phone driver Software was removed
" successfully

o

Figure 16-3

Also see Chapter 4 for more information on trouble-
shooting and uninstalling misbehaving software.
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Choose the Right Utility to Solve Vour Problem

When all else fails, the next step is restoring earlier settings on your
computer. Windows has two built-in utilities for this purpose: System
Restore and Last Known Good Configuration. I cover both later in this
chapter. To decide which to use, consider the primary differences:

w= System Restore can be used only on a PC that can
start in Windows in either normal or safe mode (see
Chapter 17).

m= [ ast Known Good Configuration can be invoked
during the startup process and may be able to bring
to life a PC that otherwise can’t load Windows.

w= You can undo changes made with System Restore by
repeating the process, going back to the settings that
were in effect before the restore, or trying a different
date in the hope of getting a different result.

m= Changes made through Last Known Good
Configuration are permanent and cannot be undone.

restore only system settings; they don't affect data
files, e-mail, or applications. Also, neither utility
repairs or replaces a deleted or corrupted driver or
program. To make that sort of fix, you need to rein-
stall the driver or program from the original source
or from an online source.

@ System Restore and Last Known Good Configuration

Reset Vour PC with System Restore

System Restore, featured in all current version of Windows, is a com-
puter version of a time warp, allowing you to go back from the future
to a specific restore point — a group of settings that were in effect last
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night, last week, or at some other time. By default, it creates restore
points automatically every day, but you can also create them at any
time (see the “Create a Restore Point Manually” section for your ver-
sion of Windows, later in this chapter). System Restore is most likely
to work if you use it immediately after you notice problems.

You can use System Restore to reset your computer
only if you've previously turned this feature on.

There’s really no reason not to use it, because it's

enabled as part of a standard Windows installation.

1. Save any open files on your computer, and close all
programs.

2. Make sure that you have current backups of essential
data files.

3. Launch System Restore in any of the following ways:

e Windows XP, Vista, and Windows 7: Choose
Start>All Programs=>Accessoriest System Toolsw>
System Restore.

e Vista only: Click the Start button, type system
restore in the Search box, and then click the
utility’s name in the search results.

e Windows 7 only: Click the Start button, type
system restore in the Search box, and then click
Restore Your Computer to an Earlier Time.

The resulting window asks whether you want to create a
restore point (set one manually) or choose a previously
recorded restore point. Figure 16-4 shows this window in
Windows XP; the Vista and Windows 7 windows are
slightly different.
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Choose this option in Windows XP.

'“® System Restore

Welcome to System Restore

‘fou can use System Restore to undo harmful changes to
your computer and restore its settings and performance.
System Restore returns your computer to an earlier time
(called & restore point) without causing you to lose recent
work, such as saved documents, e-mail, or history and lier fime |
s v S O . o ocf s s

To begin, select the task that you want to perform:

O Create a restore point
Any changes that System Restore makes to your computer

are completely reversible,

‘four computer automatically creates restore points {called
system checkpoints), but you can also use System Restore
to create your own restore points. This is useful if you are
about to make a major change to your system, such as
installing a new program or changing your registry.

System Restore Settings

To continue, select an option, and then dick Next. Mext = ] [ Cancel ]

Figure 16-4
4. Follow the appropriate step for your version of Windows:

e Windows XP: Select Restore My Computer to an
Earlier Time, and click the Next button.

e Vista: Select Recommended Restore or Choose a
Different Restore Point (see Figure 16-5), and click
the Next button.

e Windows 7: Select Open System Restore, and click
the Next button.
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Choose one of these options in Vista.

i System Restord ==

Restore system files and settings

W +1] ) y

/ System Restore can help fix problems that might be making your
computer run slowly or stop responding.
T—

— % System Restore does not affect any of your documents, pictures, or
other personal data, and the process is reversible, How does System
Restore work?

@ Recommended restore:

Select this option to undo the most recent update, driver,
or software installation if you think it is causing problems.

5/13/2009 8:18:51 PM Install: Windows Update
Current time zone: Eastern Daylight Time
_) Choose a different restore point

To create a restore point, open System Protection.

Mext = ]| Cancel

Figure 16-5

5. In the next window, select a restore point (preferably
one just before the day and time when you began
experiencing problems). Figure 16-6 shows this window
in Windows XP; Figure 16-7 shows the Vista version
of the window; and Figure 16-8 shows the Windows 7
version.
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Select a date in this calendar in Windows XP.

B System Restore ﬁ

Select a Restore Point

The following calendar displays in bold all of the dates that have restore points available, The list displays the
restore points that are avalable for the selected date.

Possible types of restore points are: system checkpoints {scheduled restore points created by your computer),
manual restare points {restore points created by you), and installation restore points {automatic restore points
created when certain programs are installed),

1. On this calendar, click a bold date. 2. On this list, click a restore point.

Sun |Mon | Tue (Wed| Thu | Fri

29 300 3 1 2] 3

[ < Back ][ Mext = ][ Cancel ]

Figure 16-6
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Choose a restore point in Vista.

e System Restore ==

Choose a restore point s
v ;
System Restore will not change or delete any of your documents and the process is reversible. ! il

Click the restore point that you want to use and then dick Next. How do I choose & restore point?

Current time zone: Eastern Daylight Time

Date and 'I'|me. Description

7/13/2009 9:59:26 AM Install: Windows Update
/112009 8:59:56 AM System: Scheduled Checkpoint
7/9/2009 2:33:09 PM Install: Windows Update
7/3/2009 2:27:42PM Install: Windows Update
F(F(2009 7:52:46 AM System: Scheduled Checkpoint

[¥] Show restore points older than 5 days

Figure 16-7

Choose a restore point in Windows 7.

i System Restofe e
Restore your cgmputer to the state it was in before the selected event ﬁ |
I /

How do I choose § restore point?

Current time zonef Eastern Davlight: Time

Date and Time Description Tvpe

[] show more restare points l Scan for affected programs ]

< Back ” Mext = l[ Cancel |

Figure 16-8
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Don't go too far back in time. Going farther back
than necessary could disable good updates and

changes that you made before the problem started.

Try using restore points created just before problems

started. If the first restore doesn’t work, go farther
back.

6. Click the Next button. The computer chugs along for a
few moments, preparing the information it needs, and
then restarts.

7. When your PC restarts, follow the appropriate step:

e Successful restoration: If the restoration is suc-
cessful, you see a screen like the one shown in
Figure 16-9 when Windows loads. Click the Finish
button to close System Restore.

i System Restore ==
Confirm your resfore point
,(: i ] Time: 7/13/2009 9:53: 26 AM (Eastern Daylight Time)
L" { Description: Install: Windows Update
A

System Restore will restart your computer to apply these changes. Before
you proceed, save any open files and dose all programs.

| < Badk |[ Finjsh ] | Cancel |

Click Finish after a successful restoration

Figure 16-9
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¢ Failed restoration: If the restoration fails, your
computer restarts in the same condition it was in
before you attempted to fix it. Repeat Steps 3-6
with a different restore point.

To undo restoration changes, open System Restore;
select the Undo System Restore radio button (see
Figure 16-10); and click Next. You won't see the
option to undo a system restore until you've done
a system restore.

Choose Undo System Restore, and click Next.

i’ System Restore [

Restore system files and settings

System Restore can help fix problems that might be making wour
computer run slowly or stop responding.,

Swskern Restore does not affect any of vour documents, pictures, or
other personal data. Recently installed programs and drivers might: be
uninstalled. Is this process reversible?

e Uil Stystem Restore:

Select this option ta undo the System Restore done at
the kime listed, if you think it didn't Fix problems or caused
more problems.

Time: 8fS/2009 11:05:52 AM
Description: Undo: Restore Operation
Current time zone: Eastern Dawlight Time

Scan for affected programs

Choose a different restore point

= Back Mext = | | Cancel

Figure 16-10

As a safeguard against future problems, I recommend
that you create a restore point manually before you
add a program or change a major setting. The follow-
ing sections show you how.
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Create a Restore Point Manually in Windows XP

1. Choose Start=>All Programs=>Accessoriese>System Tools=>
System Restore. The Welcome to System Restore window
opens (refer to Figure 16-4 earlier in this chapter).

2. Select the Create a Restore Point radio button, and click
the Next button.

3. Follow the onscreen instructions.

Create a Restore Point Manually in Vista

1. Choose Start=>All Programs=>Accessories=>System
Tools=>System Restore.

or

Click the Start button, type system restore in the Search
box, and then click the utility’s name in the search
results. (Vista shows a User Account Control window.)

Whichever method you use, the System Restore window
opens.

2. Click the Open System Protection link, and click Create
in the System Properties window.

3. Follow the onscreen instructions.

Create a Restore Point Manually in Windows 7

1. Choose Start=>Control Panel=>System, and click Change
Settings to open the System Properties dialog box.
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2. On the System Protection tab, click the Create button
(see Figure 16-11).

System Propertles =5

“ Use spstem protection bo undo uny
| restore previous versions of files. ¥

System Restore

You can undo system changes by reverting
your computer bo a previous restore point. System Restore.. I
Protection Settings

Available Drives Pratection

£, Local Disk ] [System) On

Configure restore gettings, manage disk zpace, | Canfigure:
and delete restore points.

Create a restore point right now for the diives that |
hawe zystemn pratection turned on.

Create... i

QK H Carcel ] Apply

Click Create.
Figure 16-11

Windows automatically adds the date and time, and you
can include a short note, such as Before changing mouse
device driver.

Revert to the Last Known Good Configuration

Last Known Good Configuration restores the settings that were in
effect the last time the computer started successfully. It's not quite the
same as System Restore (see “Reset Your PC with System Restore,” ear-
lier in this chapter), which you can invoke days or weeks later to reset
a computer to an earlier configuration.

276



Chapter 16: Restoring Your Computer’s Settings

This tool should be your first line of defense if you
just installed a new piece of hardware or software
and find that the computer won't restart properly.

1. Remove any discs from the CD and/or DVD drives that
may be part of your system.

2. Restart your computer.

3. As the computer comes to life — and before the
Windows logo appears — repeatedly press and release
the F8 function key. In a moment, the somewhat-scary
Last Known Good Configuration screen should appear
(see Figure 16-12).

If the Windows logo appears instead, you've missed
your moment. Wait until Windows has loaded fully;
then shut down and restart to try again.

Press the arrow keys in your keyboard to select this option.
Figure 16-12
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4. At this stage of the process, your mouse won't work, so
use the arrow keys to highlight Last Known Good
Configuration; then press the Enter key.

5. If you have more than one version of Windows installed
on your PC, you see options for each version; choose the
version that you want to restart. After you make your
selection, your PC restarts in the selected version of
Windows.

6. Inspect Windows applications, and test whatever caused
you to choose this option in the first place to see whether
you corrected the problem.
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Working in Safe
Mode

a

S

fe mode is like putting your car up on a lift
at the garage. When you run a computer in

this mode, you can start it, test most of its sys-
tems, and change certain settings, but you're not
going to get much use out of it until you bring it
back down to Earth . . . and normal operations.

Safe mode is an excellent way to determine the
source of problems:

[ 2

1=

2

If you can start your PC in safe mode, its
basic hardware probably isn’t the cause
of your problem. Instead, the problem
may involve settings or configurations
that you recently made (see Chapter 4
and the chapters in Part IV), new devices
that you recently added (see Part III), an
electrical problem (see Chapter 9), or
malware (see Chapter 6).

If you can’t start your PC in safe mode,
you have a problem with basic hardware
(see Part III) or the basic elements of
Windows (see Part IV).

If your PC starts in safe mode all by
itself, some component is preventing
normal startup. For help, see the “Test
Components and Settings in Safe Mode”
section of this chapter.

| “*apter

1/

Getready to. ..

w= Start Your Computer in
Safe Mode..........cceeee.e. 280

w= Make the Monitor Easier
to Read in Safe Mode ....... 283

w= Use Safe Mode Tools ........ 284

w= Test New Hardware in

Safe Mode......coooe 287
w= Test Settings in Safe

Mode ..o 288
w= Choose Advanced Safe

Mode Options................... 289
w= Exit Safe Mode................. 292



Part IV: Resetting the Operating System

In this chapter, I show you how to use safe mode to diagnose — and
often fix — your computer’s problems.

Start Your Computer in Safe Mode

1. Remove any discs from the CD/DVD drive, if your PC
has one.

2. Shut down your computer in one of the following ways:

e [f you can see enough of the screen to follow the
standard Windows shutdown procedure, do that.

e If you can’t do a normal shutdown, press the
Ctrl+Alt+Del key combination and then release the
keys. (Whether you can see it or not, you're dis-
playing Windows Task Manager.) Next, press and
release the Alt key; press the U key to select the
Shut Down menu; and press the U key to turn off
the computer. (This works in XP, but not in Vista
or Windows 7.)

3. Wait a few moments to allow the computer to shut off
fully; then restart. The computer begins processing its
self-test, and you should be able to see messages on the
screen, including advice on alternative ways to start the
computer. When the self-test is complete, the computer
pauses briefly before it begins to load Windows.

4. During this pause, repeatedly press and release the F8
function key on the keyboard. Keep doing so until the
Windows Advanced Options Menu screen appears (see
Figure 17-1).
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Select the Safe Mode option.

Figure 17-1

If you begin tapping the F8 key too soon, you'll see a
“keyboard error” message; restart the computer and

try again. If you begin tapping too late, the computer
will go on to load Windows, and you have to repeat
the shutdown/startup process.

5. If you have more than one version of Windows installed
on your computer, use the arrow keys to select the ver-
sion you want to start in safe mode, and then press F8;
otherwise, go on to Step 6.

6. Press the arrow keys on the keyboard to highlight the
Safe Mode option, and press Enter. The computer starts
loading Windows in safe mode.

When Windows is fully loaded in safe mode, you see a
basic screen like the one shown in Figure 17-2 — probably
using a smaller number of colors than you're used to see-
ing, as well as lower resolution, and displaying the words
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282

Safe Mode in the corners. (To make the display more
legible, see “Make the Monitor Easier to Read in Safe
Mode,” later in this chapter.)

Safe Modeg'

S 850009

Note the “Safe Mode” flags in the screen corners.
Figure 17-2

The Safe Mode option starts Windows in a basic, lim-
ited mode. As you operate in this mode, you'll dis-

cover things that you can’t do. You can select a more
advanced option to perform additional troubleshoot-
ing, as I discuss in “Choose Advanced Safe Mode
Options,” later in this chapter.
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Make the Monitor Easier to Read in Safe Mode

By default, safe mode uses a screen resolution of
800 x 600 pixels, but you can increase resolution to

fit more on the screen and to produce a clearer
display.

1. To change the monitor settings to make the screen easier

to read in safe mode, follow the appropriate step for your
version of Windows:

e Windows XP: Choose Startz>Control Panel to
open the Control Panel window, and double-click

the Display icon to open the Display Properties
dialog box.

Alternatively, you can right-click the desktop and
choose Properties from the shortcut menu.

e Vista: Choose Starte>Control Panel.

e Windows 7: Choose Startz>Control Panel=
Appearance and Personalization and then click
Display to open the Display dialog box.

2. Again, follow the appropriate step for your version of
Windows:

e Windows XP and Vista: On the Settings tab, select
Screen Resolution and Color Quality settings that
work properly with your system, and click OK.

e Windows 7: Select the Medium or Larger radio

button (see Figure 17-3), and click the Apply
button.
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In Windows 7, you can right-click the desktop and
choose Screen Resolution from the shortcut menu to
adjust resolution, but you can’t change color settings
or themes in safe mode.

= Display

€15 B ~ Control Fanel v All Control Panel Ttems + Display v [k&3 | search control Panel

Control Panel Home Make it easier to read what's on your screen

WYou cah change the size of text and other iters on your screen by choosing one of these options, To

Adjustresplution termporatily enlarge just part of the screen, use the Magnifier tool,

By Calibrate color
Change display settings
9 STy e € Smaller - 100% default Preview
Adjust ClearType text
Set custom text size (DPT)

= Medium - 125%

— larger - 150%

1. This change will take effect the next time you log on, Apply

Some iterns may not fit on your screen if you choose this setting while your display
is set to this resolution,

8572009

Choose a level of magnification.
Figure 17-3

Use Safe Mode Tools

When you've restarted a troublesome computer in safe mode, you can
use several diagnostic and repair tools to attempt a fix. (Slight varia-
tions in operation may occur among Windows XP, Vista, and
Windows 7.) Here are some of the most valuable tools:
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Plug and play: The availability of plug and play
means that the computer can recognize most devices
that are plugged in during or after start-up. Not all
device drivers are available in safe mode, however.
For more information on working with device
drivers, see Chapter 4.

Help and Support: Choose Start=>Help and Support
to open the Help and Support window, which pro-
vides searchable instructions and troubleshooting
tips for many elements of the system (see Figure
17-4). In basic safe mode, however, networking and
Internet access are disabled; to search on the Web
for assistance, you have to choose the Safe Mode
with Networking option during start-up (see
“Choose Advanced Safe Mode Options,” later in
this chapter).

Device Manager: This tool allows you to update
device drivers and configure hardware. For details on
using Device Manager, see Chapter 18.

System Restore: This utility lets you retrieve settings
and other information stored in the computer at an
earlier time. I cover System Restore in detail in
Chapter 16.

Command prompt: In certain circumstances — such
as when a support professional tells you to do so —
you may want to reach the command prompt to run
a program that resides outside Windows. To display
the prompt (see Figure 17-5), choose Start=>All
ProgramswAccessoriess>Command Prompt. Also see
“Choose Advanced Safe Mode Options,” later in this
chapter, for more information.

Chapter 17: Working in Safe Mode
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Safe mode indicators
|

SafTede . icrosoft (R) Windows (R} (Build 6001: Service Pack 1)
-

Recycle Bin -
) Windows Help and Support _ 10 x|

p , = @ :
el A\ . - “| ﬁ?} Ask Options «

PowerPoint What is safe mode?
Presentations

Safe mode is a troubleshooting option for Windows that star ur computer in a limited

state. Only the basic files and drivers necessary to run Winde tarted. The words "Safe
Mode" appear in the corners of the display to identify which Windows mode you are using.
If an existing problem does not reappear when you start in safe mode, you can eliminate the
default settings and basic device drivers as possible causes.

Manuals If you den't know the cause of the problem, you can use the process of elimination to help
you find the problem. Try starting all of the pregrams you commaenly use, including the
programs in your Startup folder, one by cne, to see if a program might be the cause of the
problem.

If your computer automatically starts in safe mode without prompting, a problem with your
computer might be preventing Windows from starting normally. i you think the cause of
i X the problem might be a recently installed pregram or device, try using System Restore, For
Video Capture: . 2 x g
more information, see What is System Resteore?
See also
» Advanced startup options (incuding safe mode)
# Start your computer in safe mode
#» Diagnostictools to use in safe mode

ry

8 Ask someone or expand your search

® Windows H...

Wil 420 PM

Help window
Figure 17-4

w= Registry Editor: This tool is not for inexperienced or
unguided users. You may need to use it, however, if
a support professional directs you to make changes
in your Windows Registry files. Follow his or her
instructions carefully.

Don't make changes without backing up the previous
set of files and without getting specific instructions
about changes. A mistake in a critical section can ren-
der Windows unusable, requiring you to reinstall it.

@.
7y
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Type commands at the command prompt.
Saf_ i i (Build 6002: Service Pack 2)
-
Recycle Bin

B Administrator: C:\Windows\gystem32icmd.exe

Microsoft Windows [Uersiin 6.8.68021
Copyright <(c)> 2886 Microiloft Corporation. All rights reserved.

C:sUserssGCorey Sandler>z

:'Stan| Quicklaunch @ b @ G @ § QL E = & B8 Administra... |Desktop > @M =g}z 2:35 PM
Figure 17-5

Test New Hardware in Safe Mode

1. Start your computer in safe mode, as described earlier in
this chapter.

2. Uninstall any drivers or other software that you installed
for the new hardware. (See Chapter 4 for information on
uninstalling programs and working with drivers.)

3. Choose StartoShut Down to shut down the computer.

4. Uninstall the new hardware.
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5. Restart the computer in normal mode.

6. If the problem goes away, you've isolated its source.
Contact the manufacturer of the new hardware for
assistance.

Test Settings in Safe Mode

1. Follow the appropriate step for your version of Windows:

288
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Windows XP: Choose Startr>Control Panel to open
the Control Panel window, and double-click the
Display icon to open the Display Properties dialog
box.

Vista and Windows 7: Choose Start=>Control Panel
to open the Control Panel window. Then (in Classic
View) click Display or (in Category View) select
Appearance and Personalization and then click
Display to open the Display dialog box.

2. Again, follow the appropriate step for your version of
Windows:

-y

nmp

®
®

Windows XP: On the Settings tab, restore the resolu-
tion and color settings that were in effect before you
started having problems, and click OK.

Vista and Windows 7: Click Adjust Resolution,
make the necessary changes, and click OK.

In Windows 7, you can’t adjust color settings in safe
mode, but you can adjust screen resolution.

Other system settings, such as network and sound-
card configuration, aren’t available in standard safe
mode. See the next section for more options.
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Choose Advanced Safe Mode Options

1. Follow Steps 1-4 of “Start Your Computer in Safe Mode,”
earlier in this chapter. In Windows XP and Vista, you see the
Windows Advanced Options Menu screen; in Windows 7,
you see the Advanced Boot Options Menu screen.

2. Use the arrow keys to select the option you want to use:

In Windows 7 and Vista, a brief description appears
at the bottom of the screen as you select each option.

¢ Repair Your Computer (Vista and Windows 7
only): This option displays a list of system-recovery
options, including tools you can use to diagnose
your current problems. You'll be asked to log in,
after which you see a dialog box.

your computer’'s manufacturer has supplied tools to
replace these Microsoft utilities. Also, you may find
these tools on your Windows CD but not on your
hard drive.

@ If you don't see this dialog box, it may mean that

e Safe Mode: This option (covered earlier in this
chapter) loads Windows with a minimal set of
drivers and services, permitting access to Control
Panel and certain other utilities.

e Safe Mode with Networking: This option loads
Windows in safe mode and also includes the stan-
dard set of drivers and services that you need to
access the Internet or other computers on a network.

e Safe Mode with Command Prompt: This option
loads Windows in safe mode but displays the
command-prompt window instead of the usual
Windows interface, permitting direct use of utili-
ties that run outside Windows.
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e Enable Boot Logging: During the start-up process,

this option creates a file listing all the drivers that
load during start-up. Examining the file, which is
called ntbtlog. txt, may offer clues for
advanced troubleshooting.

Enable VGA Mode (Windows XP and Vista) or
Enable Low Resolution Video (Windows 7): This
option loads Windows with the current video
driver but with low-resolution, minimal settings.
This option allows you to reset the display settings
if they were intentionally or accidentally set out-
side the acceptable range for your hardware.

Last Known Good Configuration: This option
loads Windows with the last configuration that
worked successfully. I cover it in detail in
Chapter 16.

Directory Services Restore Mode: This advanced
option is for system administrators and advanced
users, but a support professional may direct you to
choose it. This option loads the Windows domain
controller running Active Directory so that the
directory service can be restored. You wouldn't
choose this option except under the direction of a
Windows support professional.

Debugging Mode: This option loads another
advanced troubleshooting mode that lets you
change certain elements of the Windows code
itself. A support professional may direct you to
choose this option, but don’t enter this mode by
yourself.

Disable Automatic Restart on System Failure:
This option (see Figure 17-6) allows you to specify
whether Windows will restart automatically if an
error causes it to fail. Microsoft recommends that
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you disable automatic restart if Windows is stuck
in a loop in which it fails, attempts to restart, and
fails again repeatedly.

e Disable Driver Signature Enforcement (Vista and
Windows 7 only): This option allows drivers that

contain improper or unverified signatures to be
loaded.

e Start Windows Normally: This option, unlike the
others in this menu, starts Windows in normal
mode.

e Recovery Console (Windows XP) or View System
Recovery Options (Vista): Choose this option to
display a menu of recovery options that can help
you solve problems related to start-up.

Disable automatic restart if Windows
cycles and won't start up properly.

Startup and Recovery (=]

System startup
Default operating system:

Microsoft Windows Vista A4
[¥] Time to display list of operating systems: 30 |5+ seconds
[| Time to display recovery options when needed: | 30 seconds
System failure

[¥] write an event to the system log

{7] Automatically restart

‘Write debugging information

Kernel memory dump -

Dump file:
YeSystemRoot% \MEMORY . DMP

[¥] overwrite any existing file

OK ] | Cancel

Figure 17-6
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repair tools. You see this option only if these utilities
have been installed on your hard drive. Otherwise,
you can find them on your Vista CD. Depending on
your computer brand, the manufacturer may have
substituted another utility for this one.

@ System Recovery Options is a suite of recovery and

e Reboot: This option lets you restart the system.
Unless you press the F8 key to start in safe mode,
this option restarts the computer normally.

e Return to OS Choices Menu: If your computer
contains more than one version of Windows, this
option returns you to the start-up menu so you
can choose which version you want to launch.

3. Press Enter to start Windows in the selected mode.

Exit Safe Mode

1. Restart the computer from the Start menu.

2. Allow Windows to load normally.
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Troubleshooting
Your PC

The Sth Wave By Rich Tennant
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“We’ze much betber prepared for this vpérade than
before. We've giving users additional training,

better manvals, and a morphine drip.”







Managing and
Troubleshooting
Devices

Device Manager, a key component of the
System utility in Control Panel, is a full-
time, officially licensed internal snoop and
reporter. As its name tells you, its assignment is
to manage the devices that do the work.

In addition, this utility gives you a window on
the various hardware components that make
up your computer. Here, devices are grouped
according to their function. You can retrieve
device names, view driver information, find
out whether a device is working properly,
enable or disable a device, and more. Device
Manager is a valuable tool that helps you
understand more about your computer system
and troubleshoot hardware problems.

In this chapter, I show you how to use Device
Manager to keep your system running
smoothly — and how to troubleshoot device
problems if you need more help.

| “*apter

Getready to. ..

w= See What You Can Do
with Device Manager ...

w= Open Device Manager.
w= Resolve a Conflict ........

w= Disable a Device .........

w= Use a Windows Trouble-

shooting Wizard..........

w= Update a Device Driver
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See What You Can Do with Device Manager

w= View a list of the devices installed in your computer
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system. Figure 18-1 shows a sample list in Device
Manager. (Your computer’s list will be similar but
certainly not the same.)

Click a plus sign (+) to expand any device category.

2 Device Manager =/@JE3
File Action View Help
g 2 )
- i Computer |

[+]
&

+

=1-Eg Metwork adapters

[+
[+]
[+
+
+
[+

_(') DwD/CD-ROM drives

{=) IDE ATA/ATAPIL controllers
[+]-&5p [EEE 1394 Bus host cantrollers

‘i Keyboards

@ Processars
@% SCSIand RAID contrallers
L) Sound, video and game contrallers

W System devices
Universal Serial Bus controllers |ne |

= Disk drives
g [C2SMOBOATMRO4 -0
@ Display adapters

i MATSHITA UIDATED DVD/CDRW

@ Intel AIM 3.0 Codec

Zg» Standard 101/102-Key or Microsoft Matural PS/2 Keyboard
"_, Mice and other pointing devices

Maodems
® Monitars

-E8 1394 Net Adapter
-E Intel{R} PRO/Wireless 2200BG Metwork Connection
B8 Realtek RTL3139,510x Family Fast Ethernet NIC

B PCmcs adapters

Figure 18-1

w= Temporarily disable any listed device to help with a

=y

troubleshooting process (see “Disable a Device,”
later in this chapter). If your PC works properly with
a single device disabled, either that device is causing
the problem, or it’s in conflict with another device
(see “Resolve a Conflict,” later in this chapter).

See at a glance whether the system has found prob-
lems, such as malfunctioning hardware or intermit-
tent device conflicts.
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Get data about the microprocessor and other major
components of the motherboard.

See information about many external devices that are
in continuous communication with your computer.

Print a report on the status of your devices.

Examine the resources (including memory) that any
device uses.

View details on the drivers for each device, including
the publisher of the software and its version name or
number.

Update, roll back, or uninstall device drivers.

If Windows was set up on your PC with an
Administrator account (most often done in offices,
where one person or department is in charge of man-
aging multiple computers), you have to sign in as the
administrator to manage devices and make certain
changes in settings.

Open Device Manager

1. Follow the appropriate step for your version of Windows:

e Windows XP: Choose StartevControl Panel to
open the Control Panel window; double-click the
System icon to display the System Properties dia-
log box; click the Hardware tab; and then click the
Device Manager button (see Figure 18-2).

¢ Vista and Windows 7: Choose Startz>Control
Panel to open the Control Panel window. Then (in
Classic View) click Device Manager or (in Category
View) click Hardware and Sound to open the
Hardware and Sound dialog box; then click Device
Manager in the Devices and Printers section.

Chapter 18: Managing and Troubleshooting Devices

297



Part V: Troubleshooting Your PC

System Properties @
Systemn Restore Automatic Updates Remate
General | Computer Name Hardware Advanced

Device Manager

on your computer, Use the Device Manager to change the

"#"‘{ The Device Manager lists all the hardware devices installed
properties of any device.

Device Manager

Diriver Signing lets you make sure that installed drivers are
compatible with ‘Windows. Windows U pdate lets you set up
haw Windows connects b Windows Update far drivers.

I Diriver Signing ] I Windows Update J

Hardware Profiles

o Hardware profiles provide a way for you to set up and store
different hardware configurations.

Hardware Profiles

[ 0K ][ Cancel ]

Click to launch Device Manager.
Figure 18-2

Whichever method you use, Device Manager
opens.

2. Check the Device Manager window for any warning
icons. If Device Manager has detected a problem, it dis-
plays either of two warning icons next to the device in
question:

¢ An exclamation point (!) in a yellow circle indi-
cates a potential or actual conflict (see Figure
18-3). See the next section, “Resolve a Conflict,”
for information on what to do next.

e An X in a red circle tells you that a device is
disabled — physically installed on your computer
but not functioning. Either you've disabled the
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device (see “Disable a Device,” later in this chap-
ter), or a troubleshooting utility has disabled it
for you.

3. Double-click the name of a device or category to display
its properties. You can double-click the Processors entry,
for example, to find out what kind of processor your
computer uses.

To display individual devices in a category, click the
plus sign (+) (Windows XP) or the right-pointing
arrow (Vista and Windows 7).

.= Device Manager =N =
File Action View Help
= @ HE
g4 TOSHP205
+Q Batteries
&l Computer
+]- = Disk drives
+-Be Display adapters
2 DVD/CD-ROM drives
g IDE ATA/ATAPI controllers
1 ? IEEE 1394 Bus host controllers
- %54 Imaging devices
== Keyboards
£ 1] Memary technology driver
Jil, Mice and other pointing devices
| Modems
A Monitors
¥ Network adapters
-\ Other devices
= |/ Stamps.com Model 510 5LB USE Scale
T3 Ports (COM & LPT)
D Processaors
&2 sD host adapters
% Sound, video and game controllers
-z Storage controllers
+1-1hl System devices
22 @ Universal Serial Bus controllers

2]

O 0 oy O O Y

ER e S Y

This icon indicates a possible conflict involving this device

Figure 18-3
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4.

Click the Driver tab to view information about the driver
software installed to support this device.

box, Windows displays the path to the device’s driv-

@ If you click the Driver Details button in this dialog

ers. For information on updating drivers, see “Update
a Device Driver,” later in this chapter.

Resolve a Conflict

300

1.

2.

Double-click any device with a warning icon (see “Open
Device Manager,” earlier in this chapter) to display its
Properties dialog box.

Click the General tab, and read the Device Status section
(Figure 18-4). This section may list specific information
about the nature of any problem; you can use those
details to change configurations by yourself or with the
assistance of a support technician.

. If the Device Status section reports that the device is

working properly, proceed to Step 4.
or

If the Device Status section reports that the device isn't
working properly, click the Troubleshoot button, and
skip to “Use a Windows Troubleshooting Wizard,” later
in this chapter.

If the device uses system resources, you should find a
Resources tab in the Properties dialog box; click that tab.

Check the Conflicting Device List section at the bottom
of the Resources tab. This information may be sufficient
to help you figure out which device needs to be reconfig-
ured or replaced. Figure 18-5 shows this section for a
device that has no conflicts.
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Standard PS/2 Keyboard Properties 7 ==

Standard P5/2 Keyboard

Device type: Keyboards
Manufacturer: {Standard keyboards)
Location: plugged into keyboard port

Device status

[This device is working propery.

[ ok [ concel

Look in the Device Status section for
details on problems with this device.

Figure 18-4

Standard 101/102-Key or Microsoft Natural PS/2 Keybo... [2JE3

General || Driver | Details | Resources

&S, Standard 101/102-Key or Microsoft Natural P3/2 Keyboard
Resource settings:

Resource type | Setting
| W 1/0 Range
W 1/0 Range
| W IRG

Conflicting device list:
Mo conflicts.

[ 0K ][ Cancel ]

Look here for possible device conflicts.

Figure 18-5
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Disable a Device

302

Disabling a device (actually, disabling its device

@ driver and its request for use of system resources) can
be very helpful in tracking down the source of a
problem with your computer or with Windows.
When a potentially problematic device is disabled,
you can see status reports and error messages that
may assist you.

1. Launch Device Manager (see “Open Device Manager,”
earlier in this chapter).

2. Click the plus sign (+) next to the device’s category to
expand the listing (see Figure 18-6).

3. Double-click the device that you want to disable. The
device’s Properties dialog box opens.

4. Follow the appropriate step for your version of Windows:

e Windows XP and Vista: Click the General tab. In
the Device Usage section at the bottom of the tab,
choose Do Not Use This Device (Disable) from the
drop-down menu (see Figure 18-7).

e Windows 7: Click the Driver tab, and choose
Disable at the bottom of the tab.

in various versions of Windows, but the effect is the
same.

@ The wording of the disable option may differ slightly

5. Click OK to apply the change and close the dialog box.

6. If you don't see an immediate change in your computer’s
operation, restart your PC to allow all the installed
devices to make their presences known to Device
Manager.



Chapter 18: Managing and Troubleshooting Devices

Expanded category

£ Davice Manager

File  Action View Help

m & 2 A

Y _DIMENSION
9 Batteries
+ I Computer
=) age Disk drives
e SAMSLNG SPE504C
“ee U3B2.0 CF CardReader USE Qevice
“e USEZ2.0 M5 CardReader USE evice
“ee U3B2.0 3D CardReader USE Qevice
“ge USBZ.0 SM Cardreader USE Qevice
e WD WDS000YS-01MPED
=8 Display adapters
& Radeon %1600 Series
:j Radeon X1600 Series Seconddry
= alf DYDICD-ROM drives
b HP DYD Wriker 8408 LISE Device
i SONY CORWDVD CRX3105
{25 Huran Intetface Devices
=i Imaging devices
z» Keyboards
_) Mice and other paointing devices
# Monitars
B8 Network adapters
B Intel(R) 525660C Gigabit Metwork Connection
= & Ports (COM & LFT)
5 Keyspan MPR Serial Port (COM3)
- #8% Processors
A Intel(R) Core(TM)2 CPU £600 @ 2.40GHz
W Intel(R) Core(TM)Z CPU £600 @ 2.40GHz
+ @% SC5I and RAID controllers
+ @), Sound, viden and game controllers
+| g Storage wolumes

¥ System devices
+ Universal Serial Bus controllers

[ = e Sy

Figure 18-6

For external devices that connect to the system
through a USB port, you can achieve the same effect
by unplugging the device from the computer or (if it
draws its own power from a wall socket) turning off
its switch. If the device includes memory, however,
you should first click the Safely Remove Hardware
icon at the right end of the taskbar and choose the
device from the pop-up menu. To remove a USB
storage device in Windows 7, choose Starte>Devices
and Printers, right-click the device in the Devices
and Printers window, and choose Eject from the
shortcut menu.
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ENE PCI Memory Stick Card Reader Controller Properti... (23

Gereral | Driver || Details | Resources |

@? ENE PCI Memory Stick Card Reader Controller

Dievice type: SCSland RAID controllers

Manufacturer: EME Technology Inc.

Location: PClbus 2, device 4, function 1
Device status

This device is working property.

I you are having problems with this device, click Troubleshoot to
start the troubleshooter.

Troubleshoat...

Device usage:

| Do not use this device (di
_|Usetl i

Enable and disable devices with this menu.
Figure 18-7

Use a Windows Troubleshooting Wizard

To use Windows’ automatic troubleshooting process,

@ your PC has to be functioning at least well enough
for Windows to load and run. If it can’t get to that
point, try restarting in safe mode (see Chapter 17),
which loads only your computer’s most basic
functions.

1. Launch Device Manager (see “Open Device Manager,”
earlier in this chapter).

2. Click the plus sign next to the category you want to trou-
bleshoot to expand the list of items in that category.
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3. Right-click the troubled device, and choose Properties
from the shortcut menu to open the device’s Properties
dialog box.

4. Click the General tab, and read the information listed in
the Device Status section, which may tell you the nature
of the problem and suggest a solution.

5. To get help, click the Troubleshoot button. Windows
Help and Support Center launches a troubleshooting
wizard for the device in question (see Figure 18-8).

Select your problem, and click Next.

) Help and Support Center S| (=[]
»

A\ 1 ) : &4 0 . m_-\ 1 :
3 B ? | ,I.J g_j Index i Favorites J Histary Support ‘{i DOptions

search > @ Help and Support Center

Set search options Windows XP Home Edition

Video Display Troubleshooter

What problem are you having?

@@ [ receive the following message: "Display problems. This program can't continue.”

@) My display flickers or is garbled.

¢y I cannot install my monitor.

O I am having a problem with the multiple monitor feature.
() \Videos or animations do not work correctly.

() [ cannat set the video rezolution above 640 x 480 with 16 colors.

Figure 18-8

6. Follow the wizard’s instructions, being sure to click the
Next button at the bottom of each wizard screen to pro-
ceed to the next step.
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Update a Device Driver

306

1. Launch Device Manager (see “Open Device Manager,”
earlier in this chapter).

2. Click the plus sign next to the category you want to trou-
bleshoot to expand the list of items in that category.

3. Right-click the troubled device, and choose Properties
from the shortcut menu to open the device’s Properties
dialog box.

4. Click the Driver tab.

5. Click Update Driver to launch the Hardware Update
Wizard (Windows XP) or the Update Driver Software dia-
log box (Vista and Windows 7).

6. Select Yes when Windows asks permission to connect to
Windows Update to look for a driver (XP). In Vista and
Windows 7 the search will be begin as soon as you click
the automatic search choice on the update screen.

7. Click Next (XP) to display an action summary screen,
then click Next again to accept the automatic installation
option.

8. Follow any onscreen instructions. If Windows determines
that your driver is current, it displays a notice to that
effect; otherwise, it proceeds to install the current driver.

9. If you're installing a new driver in an attempt to solve a
problem, restart your computer after installation, and test
the problem device.

installing new software so that you can revert to the
earlier configuration if necessary. For details, see
Chapter 16.

@ It’s a good idea to set a new restore point before



Relieving Hard
Times for Hard
Drives

Tw hard disk drive in your computer is a
mechanical device, kind of like a lawn-
mower, a food processor, or a record player
(remember those?). Like all mechanical
devices, it has a limited life expectancy.

If you're unlucky, your drive will die suddenly.

If you're lucky, it will break down slowly over
a long period. Make no mistake, though:
Someday, your hard drive will die. That's why
it's important to check its health regularly and
keep it in the best possible shape.

You can do several things to check and main-
tain your drive:

m= [Ise an automated maintenance utility
provided by the drive maker or a third-
party software company

m= Perform a manual check with mainte-
nance tools that are built into Windows

w= Defragment the drive

ws Check for disk errors

| “*apter

19

Getready to. ..

w= Defragment the Drive with
Windows' Defragmenting

ToOl cuviiiiiiiei, 308
w= Defragment the Drive with

a Third-Party Utility............ 310
w= Check for Disk Errors

Automatically ................... 311
= Check for Disk Errors

Manually with Chkdsk ....... 314
w= Take Out the Garbage

with Disk Cleanup............. 317
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The one thing you should not do is ignore any developing issue.

In this chapter, I show you how to tune up your hard drive and keep it

running as long as possible.

Defragment the Drive with Windows’
Defragmenting Tool

308

1. Choose Start=>All Programs=>Accessories=>System Tools=>

Disk Defragmenter to display the Disk Defragmenter
dialog box (see Figure 19-1).

Click here for more information.

By Disk Defragmenter

=l =

> Disk Defragmenter consolidates fragmented files an your co

« performance, Tell me more about Disk Defragrmenter,

puter's hard disk to improve system

5 Configure schedule I

Scheduled defragmentation is turned on |
Run at 1:00 &AM every Miednesday

Mext scheduled run: 8/12,/2009 1:12 AM

Current status:

Disk Last Run Progress
.L;,(C:) 8/6/2009 10:10 P (6% fragrmented)
o TOMFLASH (F:) Mewver run

Only disks that can be defragmented are shown,
To best determine if wour disks need defragrmenting right now, you need to first analyze your disks,

| 5 Analyze disk | | B Defragment disk |

| Close |

Figure 19-1

Click here to start defragmenting.

Click here to set up an automatic defragmenting
schedule in Vista and Windows 7.
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2. Select the drive that you want to defragment.

C: drive; it contains Windows, your applications, and
your data. This drive has the most storage. You may
also see a much smaller D: drive, which likely con-
tains the files you would use to restore your computer
to factory settings in the event of a problem. You
don't want to alter anything on this recovery drive.

@ For most users, the main hard drive is designated the

3. Click Defragment (Windows XP) or Defragment Disk
(Vista and Windows 7). The defragmenter analyzes the
disk for degree of fragmentation and then begins the
defragmentation process.

In Windows XP, you see a graphical display that repre-
sents the hard drive before and after defragmentation. In
Vista and Windows 7, you see a countdown of the per-
centage of defragmentation completed.

4. When the process is complete, close Disk Defragmenter
by choosing File=>Exit (Windows XP) or by clicking the
Close button (Vista and Windows 7).

Defragmenter to run on a schedule, which keeps your
hard drive tuned up and efficient without your hav-
ing to think about it.

@ In Windows 7 and Vista, you can configure Disk

Don't allow your drives to become so full that a
@ defragmentation tool — either the built-in Windows
tool or a third-party product (see the next section) —
has little or no room to rearrange files. In most cases,
you shouldn’t fill a drive to more than 85 percent of
its capacity; that means leaving at least 15 percent
available for the utility. Delete junk or move some
files to external storage if you need to open space.
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Defragment the Drive with a Third-Party Utility

Why spend money for a tool that does the same thing as Disk
Defragmenter? Third-party defraggers provide extra bells and whistles
that may be worth paying for. Here are a few of the best third-party
defragmentation utilities:

m= Norton 360 and Norton Systemworks
(www . symantec . com)

w= Diskeeper Professional (www.diskeeper.com;
see Figure 19-2)

Colorcoded defragmentation analysis

e =[] 5]
Manual Analysis Job Display
Wolume Map | JobReport |

Wolume map wiew: _ .

Thig view shows the performance of files and free epace on your volume with an emphasiz on the impact of fragmentation.

o i i L
A bl i s o | AL
e N P I T S~

(1 | EEETNT el N | i
0| LT T | N
___Ill_-]I_I__I]_I__I_I_II_\IIIlIli-_-

B Blue - high performing files and folders B Red - low perfarming files and folders
O Fink - low perfaming spstern files O 'white - unuzed space

[ Greenswhite - reserved system space

(C:) Analyzed Done

Figure 19-2
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If you use a scheduled defragmentation tool such as
the one built into Windows 7 (as opposed to one that
works in the background, like the Norton products
and Diskeeper), you'll get better and faster results if
you turn off your computer’s Internet connection
while the program is running. Otherwise, new e-mail
and other automatic activities that bring files to your
computer will slow the process — sometimes to the
point at which the tool has to start all over again.

Check for Disk Errors Automatically

1. Choose Start=>My Computer or Start=>Computer to open
the My Computer/ Computer window.

2. Right-click the drive you want to check, and choose
Properties from the shortcut menu to open the drive’s
Properties dialog box.

3. Check the General tab for information about your drive,
such as total capacity and free space (see Figure 19-3). A
drive that is 99 percent full may not report errors, but it
may act like it has hardware problems. If so, delete some
files to make more room.

4. Click the Tools tab, and click the Check Now button. The
Check Disk dialog box opens (see Figure 19-4).

5. Select one or both of the following options:

¢ Automatically Fix File System Errors: If this box
is checked, the utility will examine all the files,
folders, and indexes on the drive and repair most
basic problems that it finds.
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Local Disk (C:) Properties B[%]

Gereral  Tools | Hardware || Sharing | Quota |
]

Type: Local Disk
File system:  NTFS

B Used space: 35,003,484 160 bytes 363GB
B Free space: 21,008,125,952 bytes 15.5GB
Capacity: 60.011.610.112 bytes 55.8GB

[]Compress drive to sae disk space

Allow Indexing Servick to index this disk for fas] file seanching

[ Lok [ cancel] |

Free space Used space

Figure 19-3

Choose your options, and click
Start to scan for errors.

Check Disk Local Disk (C:) 2)&3

Check disk options

Automatically fix file system errors
Scan for and attempt recovery of bad sectors

[ ]

[ Start ] [ Cancel

Figure 19-4

e Scan for and Attempt Recovery of Bad Sectors: If
this box is checked, the utility will examine the
magnetic sector markings on the surface of the



disk, looking for any that are corrupted, incorrect,
or damaged. If possible, the utility will repair dam-
aged sector marking. If that portion of the disk is
damaged, the utility may be able to place an elec-
tronic fence around the sector so that your PC
doesn’t attempt to place new information there.

6. Click the Start button to begin the scan. If you selected

the automatic-check option in Step 5, Windows displays
a message that the check can’t be performed while you're
using the disk and asks whether you want the utility to
check the disk the next time you restart your PC.

7. Follow the appropriate step for your version of Windows:

e Windows XP: Click Yes to tell Windows to check
your disk at the next restart.

e Vista and Windows 7: Click Schedule Disk Check.

have an administrator perform certain functions,
you'll be asked to enter an administrator password at
this point. Most home and small-business PCs, how-
ever, aren’t set up to be managed by an
administrator.

@ If your Vista or Windows 7 computer is set up to

If you chose Scan for and Attempt Recovery of Bad
Sectors in Step 5, you can continue to work on your com-
puter, if you want, while the test is under way. You can
get some idea of the status of the checkup by watching
the slow advance of the progress bars onscreen, but don’t
expect a play-by-play report.

At the end of the scan, Windows will report whether or
not errors were found and corrected. If you opted to
schedule an automatic check on the next restart,

Chapter 19: Relieving Hard Times for Hard Drives
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Windows reports that a disk check has been scheduled,
gives you a chance to cancel, and then goes about run-
ning the Check Disk utility.

You don't have to check for disk errors every day, but
you should do it every few months or whenever you
notice erratic behavior that may be disk-related.

Check for Disk Errors Manually with Chkdsk

This method takes a side trip out of Windows into

@ the dark recesses of the command prompt — the
mostly hidden vestige of the PC’s ancestral operating
system — via a utility called Chkdsk. This text-based
utility will be familiar to old-time computer users.
Welcome to the past.

1. Follow the appropriate step for your version of Windows:

¢ Windows XP: Choose Start=>Run to display the
dialog box, type cmd in the Open text box, and
click OK.

e Vista: Click the Start button, type cmd in the
Search Programs and Files field, and press Enter.
Windows opens a dialog box displaying the mes-
sage This task will be created with
Administrative privileges. Click OK.

¢ Windows 7: Click the Start button, type cmd in
the Search Programs and Files field, and press
Enter. Right-click cmd in the search-results win-
dow, and choose Run as Administrator from the
shortcut menu. When Windows asks permission to
make changes in User Access Control, click Yes.
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Whichever method you use, the command-prompt
window opens.

You won't be able to work on your computer while
this utility is running.

2. Enter one of the following commands:

e To view detailed information about your hard
drive, type chkdsk driveletter: and then press
Enter. (You enter the drive letter in place of
driveletter. To check drive C:, for example, type
the command chkdsk c:.)

e To find and repair errors, locate bad sectors, and
recover readable information that may have been
lost to an application, type chkdsk driveletter:/r
and then press Enter. (Substitute the actual drive
letter for driveletter. To check drive C:, for example,

type chkdsk c:/r.)

Programs such as chkdsk can be executed (run) with
@ command switches that tell the program to conduct
special tasks. You enter a switch after the program
name, preceded by a slash (/). The /r switch, for
example, tells Chkdsk to find and repair errors.

If the current drive is in use (which is often the case

@ in a PC that has just one drive), Chkdsk informs you
that it can’t run the test with the specified repairs
now and offers to conduct it the next time the com-
puter starts. Type Y (for yes) and then press Enter.
The next time you start your computer, Chkdsk will
run its test before Windows loads.

3. Wait for Chkdsk to finish doing its thing and display
details on what it found (see Figure 19-5).
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Result of a Chkdsk scan

=8 Administrator: Command Prompt -10] |

C:sWindowsssystem32 >chkdsk e: AF /»
The type of the file system is FAT32.
Uolume SANDLER1GGE created 2/7-2089 1:47
Uolume Serial Number is 147A-5474
Windows is verifying files and foldews...
File and folder verification iz complete.
ost chain cross—linked at cluster 125145. Orphan truncated.
Convert lost chains to files (Y¥Y~/NX7 u
64 KB in 1 recovered files.
Windows is verifying free space...
Free space verification is complete.
Ilindows has made corrections to the file system.
15,736,888 KB total disk space.
4,824 KB in 68 hidden files.
1,168 KB in 141 folders.
7.188.952 KB in 1,558 files.
8,.541.864 KB are availahle.

§.192 bhytes in each allocation unit.
1.967.181 total allocation units on disk.
1.867.733 allocation units available on disk.

C:sWindowsssystem3d2>

1] 3

Figure 19-5

Here are the possibilities and their meanings:

Exit Code Description

0 No errors were found.

1 Errors were found and fixed.

2 Disk cleanup, such as garbage collection, was performed, or cleanup
wasn't performed because the /£ switch wasn't specified. (/£ is the
errorfix switch that's included in the /x switch, which | discuss earlier
in this section.)

3 Chkdsk couldn't check the disk or couldn't fix errors because the /£

switch wasn't specified.
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4. What you do next depends on the result of the test. If
you asked Chkdsk to fix errors, for example, it may dis-
play an exit code or ask for verification before it performs
a repair or recovery task. To continue the process, type Y
and then press Enter.
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5. Type exit and press Enter to close the command-prompt
window.

on the hard drive, you see the following message:
Chkdsk cannot run because the volume
is in use by another process. Would
yvou like to schedule this wvolume to
be checked the next time the system
restarts? (Y/N) TypeY and press Enter to
schedule the disk check; then restart your computer.

@ Again, if Windows is using one or more of the files

Take Out the Garbage with Disk Cleanup

1. Choose Start=>My Computer or Startc>My Computer to
open the My Computer/Computer window.

2. Right-click the drive you want to check, and choose
Properties from the shortcut menu to open the drive’s
Properties dialog box (refer to Figure 19-3, earlier in this
chapter).

3. Click the General tab, if it isn't already open.

4. 1f you want, check the Compress This Drive to Save Disk
Space check box. This option compresses old files that
you haven't used for a while.

Choosing the Compress option generally is a good
idea, although some users (including me) would

rather not touch older files and compensate by add-
ing more storage. (See Chapter 11 for details on add-
ing or replacing a hard drive.)

5. Click the Disk Cleanup button. The system churns away
for a while, examining your drive and calculating how
much garbage it can locate.
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Finally, the Disk Cleanup dialog box opens (see Figure
19-6), indicating how much junk is sitting around in
places like the folders for downloaded program files,
temporary Internet files, and the Recycle Bin, and sug-
gesting files to delete.

Disk space that will be recovered
if you delete these files

=, Disk Cleanup for SQ004331V05 (C:) ==

Disk Cleanup | More Options |

“You can use Disk Cleanup to free up to 3.66 GB of disk
space on SGO04331V05(C:).

Files to delete:
[C] &3 Offline Webpages 14.2 KB
[ @ Hibemation File Cleaner 158GE -~
FH it 5
Total amount of disk space you gain: 1.48GB
Dlescription

Downloaded Program Files are ActiveX controls and Java applets
downloaded automatically from the Intemet when you view certain
pages. They are temporarily stored in the Downloaded Program
Files folder on your hard disk.

View Files |

How does Disk Cleanup work?

[ ok [ concel |

Figure 19-6

6. Clear the check boxes next to any files that you want to
keep; check the check boxes next to any additional files
that you want to clear off the disk.

For most users, it’s best to delete only the recom-
mended files. If you choose to go further, click each
file and read its description before proceeding.
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7. Click OK.

8. When Windows asks you to confirm that you want to
delete these files permanently, click Yes (Windows XP) or
Delete Files (Vista and Windows 7).

depends on your habits. If you do a lot of Internet
browsing, and disk space is running low, run the util-
ity. Otherwise, every few months is probably often
enough.

@ How often you should run the Disk Cleanup utility
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Fixing Common
Problems

A s Claude Rains advised in Casablanca,
when things go awry, the first thing to do
is round up the usual suspects. The same is
true for computers. Although there are
uncountable possible combinations of hard-
ware, software, and settings, most problems
can be traced to a relatively small number of
causes.

In this chapter, I give you tips for trouble-
shooting some of the most common PC
problems.

”'*’a ter

Getready to. ..

w= Start a Computer That
Won't Start .....oooveiienne,

w= Solve Basic Hardware
Problems ...,

w= Troubleshoot Common

Windows Woes................

w= Solve Basic Software
Problems........cccooeveeeeeenn.

w= Get Back on the Internet ....
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Start a Computer That Won’t Start
1. Check the computer’s power source and connections.

e Make certain that the power cord is plugged into
the computer and into a source of power. The
power cord runs from the back of the computer
and plugs into an electrical socket in the wall; into
a surge protector (a good thing); or (even better)
into an uninterruptible power supply (UPS),
which is basically a large battery that is continu-
ously recharged by wall current (see Figure 20-1).

Figure 20-1

e Test the source of power to see whether it’s live. To
do that, plug a lamp, radio, or fan into the same
outlet, surge protector, or UPS that you're using for
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your computer, and see whether that device works
properly. If not, the wall outlet may have blown a
fuse or the surge protector may have failed (which
is its job if a power spike comes along). For more
details on dealing with a power problem, see
Chapter 9.

¢ Try an alternative source of power, such as a differ-
ent wall socket. Then turn the computer back on
and hope for a return to normalcy.

2. Push the start button or click the power switch, and listen
for the computer’s cooling fan. A silent machine plugged
into a live power outlet may indicate a failure in the
power supply or circuitry. For details on replacing a failed
power supply (or directing a technician to do it for you),
see Chapter 9.

3. Listen and watch for beeps, other alert tones, or flashing
lights on the front panel after the PC’s fan comes to life.
These alerts during start-up (your computer’s instruction
manual may explain them) may indicate a problem with
internal hardware, such as memory or the hard disk
drive. If you need to replace hardware, turn to Part III.

If you just installed new memory or made other
@ changes inside the case, the sound or light codes may
be telling you that something went wrong with your
work. Try removing whatever you just installed and
returning the computer to the condition it was in
before you touched the hardware (see Chapter 16).

4. Watch for onscreen messages before Windows is loaded.
These messages could warn you of a hardware failure or
an error resulting from a problem with setup
instructions.
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®

Sometimes, you can get past a hardware error by
instructing Windows to open in safe mode (see
Chapter 17), which loads only the most critical com-
ponents of Windows. If Windows will load this way,
you can check Device Manager for clues about which
component failed; for details, see Chapter 18.

Solve Basic Hardware Problems
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Your computer is suddenly silent. Make sure you
haven’t muted the sound. The sound card or adapter
inside your PC has failed or is no longer adequate
for your needs.

Solution: Instead of opening the case, plug in an
external sound adapter such as Creative’s USB
SoundBlaster Live! 24-Bit External, which attaches to
a USB port on almost any desktop or laptop
computer.

Your PC needs new or better wireless capability.
You want to give your computer the ability to com-
municate wirelessly with other devices, or you need
to upgrade an outdated or malfunctioning built-in
Wi-Fi adapter.

Solution: Several manufacturers offer external Wi-Fi
adapters and antennas that connect to your PC
through (you're getting the pattern here, right?) the
USB port. One advantage of using an external Wi-Fi
adapter is that it usually comes with a more substan-
tial antenna than its internal equivalent, and you can
adjust the placement of that antenna to get the best
transmission and reception in your home or office.
The latest “N” Wi-Fi technology adapters, like the
one shown in Figure 20-2, have a small footprint
and offer better coverage than earlier models do.
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Figure 20-2
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w= You can’t install programs on a computer with no
CD/DVD drive. If you own a minimalist netbook or
a small desktop computer, the tiny size and low cost
often come at the expense of things like a CD/DVD
drive. But without a CD/DVD drive, how do you
install new programs?

Solution: A couple of simple work-arounds are
available:

e Use the Internet. The first and most obvious solu-
tion is to download programs or data over the
Internet or across a local area network, or to use a
device such as a flash memory drive to transfer
program content to the computer. You can pur-
chase very large flash drives to store up to 256GB
worth of programs or data. Figure 20-3, for exam-
ple, shows a Kingston 128GB USB flash drive.
Old-timers like me find it hard to believe that you
can get so much storage in such a small package.

Datalraveler

200

Figure 20-3

¢ Install an external CD/DVD drive. Another
option is to install an external drive. Drives of this
type are small units, similar to those used in full-
feature laptops, that draw electrical power from
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wall current and connect to the computer through
the USB port. (For details on external drives, see
Chapter 11.) Figure 20-4 shows a typical external
CD/DVD drive that can read and write discs.

Figure 20-4

For information on fixing other hardware glitches,
see Part III.

Troubleshoot Common Windows Woes

w=  Windows is damaged. The version of Windows
installed on your PC has become damaged, and your
only option seems to be a clean reinstallation. First
consider which applications you really need to keep
and use after this process; then make sure that you
have the original installation discs for these
programs.

Solution: Follow these steps:

327



Part V: Troubleshooting Your PC

328

1. Plug in an external hard drive as an additional storage
device. If the drive has been formatted and includes
any data (virtually all modern drives are configured
for plug-and-play installation), Windows will ask your
intentions (see Figure 20-5).

Maxtor 300GB External (E:)

This disk or device contains more than one type of

< content.
What do you want Windows to do?
l\-?_j- sing Photo Printing Wizard

20 Acauire picturss
[9) s

'fsﬁ‘ View pictures
lj@_. View/Download Images
2

‘_,_..-I/ Open folder to v les

@ Take no action

|ae

[ OK ] [ Cancel. ]

Select an option if necessary, and click OK.

Figure 20-5

2. If the drive is new, all you want to do is make it avail-
able to Windows, so you don’t need to select an
option; simply click OK.

3. Use Windows Explorer to copy all your data from the
internal drive to the external drive.

4. Repartition and reformat the internal drive, and rein-
stall Windows (all covered in Chapter 11).

5. Restart your PC.

6. When Windows is up and running properly, copy
your data files on the external drive back to the inter-

nal drive.
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7. Reinstall any applications that you want to use.
(Unfortunately, when you reformat a drive and rein-
stall Windows, you lose your other applications.)

You may want to keep the external drive attached
and use it to store backup copies of your data files.

w= After you install a new program, Windows stops
working properly. The new program may be
incompatible with your version of Windows. Restart
Windows in safe mode, uninstall the program, and
then contact the manufacturer to see whether it offers
a later version of the program (or a patch that makes
it compatible with your version of Windows). For
more information on safe mode, see Chapter 17; for
details on uninstalling software, turn to Chapter 4.

w= After you install a new piece of hardware,
Windows no longer works properly. The most
likely culprit is a device driver that’s incompatible
with your version of Windows or that conflicts with
a driver for a different piece of hardware. Try unin-
stalling and reinstalling the driver, and check for a
new version that may be more compatible with your
system. For details on checking for device conflicts,
see Chapter 18.

@ For full coverage of Windows issues, see Part IV.

Solve Basic Software Problems

w= After you install a new program or change your
Windows settings, your computer freezes.
Evidently, the new software has something to do
with the problem.

329



Part V: Troubleshooting Your PC

Solution: Try restarting the PC to see whether the
problem goes away after restart. If not, use
System Restore (see Chapter 16) to return your
computer to the configuration it was in before
you made the change. Figure 20-6 shows the
System Restore screen in which you choose which

restore point to use.

i System Restore (==
Choose a restore point ST
System Restore will not change or delete any of your documents and the process is reversible, I; .,
==
Click the restore peint that you want to use and then dick Next. How do I choose a restore point?
Current time zone: Eastern Daylight Time
Date and Time Description
4/29,/2009 9:10:24 AM Install: Windows Update
4/27/2009 7:25:19 FM Install: Windows Update
4/26/2009 7:33:56 PM Install: Windows Update
4212009 1:36:59 PM Install: Windows Update
/18,2009 7:53:31 PM Install: Windows Update
4/17/2009 7:41:27 PM Install: Windows Update
4/12/2009 5:39:54 AM System: Scheduled Checkpoint
4{6/2009 7:35:57 PM Install: Windows Update
4/2/2009 5:21: 25 PM Install: Windows Update
[¥] show restore points older than 5 days
| < Back ] Next > | Cancel |

Send your PC back in time by selecting one of these restore points.
Figure 20-6
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Another option is to restart your computer in safe
mode, undo your most recent changes in Control
Panel, restart again, and allow Windows to load
normally. For more information, see “Undo
Something You Just Did” in Chapter 16.

m= An application that once worked is reporting
problems or isn’t running at all. A few misplaced
bits of program data due to a hard drive problem or
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program conflict can cause applications to lose their
minds, so to speak. You could be experiencing a
hardware failure (see “Solve Basic Hardware
Problems,” earlier in this chapter), a problem with
Windows (see “Troubleshoot Common Windows
Woes,” earlier in this chapter), or issues between the
application and Windows.

Solution: Try these fixes:

e If the program will open, and you can access its
menus, look for a software-update option (proba-
bly in the File or Help menu). Windows conducts
periodic automatic updates unless you've disabled
this feature. An older application could resist a
major Windows update by refusing to run

properly.

e If you can’t find an update option in any menus,
check the manufacturer’s Web site, where you may
be able to download and install the latest software
version.

e Remove the program; then reinstall it from the
original discs. See Chapter 4 for details on how to
uninstall a program.

Get Back on the Internet
1. Let Windows help you solve the problem.

e If you attempt to connect to a Web page and get a
message similar to the one shown in Figure 20-7,
click More Information for help.

¢ Click Diagnose Connection Problems.
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Click for more information.

Click to let Windows try to solve your problem.

& Interneq|Explorer cannot display the webpage - Windows Internet Explorer =| =
@\\J L Ii hitpsifan.microsaft.comyfudink 7linkid=59424 .‘ ¢,| % | [ Bing e
. Faworit = @Suggssted Sites ¥ & | Get More A4dd-ons ~
(E1nternedExplorer cannot display the webpage | fiov B ~ 0 8 v Pagev safetyv Tookv @ 2

@ Internet Explorer cannot displdy the webpage

What you can try:

Diagnose Connection F’mhlems-’—

—n Nore information
This problem can be caused by a variety of issues, including:

= Internet connectivity has been lost.

= The website is temporarily unavailable.

= The Domain Mame Server (DKS) is not reachable,

= The Domain Mame Server (DNS) does not have a listing for the website's domain,

= There might ke a typing error in the address.

= Ifthiz is an HTTPS (secure) address, click Tools, click Internet Options, click Advanced, and check to be
sure the S5L and TLS protocols are enabled under the security section,

For offline users

You can still view subscribed feeds and some recently viewed webpages,
To view subscribed feeds

1. Click the Favorites Center button T dick Feeds, and then dlick the feed you want to view.
To view recently visited webpages (might not worl on all pages)

1. Click Tools %& and then click Work Offline.
2. Click the Favorites Center button B, dlick History, and then click the page you want to view,

@ Internet | Protected Mode: On

iy v W v

Figure 20-7

You may see slightly different responses to a bad
Internet connection, depending on the browser
you're using.

2. Make sure that your Internet connection is still active. If
you have a cable or DSL modem, an indicator light
should tell you whether the service is active.

e Cable modem: If you use a cable modem, also
check to see whether any television sets connected
to the line are getting a video signal.
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e DSL modem: If you use a DSL modem, see
whether any telephones attached to the line have a
dial tone.

If your service seems to be working properly, the problem
may be caused by a momentary electrical glitch in the sig-
nal that can lock up the modem. Proceed to Step 3.

3. Try a power reset, as follows:

a. Close your Web browser and other programs on your
computer.

b. Remove the power cord from the modem (and, if you
use one, from the router).

c. Wait about 10 seconds.

d. Restore the power to the modem (and router, if appli-
cable), and wait until all the indicator lights come
back on.

e. Open your Web browser, and see whether Internet
access has been restored.

4. 1f you still don’t have Internet access, and the modem
indicator light still shows problems, call your Internet
service provider’s support desk for assistance.

If the support person tries to avoid helping you —
perhaps by claiming that the problem is in the

internal wiring of your home or office, or that

your computer is malfunctioning or improperly
configured — insist that he or she help you solve
the problem. One way to get the company’s atten-
tion: Tell the support representative that you're pre-
pared to cancel your service because you can’t get
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the Internet to work, and ask to be connected to the
billing department. All of a sudden, someone —
often, a supervisor — will be made available to you
to solve the problem.

5. If you still don't have Internet access after Step 3, but the
modem’s indicator light shows that the service is working
properly, retrace your steps. Have you made any changes
in Windows or installed any new programs since the last
time your PC linked up properly to the Web? If so,
restore the previous settings manually or with System
Restore (see Chapter 16).
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application software: The program your computer uses to do work,
such as a word processing or a spreadsheet program.

bandwidth: The amount of data that can be transmitted over an elec-
tronic line in a fixed amount of time. For digital devices, bandwidth is
usually expressed in bits per second or bytes per second. For analog
devices, bandwidth is expressed in cycles per second, or Hertz (Hz).

bank switching: A technology to expand available system memory by
switching between banks of memory as needed. The off bank retains
its memory when not in use but is not immediately available.

base memory: The amount of available memory for programs in the
first megabyte of memory in a PC.

bit: The smallest piece of information in a computer represented as a 1
or a 0. A bit can represent a number or a state, such as ON or OFF, or
TRUE or FALSE. A byte has eight bits.

bits per second: bps. The number of binary digits that can be trans-
mitted in one second. A more accurate means of measuring the poten-
tial speed of a modem.

boot: The process the computer goes through to set itself up and load
its operating system. Two kinds of boot exist: hard (or cold) and soft
(or warm).

boot drive: The disk drive from where the operating system is loaded.
boot sector: The first sector of the active (bootable) partition.

broadband: A high-speed means of connection to the Internet, such as
cable modem or DSL telephone wiring.
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burn: The act of recording information onto an optical storage
medium such as a CD-R or DVD-R. The device’s unit burns pits, or
markings, on the disc to indicate the 0s and 1s of digital data.

byte: Eight bits, the smallest unit of data moved about in a personal
computer.

cache: Memory used to store multiple pieces of data that the computer
can reasonably guess it will need soon.

CD-R: Compact Disc-Recordable. A family of devices that can write a
permanent record to a special type of CD, which can then be read on a
standard CD-ROM drive or another CD-R device. Also known as
Compact Disc-Writable.

CD-ROM: Compact Disc Read-Only Memory. An adaptation of music
CD technology that stores large amounts of data.

chip: A casual name for an integrated circuit. A chip is a silicon wafer
that has layers of circuits photoetched into its silicon surface. Chip
also refers to the ceramic or plastic packages in which chips come.

chipset: An integrated set of chips that performs the functions of a
larger number of discrete logical devices on a PC.

cold boot: Starting or restarting a computer by removing all power to
the system or pressing the reset button. Compare to warm boot. In cer-
tain situations, a cold boot is necessary to reset some hardware devices.

command prompt: A screen symbol from the operating system that
indicates the system is awaiting input from the user — for example, C:>.

conventional memory: Memory located between 0 and 640K, sepa-
rated by IBM PC convention from addresses above 640K to 1MB, and
intended for use by the OS (operating system) and applications.

corruption: When data becomes scrambled, changed, or otherwise
damaged.
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CPU: The Central Processing Unit is the part of the computer that exe-
cutes instructions and manipulates information. PCs are based on
Intel or compatible CPUs, including the original 8088 and later chips,
such as the 80286, 80386, 486, Pentium, Pentium MMX, Pentium 1I,
Celeron, Pentium III, and Pentium 4.

debug: The process of finding and removing bugs, or errors, in a piece
of software. From the very first PC through modern machines, the
operating system has included a utility called DEBUG that allows
advanced users to directly alter bytes of data in memory or in storage.

DRAM: Dynamic Random Access Memory. Memory chips that need to
be refreshed regularly. DRAM temporarily stores data in a cell made up
of a tiny capacitor and transistor.

DSL: Digital subscriber line. A DSL is a form of communication
offered by telephone companies and third parties that permits broad-
band Internet connection. Although fast, DSL lines are usually sur-
passed by cable modem connections.

dual boot: A configuration that enables a computer to be loaded with
more than one operating system, with the user able to choose among
them at boot.

dual-core processor: See multicore processor.

DVD: Digital Video Disc or Digital Versatile Disc. A standard for high-
density data, audio, and video. DVD is stored on a media the size of a
compact disc.

Energy Star: A specification for power-saving designs.

expansion slot: A connector on the motherboard that allows an
expansion card to electrically become part of the bus.

extended memory: The memory in a modern machine with an
address above 1MB. It can be used under DOS by programs that throw
the 286, 386, or 486 CPU chip — and advanced CPUs that emulate
earlier microprocessors — into protected mode, where the CPU and
associated programs can take advantage of this memory. Can be used
to provide expanded memory.
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external drive: A storage device that exists outside of the case of the
PC, connected to it by a cable. Common interfaces for external devices
include FireWire, parallel, SCSI, and USB.

firewall: A piece of software or a hardware device intended to block
intruders from accessing computers attached to a local area network or
the Internet.

FireWire: A fast and flexible external bus standard originally devel-
oped as the IEEE 1394 specification and later renamed by Apple as
FireWire. In its current version it permits data transfer rates of as much
as 400 Mbps, with faster versions expected.

flash disk: A storage device using flash memory. Examples include PC
Card memory, CompactFlash, and Smart Media cards.

Gb: See gigabit.
GB: See gigabyte.
giga: One billion.

gigabit (Gb): Used informally to mean one billion bits of storage in
hard drives and other storage media. For RAM, the actual size of a
gigabit is 1,024 megabits, or 1,073,741,824 bits.

gigabyte (GB): Used informally to mean one billion bytes of storage
in hard drives and other storage media. For RAM, the actual size of a
gigabyte is 1,024 megabytes, or 1,073,741,824 bytes.

hard disk: A large-capacity storage medium that uses spinning platters
coated with magnetic material.

hard reset: Instructing a running system to reboot by pressing a reset
button on the hardware. Also known as a cold boot. Compare to
warm boot.

heat sink: A metallic (often aluminum) structure with vanes that radi-
ate heat away from a hot component, helping to prevent failure of
electronic devices. Modern microprocessors require a heat sink, cool-
ing fan, or both because of the amount of heat they produce.
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HIMEM.SYS: A device driver that manages extended memory in DOS;
Windows provides an equivalent as part of its internal code.

hot swapping: The ability to attach or detach a device to a computer
while it is running, a feature that is one of the advantages of USB and
FireWire systems.

inkjet printer: A printing device that creates text or images by spraying
tiny dots onto a page.

internal drive: A storage device that mounts within the case of a PC. A
floppy disk, CD-ROM, Zip drive, and other forms of removable media
require access to the outside of the case, while internal hard drives can
be mounted anywhere in the case that is within reach of data and
power cables. See also external drive.

IP address: The Internet Protocol address is expressed as an identifying
number for sites, devices, or users on an Internet (or on a TCP/IP net-
work used to connect local computers together).

ISP: Internet service provider. A company or organization that sells
access to the Internet to users.

jumper: A small metal clip within a plastic block that is placed on metal
pins to turn on or off a specific function or to make a particular setting.

K: Kilo, as in 1,000.

Kb: Kilobit; 1,024 bits.

KB: Kilobyte; 1,024 bytes.
Kbps: Kilobits per second.
KBps: Kilobytes per second.

kernel: The most basic, essential element of the operating system,
loaded first and kept in memory.
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LAN: Local area network. A connection between two or more comput-
ers at a location.

laser printer: A printer that produces pages based on electronic signals
from a computer. The dots of an image are converted into a laser
beam that imparts a charge to paper that attracts dry ink that is later
fused in place by heat.

local area network: See LAN.

main memory: Another term for conventional memory.
Mb: See megabit.

MB: See megabyte.

Mbps: Megabits per second. The number of bits, in millions, moved in
one second.

MBps: Megabytes per second. The number of bytes, in millions,
moved in one second.

MBR: See master boot record.

media: A physical device that stores computer-generated data. Floppy
disks and hard disks are magnetic media. CD-ROMs are optical media.

megabit: A million bits. In reference to memory, equals 1,048,576
bits. Expressed as Mb.

megabyte: A million bytes. In reference to memory, equals 1,048,576
bytes. Expressed as MB.

memory: The part of a computer that remembers Os and 1s. Unlike
human memory, it cannot remember any context.

memory refresh: See refresh.

microprocessor: The part of the computer that processes. In micro-
computers, the chip that actually executes instructions and manipu-
lates information. Also called the CPU or the processor.
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monitor: A video display.

motherboard: The main board of the PC, holding the microprocessor,
system BIOS, expansion slots, and other critical components.

mouse: A device used to control the location of an onscreen pointer
that identifies data or issues commands to the processor.

MSDOS.SYS: A file that is the essential element of the boot files for
Microsoft operating systems from DOS through Windows 98. (In
IBM’s version of DOS, a similar file is called IBMDOS.COM.)

MTBF: Mean Time Between Failure. A measure by hardware manufac-
turers that purports to show the average time a component can be
expected to work before it fails.

multicore processor: A microprocessor that includes two or more
independent processors within the same physical chip, permitting cer-
tain applications to execute multiple processes at the same time.

nano (n): One billionth. A nanosecond is abbreviated as ns.

NIC: Network Interface Card. An adapter that permits a device to con-
nect to an Ethernet for the exchange of information and commands.

nonvolatile memory: Memory that does not need to be refreshed.
Therefore, it doesn’t require much power. CMOS RAM is a form of
nonvolatile memory.

null modem cable: A specialized serial cable used to connect two
serial devices directly, without the use of a modem.

operating system (OS): A program that enables a computer to load
programs and that controls the screen, the drives, and other devices.
Microsoft’'s DOS was used in early systems through Windows 95/98
and ME; Windows 2000 and Windows XP use new code that performs
the same functions.

OverDrive CPU: An add-on chip from Intel for upgrading a PC with a
faster and/or more powerful CPU.
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overvoltage protection: In a power supply, a circuit that shuts down
the device if the output voltage exceeds a specified limit.

parallel port: The I/O channel to a parallel device, such as a printer.

password check option: A feature of some ROM BIOS systems, it can
be used to prevent unauthorized use of the system or alterations to the
setup.

PC Card: The Personal Computer Memory Card International
Association specification for a credit-card-sized addition to PCs, most
often used in portable computers.

PCMCIA: See PC Card.

peripheral: A hardware device connected to a computer. Typical periph-
erals include keyboards, monitors, printers, disk drives, and more.

pinout: A drawing or table that lists the nature of the signals that use
particular pins of a chip or connector.

platter: The rotating disk within a hard disk drive used to hold data.

Plug-and-Play: A new device plugged into such a system would be
able to set its own IRQ, DMA channel, I/O port setting, and memory
addresses while avoiding conflicts with other peripherals’ settings.

POST: Power-On Self-Test. The BIOS ROM contains a series of hard-
ware tests that runs each time a computer is turned on. If hardware
errors are found, POST either beeps or displays error messages.

processor: The part of the computer that executes instructions and
manipulates information. In microcomputers, this is a single chip. It is
also called a CPU or a microprocessor.

protected mode: The mode of an 80286 or later microprocessor in
which the processor can address extended memory and protect OS
memory from direct manipulation by applications. See also virtual

memory.
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quad-core processor: See multicore processor.

RAM: Random Access Memory. Any part of this memory can be used by
the microprocessor. Each storage location in RAM has a unique address,
and each address can be either written to or read by the processor. In
DOS, conventional memory, maximum 640K, is the area used to hold
DOS, applications, and data. Expanded memory and extended memory
are also RAM. When people use the term RAM casually (as in “How
much RAM does your computer have?”), they're usually talking about
conventional memory, plus expanded and extended memory. Windows,
unlike DOS, uses both conventional memory and extended memory.

reboot: To restart the computer. See also boot, cold boot, and warm
boot.

refresh: Dynamic memory (DRAM) forgets the information it holds
unless it is rewritten regularly. Memory with a faster refresh rate
responds quicker. Refresh rate also is another term for the vertical scan
frequency of a monitor.

register: One of several cells in a processor that is used to manipulate
data. For example, a CPU can load a value from memory into a regis-
ter, load another value into another register, add the two values
together and put the result in a third register, and then copy the third
register’s value to a location in memory.

registry: An essential component of Windows 95/98 and later versions
holding the system configuration files including settings, preferences,
and information about installed hardware and software.

resolution: A measure of the sharpness or granularity of an image or
monitor, usually expressed as a number of horizontal pixels multi-
plied by a number of vertical pixels.

ribbon cable: A flat multiconductor cable used primarily under the
covers of the computer to connect peripheral devices, such as disk
drives to controllers.
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RIMM: A module for Rambus memory.

RJ-11: The male connector on a telephone cable, usually with four
wires, that mates with a wall port or the input port on a telephone
modem.

RJ-45: The male connector on an Ethernet cable, with as many as eight
wires. It is similar in appearance to an RJ-11, but slightly larger and
incompatible.

ROM: Read Only Memory. Recorded once, at the factory, ROM is the
ideal way to hold instructions that should never change, such as the

instructions your computer requires to access the disk drive. See also
BIOS and RAM.

ROM address: The memory address location within a ROM chip,
often used to mean the first address.

ROM BIOS: See BIOS.

router: A device that connects network hubs together. A valuable mod-
ern router includes a firewall to prevent unwanted intrusion by
hackers.

scanner: A device that converts printed or written text or illustrations
into a digital file that can be manipulated by the computer. A modern
optical character recognition application can convert text in the digital
image into characters than can be worked with by a word processor.

SDRAM: Synchronous Dynamic Random Access Memory. An
advanced form of dynamic RAM memory that can be synchronized
with the processor’s clock, eliminating wait states and latency.

Serial ATA (SATA): A standard for interfacing computers to storage
devices such as hard drives and DVD drives. SATA version 1 is capable
of 1.5 Gbps, however the standard is scalable to 2x (3 Gbps) and 4x
(6 Gbps).

server: A computer or other device that manages a component of a net-
work. A file server holds shared files; a print server manages printers,
and a network server controls communication functions of the network.
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setup: A program used to store hardware configuration information in
the CMOS chip of a modern machine.

shadowing: A method to improve performance of a computer by
copying some or all of the contents of ROM to faster RAM.

SIMM: Single Inline Memory Modules are units that can hold a group of
individual memory chips — typically eight or nine — in a single unit
that plugs into a socket. A common current design is the 72-pin SIMM,
which can hold from 1 to 64MB, delivered in a single 32-bit data path.

single user: An operating system that allows only one user to use the
computer at a time.

single user, multitask: A version of single user that allows only one
user to perform multiple tasks simultaneously. Examples include
0S/2, Windows 3.1, and VM/386. See also single user.

single user, single task: A version of single user that allows only one
user at a time to do one task at a time. DOS is an example.

SRAM: Static Random Access Memory chips that do not require refresh
as long as they are powered.

state: Condition, as in On-Off, High-Low, or Zero-One. In computers,
this means the particular way that all memory locations, registers, and
logic gates are set. State is also used casually to indicate the particular
condition and status of the computer.

surface mount: A circuit-board design in which chips are directly
attached to the board instead of being soldered in pin holes or
attached through sockets. In theory, a surface mount design is less sus-
ceptible to problems caused by bad connections. However, a failed
chip often requires replacement of the entire circuit board.

surge protector: A device to protect electrical components from dam-
age caused by overvoltage (surges). A more sophisticated uninterrupt-
ible power supply (UPS) also protects against undervoltage
(brownouts) and a short power outage.
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system: The memory in the computer that DOS (or the chosen operat-
ing system) can use for the OS, applications, and data. On most DOS
computers, this is also called conventional memory, and it has a maxi-
mum memory of 640K. DOS 5.0 and later versions, and DR DOS 6.0
can also use high memory (the first 64K of extended memory), so
these operating systems have an effective system memory of 704K.

system boot parameters: Many BIOS chips permit the user to specify
a number of options at boot.

system files: The hidden files necessary to boot the operating system.

SYSTEM.INI: A Windows file that contains information about the
hardware environment.

tower: An upright case for a computer.

transfer rate: The amount of data, measured in bytes per second, that
a computer can read from or write to a device, such as a hard disk, a
modem, or a network.

twisted pair: A cabling design that uses two thin unshielded wires
twisted around each other to somewhat reduce interference. Twisted-
pair cables are used for telephones and basic Ethernet local area net-
works. More sophisticated systems use coaxial or fiber optic cables,
which are more expensive and difficult to install.

uninterruptible power supply (UPS): A device that combines a surge
protector, a large battery, and electronic circuitry to shield a PC or
other system from surges, undervoltages, and short power outages.

upper memory: Memory located between 640K and 1,024K (1MB).
URL: Uniform Resource Locator. An Internet address system.

USB: Universal Serial Bus. The high-speed external bus that allows
easy connection and removal of devices while a computer is running.
The original specifications of USB 1.0 and USB 1.1 have been sup-
planted by the considerably faster USB 2.0 model.
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virtual memory: A means to enable a system to work with a larger
memory than it is permitted to use or with a memory that is larger
than the memory that actually exists. Paged memory is one type of vir-
tual memory.

virus: A piece of code that corrupts your PC without your permission
or knowledge.

warm boot: Restarting a computer without turning off the power or
pressing the hardware reset button; that is, using the Ctrl+Alt+Delete
combination. See also cold boot.

Zip drive: A popular design for a large-capacity removable storage device,
holding 100 or 250MB on a platter about the size of a floppy disk.
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20-pin connector, 160
24-pin connector, 160
50 percent rule, 133, 135

o/ o

AC (alternating current), 41

access point, wireless, 171-172

accessories, Windows, 58-59

Add a Printer dialog box, 56

Add or Remove Programs utility,
81-82

Advanced Boot Options Menu screen,
289

Advanced Settings link, 148

Advanced tab, Properties dialog box,
219

Advanced Technology Attachment
(ATA) design, 186

air vent, 98

airflow, checking, 95

alcohol cleaner, for mice, 231

all-in-one printer, 20-21

Allow a Program or Feature through
Windows Firewall link, 108

alphanumeric product key, 240

alternating current (AC), 41

Analyze Disk button, Disk
Defragmenter dialog box, 91-92

animated tour, Windows XP, 49

antistatic device, desktop, 30-31

antistatic strap, 28-29

antivirus program update, 73

Appearance and Personalization
menu, 49

Ask Me Every Time option, media,
113

assistance. See help sources

AT power supply, 164

ATA (Advanced Technology
Attachment) design, 186

attachment, e-mail, 111-112

attachment point, hard drive,
188-190

ATX design, 160

audio cable, 40

automatic download, e-mail, 114

automatic preview, e-mail, 114

Automatic Updates, 70-73

Automatically Fix File System Errors
option, 311

autorun feature, 112

auxiliary fan, 169

auxiliary power connector, 165-166
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backing up data, 248

baffle, 43

BIOS (Basic Input and Output
System), 181-182, 254

black blotch, when printing, 212

blocking secret transmission, 114

Blue Screen of Death, 143-145

boot drive, 186, 193

boot logging, 290

Boot tab, System Configuration
utility, 261

BOOT.INI tab, System Configuration
utility, 257

bootleg software, 104

broadband cable, 18

brute-force removal, 84

BTX design, 160

buddy list, IM, 118-119

built-in modem, 17

bus, 36

buttons, conventions used in book, 4

Buttons tab, Mouse Properties dialog
box, 234

oo

C: drive, 201, 309. See also hard drive
cable modem, 171-173, 332
camera
overview, 16-17
using to make repairs, 30, 167
using to record settings of setup
screens, 256
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cancelling Remote Assistance session,
126, 129, 132
case, computer. See computer case
Category View option, Control Panel,
49-50
cathode ray tube (CRT) monitor, 14,
139, 141
CD/DVD drive. See optical disk drive
central processing unit (CPU), 36
Change/Remove button, Uninstall or
Change a Program window, 266
Check Disk utility, 311-314
chipset, 37-38
Chkdsk utility, 314-317
Choose When to Turn Off the
Display option, Power Options
dialog box, 99
clamshell case, 32
Classic View option, Control Panel,
49-50
clean install, 145
Clean Up System Files button, Disk
Cleanup dialog box, 90
cleaning
CPU, 44
hairdryer as tool for, 225
inkjet printer, 100
laser printer, 102
mice, 229-231
trackball, 229-231
vents, 95
clip-on cooling fan, 43
CMOS (Complimentary Metal Oxide
Silicon), 254
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color printer, 20
color-coded defragmentation
analysis, 310
Comcast McAfee antivirus program,
74, 104-105
command prompt, 285, 315-317
communication cable, 189
Complimentary Metal Oxide Silicon
(CMOS), 254
Compress This Drive to Save Disk
Space check box, Properties dialog
box, 317
compressed air, 223
computer case
cooling system, 41, 43-44
examining parts inside, 36-38
grounding yourself, 30-32
opening, 32-35
overview, 27-28
ports, 44-45
power supply, 41-42
replacement cost, 133
storage devices, 38-41
toolkit to work on, 28-30
computer maintenance. See
maintenance
computer manufacturer support,
123-124
computer repair service, 124
conference call, online, 16
Configure Schedule button, Disk
Defragmenter dialog box, 93
configuring Windows Live
application, 76-79

confirmation dialog box, for
uninstalling program, 266
conflict, device, 300-301
Conflicting Device List section,
Device Manager dialog box, 300
Connect to a Network option,
Network Setup Wizard, 56
connection, checking, 99-100
Connections tab, Vista Internet
Options dialog, 52
connector
20-pin, 160
24-pin, 160
auxiliary power, 165-166
converter, 192
Molex, 165, 190-191
P1, 163
P4, 164
peripheral power, 166
power-supply, 190
SATA, 192
Control Panel, 47, 49-50
conventions used in book, 3-4
converter, connector, 192
cooling fan, replacing, 168-171
cooling system, 41, 43-44
Core 2 Quad microprocessor,
Intel, 37
corrupted device driver, 79-81
corrupted file, 145
corrupted program file, 79
CPU (central processing unit), 36
Create a Restore Point radio button,
275
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Creative USB SoundBlaster Live!
24-Bit External sound adapter,
324

CRT (cathode ray tube) monitor,
14, 139, 141

customizing display, 50-52

o)) e

D: drive, 309. See also optical disk
drive
dark line, when printing, 210
data cable, 40, 194
data storage, 38-41
DC (direct current), 41
DDR (Double Data Rate), 179
Debugging Mode, 290
defragmenting hard drive
with Disk Defragmenter, 308-309
overview, 91-93
with third-party utility, 310-311
deletion of program, manual, 84
desktop antistatic device, 30-31
desktop case. See computer case
device driver
defined, 68
fixing corrupted, 79-81
troubleshooting printing problems,
216
updating, 306
video, resetting, 153-154
device management. See managing
devices
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Device Manager
Blue Screen of Death,
troubleshooting, 144
opening, 297-300
overview, 285, 295-297
printing problems, troubleshooting,
216
updating, 306
video adapters, troubleshooting,
152
Device Properties dialog box,
207-208
Device Status section, Properties
dialog box, 151-152, 226,
300-301
devices, managing
with Device Manager, 296-300
disabling devices, 302-304
resolving conflict, 300-301
Diagnose Connection Problems
option, Internet browser, 331
diagnostic startup, 258-259
dial-up connection, 18
digital subscriber line (DSL),
troubleshooting, 333
DIMM (Dual Inline Memory
Module) slots, 178
direct current (DC), 41
Directory Services Restore Mode, 290
Disable Automatic Restart on System
Failure option, 290-291
Disable button, video adapter
Properties dialog box, 154



Index

Disable Driver Signature Enforcement
option, 290-291
disabling device, 302-304
Disk Cleanup dialog box, 90-91,
317-319
Disk Defragmenter utility, 91-93,
308-309
disk drive. See hard drive; optical
disk drive
disk error
checking for automatically,
311-314
Chkdsk utility, 314-317
display
checking, 140-142
customizing, 50-52
defined, 15
versus monitor, 13
reducing resolution, 155
settings, 146-150
troubleshooting, 143-144
Display Properties dialog box,
50, 146
Double Data Rate (DDR), 179
Download Updates for Me, but Let
Me Choose When to Install Them
option, Automatic Updates, 72
downloading
e-mail automatically, 114
Windows Live applications, 76-79
drive. See hard drive; optical disk
drive
driver. See device driver

Driver Details button
Device Manager dialog box, 300
video adapter Properties dialog box,
153
Driver tab
Device Manager dialog box, 300
Mouse Properties dialog box, 233
dropout, printer, 213
DSL (digital subscriber line),
troubleshooting, 333
Dual Inline Memory Module
(DIMM) slots, 178
DVD drive. See optical disk drive
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electrical system
failing power supply, 158-159
fixing modem, 171-173
overview, 157
removing power supply, 166-168
replacement power supply, 159-166
replacing cooling fan, 168-171
replacing power supply, 166-168
electronic system, 157
e-mail
automatic downloads, 114
fighting malware in, 110
Mail program, configuring, 53-55
maintaining security, 118
error, disk
checking for automatically, 311-314
Chkdsk utility, 314-317
error message, during startup, 181
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Ethernet port, 22-23, 45

Ethernet switch, 22

exhaust port, 43

expert, defined, 125

external drive
attachment points, 189
CD/DVD, installing, 326-327
installing, 196-197
as replacement for internal, 185
troubleshooting, 204-205

external modem, 17

external port, 44

external sound adapter, 324

of e

F2 prompt, 254
F8 key, 277, 281
Failure to repair message, 246
fan
auxiliary, 169
checking, 96-97
motherboard-mounted, 170
FAT (File Attribute Table), 200
FAT (File Attribute Table) 32,
200-201
50 percent rule, 133, 135
Files to Delete list, Disk Cleanup
dialog box, 90
firewall, 107-109, 114
First Boot Device, Boot Sequence
option, 240, 244
flash memory, 40
flat-head screwdriver, 28, 168
form factor, power supply, 160
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formatting drive, 199-202
foundational memory, 253
four-slot motherboard, 178
free software, 114

fully equipped computer, 132
function key, 13

oG o

General tab
Device Manager dialog box, 300
System Configuration utility, 86-87,
257, 260-261
Getting Started command, 48
Go Online to Learn More option,
Windows 7, 49
graphics-intensive program, 155
grounding yourself, 30-32

o/l o

hairdryer, as cleaning tool, 225
hard drive. See also replacing hard
drive
data recovery, 135
defragmenting, 91-93, 308-311
Disk Cleanup, 90-91, 317-319
disk errors, checking for, 311-317
overview, 38
partitioning, 198-199
power-supply connector, 190
replacement cost, 133
hardware. See also specific hardware
devices by name
incompatibility, 329
maintenance, 79
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printer, 213-218

testing in safe mode, 287-288

troubleshooting, 324-327
Hardware and Sound dialog box, 297
Hardware tab, Properties dialog box,

226, 232

Hardware Update Wizard, 306
Help and Support Center, 285, 305
help sources

cost of repair versus replacement,

132-135

finding, 123-125

hardware failure, 122-123

overview, 121-122

Remote Assistance, 125-132

software failure, 122-123
high voltage protector, 24
high-resolution color printer, 20
hub, 21-23
humidity

controlling, 102

printing, 214

o] e
IM (instant messaging), 111, 118
incompatible program, 329
indicator light, monitor, 140
infrastructure, computer, 41-45
NI tab, System Configuration, 88
ink cartridge, preserving, 101
inkjet printer

cleaning, 100

dark lines when printing, 210

low resolution or dropouts, 213
overview, 19-20
input device, 12-13
Install Updates button, Microsoft
Update Web page, 69-70
installed memory, 35, 181
installing
CD/DVD drive, 205-207
internal drive, 193-196
memory, 176-184
security packages, 104
Service Pack updates, 75-76
instant messaging (IM), 111, 118
intake hole, 43
Intel chipset, 38
Intel Core 2 Quad microprocessor, 37
internal drive
attachment points, 188-190
CD/DVD, 40, 205-207
installing, 193-196
troubleshooting, 202-204
internal port, 44-45
Internet
ads, 114
installing programs on computer
through, 326
security program updates, 73
troubleshooting connection,
331-334
Internet Options dialog box, 52-53
Internet Service Provider (ISP), 55
Ivens, Kathy, 107
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keyboard
freezing up, 226
maintaining, 222-225
overview, 12-13
replacement cost, 133
replacing, 235-236
reviving, 235
troubleshooting, 225-229
“keyboard error” message, 281
Keyboard Properties dialog box,
226-227
Kingston 128GB USB flash drive, 326

o/ o

label, using when opening case,
28-29
laptop computer, 16
laser printer
cleaning, 102
dark lines when printing, 210
overview, 20
streaky lines, 212
white lines when printing, 210
Last Known Good Configuration,
144-145, 267, 276-278, 290
light-emitting diode (LED)
display, 15
link, e-mail, 111-112
liquid, spilled, 222
liquid crystal display (LCD), 15,
139, 141
logical system, 157
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login info, unsolicited request for,
117

low resolution video, 290

low-ink warning, 214

oIl o

magnetized screwdriver, 28
Mail program, configuring, 53-55
Mail Setup dialog, 53-54
maintenance. See also updating
software
hard drive, defragmenting, 91-93
keyboard, 222-225
mice, 222-225
Microsoft Office Diagnostics, 88-90
monitors, 98-100
printers, 101-102
security, 93-95
System Configuration Utility, 86-88
temperature, 95-97
trackball, 222-225
malware, 103, 110-114
managing devices
with Device Manager, 296-300
disabling devices, 302-304
resolving conflicts, 300-301
manual deletion of program, 84
manual updating, 68-70, 73
manufacturer Remove or Uninstall
utility, 82-83
manufacturer technical support,
123-124
master device, 194
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McAfee antivirus program, 74,
104-105
mechanical mice, cleaning, 229
mechanical system
failing power supply, 158-159
modem, fixing, 171-173
overview, 157
removing power supply, 166-168
replacement power supply, 159-166
replacing cooling fan, 168-171
replacing power supply, 166-168
memory card, 40
memory key, 40-41
memory module
finding appropriate, 176-177
installation of new, 177-181
motherboard, 35
overview, 175
replacement cost, 133
troubleshooting, 181-184
memory scan, online, 177
memory stick, 40
menu command, 4
mice
cleaning, 229-231
maintaining, 222-225
overview, 10-12
replacement cost, 133
replacing, 235-236
reviving, 235
troubleshooting, 232-234
wireless, 10
microphone, 16-17

MiCroprocessor
Intel Core 2 Quad, 37
locating, 34-35
Pentium, 43
Microsoft Office Diagnostics, 88-90
modem
built-in, 17
cable, 171-173, 332
DSL, 333
external, 17
fixing, 171-173
overview, 17-19
power-off reset, 173
Molex connector, 165, 190-191
Molex hard drive, 166
monitor
Blue Screen of Death, 144-145
display, checking, 140-142
display, troubleshooting, 143-144
display settings, checking and
changing, 146-150
failure, 141
maintenance, 98-100
making easier to read in Safe Mode,
283-284
overview, 13-15
preventing future problems,
154-155
video adapter, troubleshooting,
150-153
video driver, resetting, 153-154
More Options tab, Disk Cleanup
dialog box, 91
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motherboard
overview, 34-35
replacement cost, 133
motherboard-mounted fan, 170
Mouse Properties dialog box,
232-234

o\l o

navigation pane, 255
Network Access Protection
(NAP), 107
network device, installing printer
attached to, 57
Network Setup Wizard, 55-56
nonanimated tour, Windows XP, 49
Norton Internet Security, 116
notification icon, for updates, 72
Notify Me but Don't Automatically
Download or Install Them
option, Automatic Updates, 72
novice, defined, 125
NT File System (NTES), 201

o () o

online conference call, 16
online memory scan, 177
Open System Protection link, 275
opening computer case, 32-35
operating system. See Windows 7;
Windows Vista; Windows XP
optical disk drive (CD or DVD)
external, installing, 326-327
installing programs on computer
without, 326
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internal, installing, 205-207
overview, 39
replacement cost, 133
testing, 207-208
optical mice, cleaning, 231
optional update, 74
outlet, checking, 158

o pPoe

P1 connector, 163

P4 connector, 164

paintbrush cleaning tool, 224

paper, for printer, 213

paper jam, 214

partitioning drive, 198-199

partly-installed memory module, 35

PATA (parallel ATA) data cable,
186, 194

PATA to SATA adapter, 192

pen, plastic, 29

Pentium microprocessor, 43

peripheral power connector, 166

Personalization window, 51, 147

Phillips-head (X-shaped) screwdriver,
28, 168

phishing, 103, 116

photorealistic inkjet printer, 213

plastic pen, 29

platter, hard drive, 38-39

plug-and-play device, 221, 285, 328

pointing device, 10-12

port, 21-23, 44-45

power consumption, reducing, 98

Power Options dialog box, 98-99
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power reset, 333
power supply
cost of replacement, 133
failing, 158-159
overview, 34, 41-42
removing, 166-168
replacement, 159-166
power-off reset, modem, 173
power-supply connector, 190
Print Test Page button, Properties
dialog box, 215-216
print tone, uneven, 210
printer
all-in-one, 20-21
built-in self-test, 214-215
checking printed pages for
problems, 210-213
configuring, 56-58
high-resolution color, 20
inkjet, 19-20, 100, 210, 213
laser, 20, 102, 210, 212
maintenance, 101-102
overview, 19-21
testing hardware, 213-218
testing software, 219-220
printing
black blotches, 212
dark lines, 210
humidity, 214
streaky lines, 212
white blotches, 212
white lines, 210
product key, Windows, 250-251

program
incompatibility of, 329
uninstalling, 81-84, 264-266
Program Compatibility Wizard,
62-64
program file, fixing corrupted, 79
Programs tab, Internet Options
dialog box, 52
Properties dialog box, 317
Advanced tab, 219
Compress This Drive to Save Disk
Space check box, 317
Device, 207-208
Device Status section, 151-152,
226, 300-301
Display, 50, 146
Hardware tab, 226, 232
Keyboard, 226-227
Mouse, 232-234
Print Test Page button, 215-216
video adapter, 154
PS/2 device, removing from
computer, 235
PS/2 serial port connection, 233
public network, 107

o () o
QWERTY layout, keyboard, 12
o R e

random-access memory (RAM). See
memory module
ratchet-style driver, 28
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read optical disk drive, 39
read/write head, hard drive, 38-39
read/write optical disk drive, 38-39
read/write/rewritable optical disk
drive, 39
rebooting, 292
Recovery Console, 291
refreshing Windows, 246-248
Registry Editor tool, 258, 286
reinstalling Windows, 145, 248-251
release latch, computer case, 33
Remote Assistance
overview, 124-125
in Vista, 126-129
in Windows 7, 130-132
in Windows XP, 125-126
Remove button, Uninstall or Change
a Program window, 266
repair service, computer, 124
Repair Your Computer, Safe Mode
option, 289
repairing. See also monitor
versus replacement, 122, 132-135
Vista installation, 243-246
Windows 7 installation, 243-246
Windows XP installation, 240-243
repeat rate, 228
replacing hard drive
external drive, 204-205
formatting, 199-202
installing external drive, 196-197
installing internal CD/DVD drive,
205-207
installing internal drive, 193-196
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internal drive, 202-204
partitioning drive, 198-199
testing CD/DVD drive, 207-208
troubleshooting external drive,
204-205
troubleshooting internal drive,
202-204
what's needed, 186-193
replacing keyboard, 235-236
replacing mice, 235-236
replacing trackball, 235-236
replacing versus repairing, 122,
132-135
resetting video driver, 153-154
resolution
display, 155
screen, 148, 283
troubleshooting printing problems,
213
Resources tab, Device Manager dialog
box, 300
Restart tab, System Configuration
utility, 87
restore point
creating manually, 275-276
overview, 267-268
restoring computer settings
choosing utility for, 267
Last Known Good Configuration,
276-278
overview, 263-264
restore points, creating manually,
275-276
System Restore utility, 267-274
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undoing actions, 264
uninstalling programs, 264-266
Return to OS Choices Menu, Safe
Mode option, 292
Roll Back Driver button, video
adapter Properties dialog box, 154
router, 17-19

oS e

Safe Mode
advanced options, 289-292
exiting, 292
making monitor easier to read in,
283-284
restarting computer in, 235
starting computer in, 280-282
starting Windows in, 264
testing hardware in, 287-288
testing settings in, 288-289
tools, 284-287
Safe Mode with Command Prompt,
289
Safe Mode with Networking, 289
Safely Remove Hardware icon, 303
SATA (serial ATA)
connector, 192
defined, 186
drive, 195
Scan for and Attempt Recovery of
Bad Sectors option, Check Disk
dialog box, 312-313
screen resolution. See also display;
monitor
accessing settings, 148
in safe mode, 283

screen saver, 51
screwdriver, 28, 168
SDRAM (Synchronous Dynamic
Random Access Memory), 179
searching, in Windows Explorer, 60
secret transmission, blocking, 114
security
building firewall in Windows,
107-109
computer maintenance, 93-95
malware, 110-114
phishing, 116
smart defense, 104-105
spam, 116-118
spyware, 114-116
viruses, 109-110
Windows Security Center,
configuring, 105-107
security alert, 115, 197
Security Center, configuring,
105-107
Selective Startup mode, 259
self-test, printer, 214-215
serial ATA (SATA)
connector, 192
defined, 186
drive, 195
serial wire, 188
Service Pack
checking for and installing updates,
75-76
checking status, 74-75
overview, 72
Service Ports probe, 94
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Services tab, System Configuration
utility, 87, 257-258
settings, restoring computer
choosing problem solving utility,
267
Last Known Good Configuration
utility, 276-278
restore points, creating manually,
275-276
System Restore utility, 267-274
undoing actions, 264
uninstalling programs, 264-266
Settings tab, Display Properties
dialog box, 146
ShieldsUP! tool, 93
skin, keyboard, 222
slave device, 194
software. See also updating software
Control Panel, opening, 49-50
display, customizing, 50-52
faxes, configuring, 56-58
Internet Options, 52-53
Mail, configuring, 53-55
Network Setup Wizard, 55-56
overview, 47
printer, 56-58, 219-220
Program Compatibility Wizard,
62-64
System Information, viewing, 61-62
touring Windows, 48-49
troubleshooting, 329-331
updating, 73-74
Windows accessories, exploring,
58-59
Windows Explorer, 59-61
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solid-state memory, 254
sound adapter, external, 324
spam, 104, 116-118
speaker, 16-17
speed, increasing, 175
Speed tab, Keyboard Properties
dialog box, 227
spooler, 216
spyware, 103, 114-116
Start Windows Normally, Safe Mode
option, 291
starting, in Safe Mode, 280-282
startup, diagnostic, 258-259
Startup Repair utility, 245
Startup tab, System Configuration
utility, 257-258
static discharge, 167
storage device, 38-41
streaky line, when printing, 212
Successful repair message, 246
surge protector, 24, 98
Synchronous Dynamic Random
Access Memory (SDRAM), 179
System Configuration utility
computer maintenance, 86-88
diagnostic startup in Windows XP,
258-259
normal startup in Windows XP, 260
system setup screens, 254-256
viewing in Vista, 260-261
viewing in Windows 7, 260-261
viewing in Windows XP, 256-258
System Information utility, 61-62,
176
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System Properties dialog box,
275-276
System Protection tab, System
Properties dialog box, 275-276
System Recovery Options window,
245,291-292
System Restore utility
overview, 267-274, 285
restore points, creating manually,
275-276
solving software problems with, 330
when to reinstall Windows, 248
SYSTEM.INI tab, System
Configuration utility, 257

o e

tablet, 12-13
temperature, maintaining, 95-97
testing
CD/DVD drive, 207-208
keyboard, 228-229
printer hardware, 213-218
printer software, 219-220
thermal fit, 162
third-party utility, defragmenting,
310-311
tone, uneven print, 210
Tools tab, System Configuration
utility, 88, 257-258
touchpad, 11
touchscreen, tablet, 12
touring Windows, 48-49
tower case, 27, 32

trackball
cleaning, 229-231
defined, 10-11
maintaining, 222-225
replacing, 235-236
reviving, 235
troubleshooting, 232-234
transmission, blocking secret, 114
Troubleshoot Printer Problems
link, 216
troubleshooting
computer that won't start, 322-324
Device Manager, 306
external drive, 204-205
hardware problems, 324-327
internal drive, 202-204
Internet connection, 331-334
keyboard, 225-229
memory, 181-184
mice, 232-234
monitor, 143-144
printing problems, 213, 216
software problems, 329-331
trackball, 232-234
video adapter, 150-153
video connections, 142
video output, 141
Windows problems, 327-329
Windows Troubleshooting Wizard,
304-305
Turn Off Automatic Updates
option, 72
20-pin connector, 160
24-pin connector, 160
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U key, 280
UAC (User Account Control),
107, 260
Undo System Restore radio button,
274
undoing action, 264
uneven print tone, 210
Uninstall button, video adapter
Properties dialog box, 154
Uninstall or Change a Program
utility, 81-82
uninstalling program, 81-84,
264-266
uninterruptible power supply (UPS),
24-25, 322
Universal Serial Bus. See USB
Update Driver button, video adapter
Properties dialog box, 154
Update Driver Software dialog
box, 306
updating device driver, 306
updating software
corrupted device drivers, fixing,
79-81
corrupted program files, fixing, 79
other software, 73-74
overview, 67
Service Pack status, checking, 74-75
Service Pack updates, 75-76
uninstalling programs, 81-84
Windows Live applications, 76-79
Windows Updates, 68-73
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upright tower case, 32
UPS (uninterruptible power supply),
24-25, 322
USB (Universal Serial Bus)
devices, removing from computer,
235
flash drive, 40
mouse, 222-223
ports, 21, 45, 196
USB SoundBlaster Live! 24-Bit
External sound adapter, 324
User Account Control (UAC),
107, 260

o (/o

vent, checking and cleaning, 95
VGA Mode, 290
video adapter
overview, 146-147
troubleshooting, 150-153
video connection, troubleshooting,
142
video driver, resetting, 153-154
video output, troubleshooting, 141
View Available Updates link, 69
View System Recovery Options, 291
virus, 103, 109-110
voice gateway, 171-172

o (f/ o

Waiting for Incoming Connection
window, 128-129

warning icon, Device Manager
window, 298
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warranty, 124
Web site, fine print on, 117
webcam, 16
What's New in Windows option,
Windows Vista, 49
white blotch, when printing, 212
white line, when printing, 210
wide ribbon cable, 187
Wi-Fi adapter, 324
Windows 7
accessories, exploring, 58-59
Add a Printer dialog, 56
Control Panel, opening, 49-50
corrupted device drivers, fixing,
79-81
Device Manager, opening, 297
Disable Driver Signature
Enforcement option, 291
disabling devices, 302
Disk Defragmenter, 91, 309
disk errors, checking for, 313-315
display, customizing, 50-52
display settings, checking and
changing, 147-150
Enable Low Resolution Video
option, 290
external drives, troubleshooting,
204
faxes, configuring, 56-58
firewalls, building, 107
Getting Started command, 48
Go Online to Learn More option, 49
internal drives, troubleshooting, 203
Internet Options, 52-53

Network Setup Wizard, 55-56

Personalization dialog, 51

power consumption, reducing,
98-99

printers, configuring, 56-58

Program Compatibility Wizard,
62-64

refreshing, 246-248

reinstalling, 248-251

Remote Assistance in, 130-132

repairing installation, 243-246

restore points, 272, 275-276

Safe Mode, making screen easier to
read in, 283-284

Safe Mode, testing settings in, 288

System Configuration utility, 86,
260-261

System Information, viewing, 61-62

System Restore, 268-269

touring, 48-49

troubleshooting wizards, 304-305

uninstalling programs, 81-82,
264-265

Update Driver Software dialog box,
306

updates, manually checking
for, 68

video adapter, troubleshooting,
152-153

What's New in Windows option, 49

Windows Explorer, 59-61

Windows Security Center,
configuring, 105
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Windows Advanced Options Menu
screen, 280, 289
Windows Explorer, 59-61
Windows Live applications, 76-79
Windows Live Mail client, 54
Windows Mail program,
configuring, 54
Windows NT File System (NTES),
201
Windows Remote Assistance
overview, 124-125
in Vista, 126-129
in Windows 7, 130-132
in Windows XP, 125-126
Windows Security Center,
configuring, 105-107
Windows Updates
checking for automatically, 70-73
checking for manually, 68-70
Windows Vista
accessories, exploring, 58-59
Add a Printer dialog, 56
Control Panel, opening, 49-50
corrupted device drivers, fixing,
79-81
Device Manager, opening, 297
Disable Driver Signature
Enforcement option, 291
disabling devices, 302
Disk Defragmenter, 91, 309
disk errors, checking for, 313-314
display, customizing, 50-52
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display settings, checking and
changing, 146-147

Enable VGA Mode option, 290

external drives, troubleshooting,
204

faxes, configuring, 56-58

firewalls, building, 107

internal drives, troubleshooting, 203

Internet Options, 52-53

Mail, configuring, 53-55

Network Setup Wizard, 55-56

Personalization display, 51

power consumption, reducing,
98-99

printers, configuring, 56-58

Program Compatibility Wizard,
62-64

Recovery Console option, 291

refreshing, 246-248

reinstalling, 248-251

Remote Assistance, 126-129

repairing installation, 243-246

restore points, 272, 275

Safe Mode, making screen easier to
read in, 283

Safe Mode, testing settings in, 288

System Configuration Utility, 86

System Information utility, 61-62,
260-261

System Restore, 268-269

touring, 48-49

troubleshooting wizards, 304-305
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uninstalling programs, 81-82,
264-265

Update Driver Software dialog box,
306

updates, manually checking for, 68

video adapter, troubleshooting,
150-152

Welcome Center command, 48

Windows Explorer, 59-61

Windows Security Center,
configuring, 105

Windows XP

accessories, exploring, 58-59

animated tour, 49

Control Panel, opening, 49-50

corrupted device drivers, fixing,
79-81

Device Manager, 297

diagnostic startup, 258-259

disabling devices, 302

Disk Defragmenter, 91

disk errors, checking for, 313-314

display, customizing, 50-52

Display Properties utility, 50

display settings, checking and
changing, 146-147

Enable VGA Mode option, 290

external drives, troubleshooting,
204

faxes, configuring, 56-58

firewalls, building, 107

Hardware Update Wizard, 306

internal drives, troubleshooting, 203

Internet Options, 52-53

Network Setup Wizard, 55-56

nonanimated tour, 49

normal startup in, 260

power consumption, reducing,
98-99

printers, configuring, 56-58

Program Compatibility Wizard,
62-64

Recovery Console option, 291

refreshing, 246-248

reinstalling, 248-251

Remote Assistance, 125-126

repairing installation, 240-243

restore points, 271, 275

Safe Mode, making screen easier to
read in, 283

Safe Mode, testing settings in, 288

System Configuration utility, 86,
256-258

System Information, viewing,
61-62

System Restore, 268-269

touring, 48-49

troubleshooting wizards, 304-305

uninstalling programs, 81-82, 264

updates, manually checking for, 68

video adapter, troubleshooting,
150-152

Windows Explorer, 59-61

Windows Security Center,
configuring, 105
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WINL.INI tab, System Configuration Py X’ PY
utility, 257

wired mice, 10

wireless access point, 171-172

wireless mice, 10

wireless router, 19

workspace, 28

X-shaped (Phillips-head) screwdriver,
28, 168
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Make simple repairs to your
computer that extend its life
and save you money

Do you go into panic mode when your computer isn't
working properly? End the worry with this accessible guide!
Expert Corey Sandler shows you how to quickly uncover
what'’s wrong and fix it by following easy steps. In no

time, you'll learn the best way to maintain your PC, solve
hardware problems, restore system settings, troubleshoot
issues, and more.

* Get to know the parts — from the mouse and keyboard to
the monitor, printer, and connection ports, discover how PC
components work

* Inside the box — develop a working knowledge of your PC’s
“brain” and the Windows operating system

* Keep your PC healthy — follow tips and techniques for proper
computer hygiene

* Upgrade memory and replace drives — change your PC’s
memory, hard disk drives, and CD/DVD drives

* Get Windowse back on track — repair, refresh, or reinstall
Windows to quickly get up and running again

* Diagnose the problem — use the Windows Troubleshooting
Wizard and make changes to your injured PC using a list of
solutions

* Enhance security — take the steps needed to protect your PC
from viruses and other threats

Corey Sandler was the first executive editor of PC Magazine. He has
written more than 160 books, including all editions of Laptops All-in-One
For Dummies. Tom Badgett has published more than 50 books and

hundreds of magazine articles on technical topics. He has also worked
as a journalist and broadcast documentary producer.

Hardware/Personal Computers/PCs

* Introductions to your PC’s parts
and operating system

*Ways to keep your computer
healthy

* Steps for stopping viruses,
malware, and spam

*When to repair and when to
replace your PC

* How to change your computer’s
memory

*Tips for repairing Windows

* How to get your printer and
monitor working again

* Tricks for fixing common PC
problems

Go to Dummies.come®
for videos, step-by-step examples,
how-to articles, or to shop!
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